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Introduction 
This guide describes how to install, set up, and maintain ObjectVideo OnBoard™ 3.0 

and ObjectVideo® VEW® 3.0. It also describes how to install, set up, and maintain 
ObjectVideo Forensics™ 3.0 and ObjectVideo Integrator Toolkit™ 3.0. This chapter 
provides the following information: 

• Tips on how to read this guide 

• A description of the ObjectVideo products 

• An overview of the ObjectVideo system 

• Minimum system and environmental requirements 

• Details about the installation CDs that accompany the ObjectVideo products 

• A description of other documentation available from ObjectVideo 
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How to Read This Guide 

Before you install the ObjectVideo system, read this introductory chapter. Pay 
particular attention to the “System Overview” section on page 5 and follow the 
guidelines in “Minimum System and Environmental Requirements” on page 17. 

When you have the proper hardware and environment in place to support the 
system, you are ready to start installing and configuring the system. 

You must perform the steps described in “Initial Deployment Steps” on 
page 28. These preliminary steps must be completed for every ObjectVideo product. 

After you have performed the initial set-up steps, do the following: 

• To complete the set-up process for ObjectVideo VEW and ObjectVideo 
OnBoard, follow the instructions in “Completing the ObjectVideo VEW and 
ObjectVideo OnBoard Deployment Process” on page 78. You only need to 
complete the steps in this chapter if you are using ObjectVideo VEW or 
ObjectVideo OnBoard for real-time event detection. 

• To complete the set-up process for ObjectVideo Forensics, follow the 
instructions in “Completing the ObjectVideo Forensics Deployment Process” 
on page 85. You only need to complete the steps in this chapter if you are 
using ObjectVideo Forensics to detect events that occurred in the past. 

• To install the ObjectVideo Integrator Toolkit, follow the instructions in 
“Installing the ObjectVideo Integrator Toolkit Applications” on page 106. 

Guidelines on how to ensure your system operates optimally over time are provided 
in “Maintaining the System” on page 110. 

If you experience problems while installing the system, see “Troubleshooting” on 
page 156. 

Notes: 

• This guide explains how to access Microsoft Windows Control Panel options in 
Category View rather than Classic View. 

• This guide assumes that you are using installation CDs provided by ObjectVideo. 
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ObjectVideo Products 

The ObjectVideo products are ObjectVideo VEW, ObjectVideo OnBoard, and 
ObjectVideo Forensics. The ObjectVideo Integrator Toolkit is a package of software 
applications provided with these products. The ObjectVideo products detect events in 
surveillance video, both in real-time and for investigative purposes. ObjectVideo VEW 
and ObjectVideo OnBoard perform real-time event detection. ObjectVideo Forensics 
searches for events that occurred in the past. 

ObjectVideo Forensics depends on ObjectVideo VEW or ObjectVideo OnBoard with 
metadata as a prerequisite. You must install and configure ObjectVideo VEW or 
ObjectVideo OnBoard with metadata before you can use ObjectVideo Forensics, as 
described in this guide. 

In addition to its event detection products, ObjectVideo provides a package of 
software tools called the ObjectVideo Integrator Toolkit, which is used by integrators 
and customer support personnel to help plan for and support ObjectVideo VEW, 
ObjectVideo OnBoard, and ObjectVideo Forensics. 

ObjectVideo VEW 

ObjectVideo VEW monitors video feeds for events and alerts you in real time as 
events take place. 

VEW Standard™, VEW HiRes™, VEW Leader/Follower, and VEW FlowControl™ are 
available with ObjectVideo VEW. 

VEW Standard detects and reports when an object crosses a tripwire, crosses 
multiple tripwires, appears, disappears, enters, exits, loiters in an area, is inside an 
area, is taken away, or is left behind. VEW Standard also detects and reports scene 
change events. 

VEW HiRes detects and reports the same event types as VEW Standard, but it 
analyzes video at a higher resolution (640 x 480 or 720 x 480) to detect more 
events and detect them more accurately. VEW Standard, VEW FlowControl, and VEW 
Leader/Follower process video at a resolution of 320 x 240. 

VEW Leader/Follower detects and reports the same event types as VEW Standard. In 
response to some of these event types, a VEW Leader/Follower sensor can instruct a 
Pan-Tilt-Zoom (PTZ) camera to follow an object involved in an event. 

VEW FlowControl detects and reports movement in an unauthorized direction, such 
as a person walking “against the flow” in a crowd. 

ObjectVideo OnBoard 

Like ObjectVideo VEW, ObjectVideo OnBoard monitors video feeds for events and 
alerts you in real-time as events take place. In ObjectVideo OnBoard, events are 
detected by an intelligent surveillance device (such as a camera) running 
ObjectVideo technology. 
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ObjectVideo OnBoard includes OnBoard 100, OnBoard 200, and OnBoard 1000 as 
optional sensor types. 

OnBoard 100 detects and reports events in which an object appears, disappears, 
enters, or exits an area. 

OnBoard 200 detects and reports events in which an object crosses a tripwire, 
appears, disappears, enters, or exits an area. OnBoard 200 also detects and reports 
scene change events. 

OnBoard 1000 detects and reports events in which an object crosses a tripwire, 
crosses multiple tripwires, appears, disappears, enters, exits, loiters in an area, is 
inside an area, is taken away, or is left behind. OnBoard 1000 also detects and 
reports scene change events. 

These sensors may support metadata. If a sensor supports metadata, it can 
generate the forensics data that ObjectVideo Forensics uses to search for past 
events. These sensors are identified as OnBoard 100MD, OnBoard 200MD, and 
OnBoard 1000MD in the ObjectVideo Management Tool. Except for their ability to 
support metadata, these sensors are identical to other ObjectVideo OnBoard sensors. 

In ObjectVideo OnBoard, it may be possible to change the sensor type of an existing 
sensor. Contact your Video Analysis Device vendor to obtain software to manage 
your sensor types. 

ObjectVideo Forensics 

ObjectVideo Forensics searches for past events by analyzing stored forensics data 
collected from surveillance video feeds. 

You must install and configure ObjectVideo VEW or ObjectVideo OnBoard with 
metadata before you can use ObjectVideo Forensics. ObjectVideo VEW components 
are required to set up the ObjectVideo Forensics system and to analyze surveillance 
video for later analysis by ObjectVideo Forensics. 

ObjectVideo Integrator Toolkit (Package) 

The ObjectVideo Integrator Toolkit is a package of software applications used by 
integrators and customer support personnel to plan for, maintain, and troubleshoot 
the system. The ObjectVideo Integrator Toolkit applications are used to improve 
event detection and reduce false alarms. 
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System Overview 

This section provides an overview of how your ObjectVideo system should be set up, 
and identifies the role of each component within the system. 

Do one of the following: 

• If you are setting up an ObjectVideo VEW system, see “ObjectVideo VEW 
System Overview” on page 6. 

• If you are setting up an ObjectVideo OnBoard system, see “ObjectVideo 
OnBoard System Overview” on page 9. 

• If you are also using ObjectVideo Forensics, see “ObjectVideo Forensics 
System Overview” on page 11. 

Notes: 

• If a component is identified as “ObjectVideo-certified,” it means that you are 
using hardware that has been tested by ObjectVideo and certified to meet the 
requirements of the ObjectVideo software. You can learn more about 
ObjectVideo-certified hardware in “Minimum System and Environmental 
Requirements” on page 17. 

• Custom hardware configurations may vary from those pictured in this guide. 
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ObjectVideo VEW System Overview 

The figure below shows a typical ObjectVideo VEW system. 

 

Figure 1: VEW System Architecture 

ObjectVideo Server Computer (ObjectVideo-certified Hardware) 

The ObjectVideo Server computer runs the ObjectVideo Server software. The 
ObjectVideo Server software routes information among the components and sends 
alerts to the Alert Console. Alerts are stored in a database on the ObjectVideo Server 
computer. 

ISE Computer (ObjectVideo-certified Hardware) 

The Intelligent Sensor Engine (ISE) computer runs the ISE software. The ISE 
software manages sensors, which monitor video feeds for events. Video feeds are 
connected to the ISE computer. Depending on the sensor type and hardware 
configuration you are using, video feeds may be directly connected to the ISE 
computer, connected via a multiplexer/switcher, or connected over the network. 
Contact customer support for more information about connecting digital video stream 
sources to the ISE computer over the network (see “Getting Support” on page 223). 
You may deploy multiple ISEs in your system. 
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Sensors on the ISE computer perform all event detection functions in ObjectVideo 
VEW. One sensor monitors each video feed that is connected to the ISE computer. 
The following types of ObjectVideo VEW sensors may be available: 

• VEW Standard 

• VEW FlowControl 

• VEW HiRes 

• VEW Leader/Follower 

Only one type of sensor can run on each VEW ISE computer. 

The number of video feeds each sensor type can monitor simultaneously varies, as 
shown in the following table. (Custom hardware configurations may vary.) 

Table 1: Maximum Number of Video Feeds That Can Be Monitored 
Simultaneously by Each Type of Sensor  

Sensor Type No. of Video Feeds 

VEW Standard Up to 4 

VEW Leader/Follower Up to 4 

VEW FlowControl Up to 2 

VEW HiRes 1 

Sensors that support multiple views may be able to monitor a larger number of video 
feeds in rotation if they are connected to the ISE computer through a 
multiplexer/switcher. 

The number of sensors per ISE computer may vary based on the hardware 
configuration being used and the number of sensors permitted by licensing. 

VEW/OnBoard Client Application Computer 

A VEW/OnBoard client application computer is a computer where one or more of the 
VEW/OnBoard client applications are installed. 

There are three VEW/OnBoard client applications: 

• Alert Console – Displays alerts as events occur and allows you to search for 
alerts. 

• Rule Management Tool – Used to set up rules for surveillance cameras. Rules 
tell the system which events to look for and how to respond when an event 
occurs. 

• System Configuration Tool – Used to set up the system’s configuration, enter 
information about components, and perform other system-related tasks. 
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“Installing the VEW/OnBoard Client Applications” on page 55 contains installation 
instructions and a more detailed description of each client application. 

Cameras 

Sensors monitor the video feeds from surveillance cameras for events. Using VEW 
Leader/Follower, a camera can follow (track) an object involved in an event. 

Multiplexer/Switcher 

A multiplexer (also referred to as a switcher) is a device that allows multiple video 
feeds to travel over a single line. Several cameras can connect to a multiplexer, 
which in turn connects to the ISE computer. The multiplexer switches between the 
video feeds either automatically (in rotation) or at the command of a user, so the 
ISE computer receives the video signal from one surveillance camera at a time. This 
enables one sensor to monitor multiple video feeds for events. VEW FlowControl 
sensors do not support the use of multiplexers. 
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ObjectVideo OnBoard System Overview 

In ObjectVideo OnBoard, the ObjectVideo Server software and ISE are both installed 
on the same computer (the Server/ISE computer). You can add more OnBoard ISEs 
if additional Video Analysis Devices are connected to your network. 

 

Figure 2: ObjectVideo OnBoard System Architecture 

Video Analysis Devices 

A Video Analysis Device is an intelligent surveillance device, such as a camera or a 
digital video recorder (DVR), containing ObjectVideo OnBoard technology that 
enables the device to detect events. Sensors run partly on the Video Analysis Device 
and partly on the computer running the ISE software. The Server/ISE computer is 
connected to the Video Analysis Device over the network. The sensors running on 
the Server/ISE computer and Video Analysis Device work together to detect events. 

Each Video Analysis Device supports a limited number of active rules and views. The 
number of active rules and views supported varies depending on the Video Analysis 
Device being used. Please contact your Video Analysis Device vendor for more 
information. 

If the Video Analysis Device is not a camera and supports multiple views, the system 
may be set up using a multiplexer/switcher, which enables one sensor to monitor 
multiple video feeds. 

 9 
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Server/ISE Computer (ObjectVideo-certified Hardware) 

The Server/ISE computer runs both the ObjectVideo Server software and the 
OnBoard ISE software. The ObjectVideo Server software routes information among 
the components and sends alerts to the Alert Console. Alerts are stored in a 
database on the Server/ISE computer. 

The ISE software manages sensors, which monitor video feeds for events. Sensors 
run partly on the computer running the ISE software and partly on the Video 
Analysis Device. 

OnBoard ISE Computer (ObjectVideo-certified Hardware) 

If many Video Analysis Devices are on a network, additional OnBoard ISE computers 
can be added to support them. If another OnBoard ISE computer is used, some 
Video Analysis Devices connect to the Server/ISE computer and others connect to 
the additional ISE computer. 

VEW/OnBoard Client Application Computer 

A VEW/OnBoard client application computer is a computer where one or more of the 
VEW/OnBoard client applications are installed. 

There are three VEW/OnBoard client applications: 

• Alert Console – Displays alerts as events occur and allows you to search for 
alerts. 

• Rule Management Tool – Used to set up rules for surveillance cameras. Rules 
tell the system which events to look for and how to respond when an event 
occurs. 

• System Configuration Tool – Used to set up the system’s configuration, enter 
information about components, and perform other system-related tasks. 

“Installing the VEW/OnBoard Client Applications” on page 55 contains installation 
instructions and a more detailed description of each client application. 
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ObjectVideo Forensics System Overview 

ObjectVideo VEW sensors and ObjectVideo OnBoard sensors that support metadata 
monitor video feeds and generate forensics data in real-time. ObjectVideo Forensics 
uses this data to detect past events. 

Do one of the following: 

• If ObjectVideo VEW sensors are generating the forensics data, see 
“ObjectVideo VEW with ObjectVideo Forensics System Overview” on page 12. 

• If ObjectVideo OnBoard sensors are generating the forensics data, see 
“ObjectVideo OnBoard with ObjectVideo Forensics System Overview” on page 
14. 
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ObjectVideo VEW with ObjectVideo Forensics System Overview 

The figure below shows a typical system where forensics data is being generated by 
ObjectVideo VEW and analyzed by ObjectVideo Forensics. 

 

Figure 3: ObjectVideo Forensics System Architecture for ObjectVideo VEW 

Cameras 

Sensors monitor the video feeds from surveillance cameras and generate forensics 
data. 

Multiplexer/Switcher 

A multiplexer (also referred to as a switcher) is a device that allows multiple video 
feeds to travel over a single line. Several cameras can connect to a multiplexer, 
which in turn connects to the ISE computer. The multiplexer switches between the 
video feeds either automatically (in rotation) or at the command of a user, so the 
ISE computer receives the video signal from one surveillance camera at a time. This 
enables one sensor that supports multiple views to monitor multiple video feeds. 
VEW FlowControl sensors do not support the use of multiplexers. 

 12 
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ISE Computer 

The ISE computer runs the ISE software. The VEW ISE software manages sensors, 
which monitor video feeds and generate forensics data. The Forensics Store service 
also runs on ISE computers. The Forensics Store service stores forensics data for use 
in ObjectVideo Forensics. 

Forensics Data 

Forensics data describes what occurred within a camera’s field of view. It consists of 
primitives and video. Primitives are text-based descriptions of what is going on in the 
video. FAST™ (the Forensics Analysis Scenario Tool™) analyzes forensics data to 
detect events. 

Forensics data can also be used by customer support personnel for troubleshooting 
purposes for ObjectVideo VEW. You will most likely only use the forensics data if you 
have purchased ObjectVideo Forensics, but because the Forensics Store service runs 
on the VEW ISE computer by default, it will be easy to add ObjectVideo Forensics 
later on. 

Computer Running FAST 

FAST is a software application that enables you to search for events within forensics 
data. 
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ObjectVideo OnBoard with ObjectVideo Forensics System 
Overview 

The figure below shows a typical system where forensics data is being generated by 
an ObjectVideo OnBoard sensor that supports metadata and analyzed by ObjectVideo 
Forensics. 

 

Figure 4: ObjectVideo Forensics System Architecture for ObjectVideo 
OnBoard with Metadata 

Video Analysis Device 

A Video Analysis Device is an intelligent surveillance device, such as a camera or a 
DVR, containing ObjectVideo OnBoard technology that enables the device to detect 
events. Sensors run partly on the Video Analysis Device and partly on the computer 
running the ISE software. The Server/ISE computer is connected to the Video 
Analysis Device over the network. The sensors running on the Server/ISE computer 
and Video Analysis Device work together to detect events. 
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Computer Running ISE Software 

The ISE software manages sensors, which monitor video feeds for events and 
generate forensics data. Sensors run partly on the computer running the ISE 
software and partly on the Video Analysis Device. 

Computer Running FAST 

FAST is a software application that enables you to search for events within forensics 
data. 

Forensics Data 

Forensics data describes what occurred within a camera’s field of view. It consists of 
primitives and video. Primitives are text-based descriptions of what is going on in the 
video. FAST™ (the Forensics Analysis Scenario Tool™) analyzes forensics data to 
detect events. 

Forensics data is only generated by ObjectVideo OnBoard sensors that support 
metadata. In addition, users must enable the generation of forensics data for each 
sensor using the ObjectVideo Management Tool. See “Enabling Forensics Storage for 
ObjectVideo OnBoard Sensors” on page 97 for more information.  
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Other ObjectVideo VEW and ObjectVideo OnBoard Components 
Used by ObjectVideo Forensics 

In addition to the primary ObjectVideo Forensics components described in the 
preceding sections, there are other ObjectVideo VEW and ObjectVideo OnBoard 
components that may occasionally be used for ObjectVideo Forensics. This section 
only indicates the role of these components in ObjectVideo Forensics. To learn more 
about these components in the context of ObjectVideo VEW, see “ObjectVideo VEW 
System Overview” on page 6. To learn more about these components in the context 
of ObjectVideo OnBoard, see “ObjectVideo OnBoard System Overview” on page 9. 

Computer Running ObjectVideo Server Software 

In ObjectVideo Forensics, the ObjectVideo Server software’s role is to send 
ObjectVideo Forensics health monitor alerts to the Alert Console. The health monitor 
alerts are stored in a database on the computer running the ObjectVideo Server 
software for later searching. 

VEW/OnBoard Client Application Computers 

A VEW/OnBoard client application computer is a computer where one or more of the 
VEW/OnBoard client applications are installed. 

There are three VEW/OnBoard client applications used with ObjectVideo Forensics: 

• Alert Console – Displays health monitor alerts related to forensics data 
storage space and system performance. It is not used to display information 
about events detected using ObjectVideo Forensics. 

• Rule Management Tool – Used to define sensor views during the set-up of the 
ObjectVideo Forensics system if you are using sensors that support multiple 
views. If you are using ObjectVideo VEW or ObjectVideo OnBoard for real-
time event detection in addition to using ObjectVideo Forensics, you can also 
export rules from the Rule Management Tool for use within FAST and import 
scenarios from FAST for use in the Rule Management Tool. 

• System Configuration Tool – Used to set up the system’s configuration, enter 
information about components, and perform other system-related tasks. 
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Minimum System and Environmental Requirements 

Network Requirements 

The system can run on any Transmission Control Protocol/Internet Protocol (TCP/IP)-
based network. If possible, the network should have a Domain Name System (DNS) 
server. If the network does not have a DNS server and you are using host names 
instead of IP addresses, you will need to create or modify hosts files to allow the 
computers running the ObjectVideo components to resolve host names to IP 
addresses (see “Adding a Host to a Hosts File” on page 140). 

The system supports networks using Dynamic Host Configuration Protocol (DHCP) 
and static IP addresses. If your network uses DHCP, you must use the host name of 
the computer running the ObjectVideo Server software rather than the computer’s IP 
address, because the IP address may change when the computer is rebooted. 

If you plan to use e-mail-based alert responses, you will need a Simple Mail Transfer 
Protocol (SMTP) server on the network. Be sure to follow industry best practices for 
securing all of the computers running the software. 

Hardware Requirements 

ObjectVideo Server and ISE Hardware Requirements 

The ObjectVideo Server, ISE, and Server/ISE computers must be located near a 
power source and have TCP/IP connectivity. Ideally, the power source should be 
backed up so that the ObjectVideo Server and ISE computers can operate 
continuously through power outages. Make sure that your environment meets all 
power, climate, humidity, noise abatement, and other requirements indicated by the 
hardware vendor. 

Specific ObjectVideo Server and ISE hardware requirements vary depending on 
whether you are installing ObjectVideo VEW or ObjectVideo OnBoard. See the next 
section, “ObjectVideo VEW,” for the requirements for ObjectVideo VEW. See 
“ObjectVideo OnBoard” on page 20 for the requirements for ObjectVideo OnBoard. 

ObjectVideo VEW 

In ObjectVideo VEW, the ObjectVideo Server and ISE software must be installed on 
ObjectVideo-certified computers, which have been tested to ensure they meet the 
requirements of the ObjectVideo Server and ISE software. See “ObjectVideo VEW 
System Overview” on page 6 for more information about the ObjectVideo VEW 
architecture. 
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The tables that follow provide the ObjectVideo Server and ISE minimum hardware 
requirements for ObjectVideo VEW. 

Table 2: VEW ISE Computer Hardware Minimum Requirements 

Hardware 
Component 

Minimum Requirement 

Processor and RAM Option A: 

• Processor: Dual Intel Xeon, 2.8 GHz 

• RAM: 2 GB 

Option B: 

• Processor: Pentium 4, 3.0 GHz 

• RAM: 3 GB 

Hard Drive(s) (1) 74 GB 

(1) 200 GB drive (for forensics data) 

ATA 133, SATA 120 or 150, or SCSI 

Other Drives 24X CD-ROM drive (recommended) 

Network Interface 100 MB TX full duplex Ethernet  

Operating System Windows XP Professional (Service Pack 2) or Windows 
Server 2003, Standard Edition (Service Pack 1) 

Video Source Analog: Four-channel video capture card 
(Winnov Videum 4400 VO) 

Digital: Supported, but not required. See “ObjectVideo 
VEW and Digital Stream Sources” for more information. 

Video Display Card 8 MB SVGA with independent GPU 

ObjectVideo VEW and Digital Stream Sources 

In ObjectVideo VEW, the computer running the ISE software is usually physically 
connected to the video feeds (or multiplexers/switchers) through BNC connectors. 
This guide describes this configuration. In some cases, however, the ISE computer 
can be connected to a digital video stream source. ObjectVideo VEW supports many 
types of digital video stream sources from network cameras and DVRs. Contact 
customer support for more information about connecting to digital video stream 
sources (see “Getting Support” on page 223). 
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Table 3: ObjectVideo Server Computer Minimum Hardware Requirements 

Hardware 
Component 

Minimum Requirement 

Processor Dual Intel Xeon, 2.8 GHz 

RAM 1 GB 

Hard Drive(s)  (1) 74 GB 

ATA 133, SATA 120 or 150, or SCSI 

Other Drives 24X CD-ROM drive 

Network Interface 100 MB TX full duplex Ethernet  

Operating System Windows XP Professional (Service Pack 2) or Windows 
Server 2003, Standard Edition (Service Pack 1) 
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ObjectVideo OnBoard 

A typical ObjectVideo OnBoard architecture consists of one Server/ISE computer and 
(optionally) one or more OnBoard ISE computers to support additional Video Analysis 
Devices. The Server/ISE computer and OnBoard ISE computer(s) are certified by 
ObjectVideo. These computers have been tested to ensure that they meet the 
requirements of the ObjectVideo Server and ISE software. See “ObjectVideo OnBoard 
System Overview” on page 9 for more information about the ObjectVideo OnBoard 
architecture. 

Each Server/ISE computer or OnBoard ISE computer can support up to 80 sensors. 
In order to support 80 sensors, the sensors must be using the default sensor 
configuration and must not be generating metadata. If sensors are generating 
metadata, they require four times as many resources. So, one Server/ISE computer 
or OnBoard ISE computer can only support 20 sensors generating metadata. You can 
combine sensors that produce metadata and those that do not. For instance, you 
could have 40 sensors that do not produce metadata and 10 sensors that do produce 
metadata running on the same computer. 

Important: An additional 50 GB of storage space (above the minimum hardware 
requirement listed below) is required for every ObjectVideo OnBoard sensor 
producing metadata. For example, if you have 20 ObjectVideo OnBoard sensors 
producing metadata, you would need over 1 TB of additional storage space. 

The table that follows provides the minimum hardware requirements for the 
Server/ISE computer and OnBoard ISE computer for ObjectVideo OnBoard. 

Table 4: Server/ISE Computer and OnBoard ISE Computer Minimum 
Hardware Requirements 

Hardware 
Component 

Minimum Requirement 

Processor and RAM Option A: 

• Processor: Dual Intel Xeon, 2.8 GHz 

• RAM: 2 GB 

Option B: 

• Processor: Pentium 4, 3.0 GHz 

• RAM: 3 GB 

Hard Drive(s) (1) 74 GB 

ATA 133, SATA 120 or 150, or SCSI 

Other Drives 24X CD-ROM drive (recommended) 

Network Interface 100 MB TX full duplex Ethernet  
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Hardware 
Component 

Minimum Requirement 

Operating System Windows XP Professional (Service Pack 2) or Windows 
Server 2003, Standard Edition (Service Pack 1) 

Video Display Card 8 MB SVGA with independent GPU 

Client Application Hardware Requirements 

Client applications may run on one or more computers, providing that each computer 
in your system meets the minimum hardware and software requirements. The 
requirements are listed in Table 5, “Client Application Minimum Hardware 
Requirements,” on page 22. 

VEW/OnBoard Client Applications 

The VEW/OnBoard client applications consist of the Alert Console, Rule Management 
Tool, and System Configuration Tool. When you install the VEW/OnBoard client 
applications, you can choose to install only the Alert Console, only the Rule 
Management Tool and System Configuration Tool, or all the VEW/OnBoard client 
applications. The ObjectVideo Management Tool is also installed when you install any 
of the VEW/OnBoard client applications.  

FAST Requirements 

FAST is the client component of ObjectVideo Forensics. FAST requires network 
connectivity in order to open, because it must be able to connect to the license 
server on the computer running the ObjectVideo Server software. You can, however, 
run scenarios on forensics data that resides on local storage media. More information 
about ObjectVideo licensing is provided in “Installing Licenses” on page 41. 
Commuter licenses for users who must use FAST offline are also available. See 
“Checking Out an Authorization for Opening FAST Offline” on page 130 for more 
information. 

ObjectVideo Integrator Toolkit Requirements 

The ObjectVideo Integrator Toolkit consists of the Alert Backup Estimator, Camera 
Placement Tool, Leader/Follower Calibration Tool, Object Sizing Tool, and Parameter 
Configuration Tool. When you install the ObjectVideo Integrator Toolkit, you can 
choose to install any one of these components or all of them. As indicated in Table 5, 
“Client Application Minimum Hardware Requirements,” the Leader/Follower 
Calibration Tool has a different hardware requirement than the other client 
applications. 

The ObjectVideo Management Tool is also installed when you install any of the 
ObjectVideo Integrator Toolkit components. 
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Table 5: Client Application Minimum Hardware Requirements 

Hardware 
Component 

Minimum Requirement 

Processor and 
RAM 

Option A (for computers that are not running the 
Leader/Follower Calibration Tool): 

• Processor: Intel Celeron, 1.0 GHz 

• RAM: 1 GB 

Option B (for computers running the Leader/Follower 
Calibration Tool): 

• Processor: Pentium 4, 3.0 GHz 

• RAM: 1 GB 

Hard Drive 1 GB available hard drive space 

ATA 133, SATA 120 or 150, or SCSI 

Other Drives 24X CD-ROM drive (recommended) 

Network 
Interface 

100 MB TX full duplex Ethernet 

Operating 
System 

Windows XP Professional (Service Pack 2) or Windows 2000 
(Service Pack 4) 

PTZ Camera Requirements 

VEW Leader/Follower uses PTZ cameras to follow objects. These PTZ cameras are 
supported by VEW Leader/Follower: 

• Sony Network Camera (SNC-RZ30N) 

• Any serial camera that supports the Pelco D protocol 
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Software Requirements 

You must install prerequisite software before you install most ObjectVideo 
components. See Appendix A, “Prerequisite Software,” on page 224, for more 
information. 

Important: Do not install the ObjectVideo Server software on a network that is 
running SafeNet, Inc. or Rainbow Technologies products. The licensing mechanism 
used by SafeNet and Rainbow Technologies products may interfere with the licensing 
mechanism used by the ObjectVideo system. If SafeNet or Rainbow Technologies 
products are running on the network, contact customer support for assistance (see 
“Getting Support” on page 223). 

Help System Requirements 

When you select Help > Contents from an ObjectVideo client application, the 
application’s Help is automatically displayed using your computer’s default Internet 
browser. 

It is recommended that you use one of the following browsers as your default 
browser: 

• Internet Explorer 5.0 or later 

• Netscape Navigator 4.0 or later 

• Opera 6.0 or later 

• Mozilla (all versions) 

Internet Explorer 5.0 or later and Netscape Navigator 4.0 or later provide the best 
results. The Help may open in a browser that is not listed above, but the display of 
Help content may be affected. 
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Installation CDs 

Before you start the installation, make sure you have the appropriate installation CDs 
for the ObjectVideo software. The following table describes the CDs. 

Table 6: Installation CDs 

Use this CD… To install this 
component… 

On this computer… 

The blue ObjectVideo 
Server installation CD 

ObjectVideo Server Computer that meets the 
ObjectVideo Server 
requirements on page 17. 

The gray/purple VEW 
Standard ISE installation 
CD (requires the purchase 
of VEW Standard) 

ISE (VEW Standard) Computer that meets the 
ObjectVideo VEW ISE 
requirements on page 17. 

The OnBoard ISE 
installation CD (requires 
the purchase of 
ObjectVideo OnBoard) 

ISE (ObjectVideo 
OnBoard) 

Computer that meets the 
ObjectVideo OnBoard ISE 
requirements on page 20. 

The gray/orange VEW 
FlowControl ISE 
installation CD (requires 
the purchase of VEW 
FlowControl) 

ISE (VEW FlowControl) Computer that meets the 
ObjectVideo VEW ISE 
requirements on page 17. 

The gray/yellow VEW 
HiRes ISE installation CD 
(requires the purchase of 
VEW HiRes) 

ISE (VEW HiRes) Computer that meets the 
ObjectVideo VEW ISE 
requirements on page 17. 

The gray/aqua 
ObjectVideo 
Leader/Follower ISE 
installation CD (requires 
the purchase of 
ObjectVideo 
Leader/Follower) 

ISE (VEW Leader/Follower) Computer that meets the 
ObjectVideo VEW ISE 
requirements on page 17. 

The red VEW/OnBoard 
client applications 
installation CD 

Alert Console, Rule 
Management Tool, and 
System Configuration Tool 

Computer that meets the 
client application 
requirements on page 21. 

The green FAST 
installation CD (requires 
the purchase of 
ObjectVideo Forensics) 

FAST Computer that meets the 
FAST requirements on 
page 21. 
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Use this CD… To install this 
component… 

On this computer… 

The ObjectVideo 
Integrator Toolkit 
installation CD 

Alert Backup Estimator, 
Camera Placement Tool, 
Object Sizing Tool, 
Leader/Follower 
Calibration Tool, and 
Parameter Configuration 
Tool  

Computer that meets the 
ObjectVideo Integrator 
Toolkit requirements on 
page 21. 
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Other Documentation 

On the Web 

Product documentation, knowledge bases, and frequently asked questions (FAQs) 
are available at the ObjectVideo web site. For access to customer-oriented content, 
contact support@objectvideo.com. For access to partner-oriented content, contact 
your ObjectVideo Channel Sales Representative. 

Product Documentation 

Find the complete documentation for all ObjectVideo product releases at the 
following locations: 

• Customer Edition: http://www.objectvideo.com/docs 

• Partner Edition: http://www.objectvideo.com/docs/partners (includes the SDK 
and ObjectVideo Integrator Toolkit documentation) 

Knowledge Bases 

Comprehensive, searchable knowledge bases featuring detailed troubleshooting 
information and how-to articles can be found at the following locations: 

• Customer Edition: http://www.objectvideo.com/kb 

• Partner Edition: http://www.objectvideo.com/kb/partners (includes additional 
content exclusive to partners) 

FAQs 

The most commonly asked questions about the capabilities of the ObjectVideo 
software and the ObjectVideo system requirements are available exclusively to 
partners at http://www.objectvideo.com/faqs. 

Readme File 

The Readme file provides late-breaking information that supplements the 
documentation. The Readme contains notes to upgrading users, system 
requirements, installation information, new feature descriptions, information on 
known issues, and contact information. Please review the Readme before installing or 
upgrading ObjectVideo software. The Readme is provided on all installation CDs. It is 
also installed with the ObjectVideo software under C:\Program 
Files\ObjectVideo\Documentation. 
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Online Help 

Each ObjectVideo client application contains comprehensive Help that provides a 
keyword search, index, and glossary. ObjectVideo Help is available whenever an 
ObjectVideo client application is running. It contains the most up-to-date information 
available for the system. 

To access the Help when an ObjectVideo client application is running, select 
Contents from the Help menu. Either select a topic from the Contents tab, or click 
the Index tab or Search tab to locate information by keyword or phrase. Click the 
Glossary tab to display a list of important terms and definitions. 

Quick Reference Cards 

The VEW/OnBoard client applications installation CD contains reference cards that 
can be printed out and displayed. The reference cards are available in the 
Documentation directory on the CD. 

These cards provide information about common tasks and concepts in ObjectVideo 
VEW, ObjectVideo OnBoard, and ObjectVideo Forensics. The following reference 
cards are available: 

• Alert Console Quick Reference Card 

• Snapshot Markup Quick Reference Card 

• Rule Management Tool Quick Reference Card 

The reference cards are provided in PDF format, which means that you need Adobe 
Acrobat Reader in order to view them. For your convenience, Acrobat Reader is 
provided in the VEW/OnBoard client applications installation CD. To run the Acrobat 
Reader installer, browse to the Acrobat directory on the CD, and then double-click 
AdbeRdr70_enu_full.exe. 



 

Initial Deployment Steps 
This chapter describes the initial installation and set-up steps that are required for all 
ObjectVideo products. The figure below provides an overview of the steps. 

 

Figure 5: Initial Deployment Steps 

Note: If you are deploying ObjectVideo Forensics or the ObjectVideo Integrator 
Toolkit, you must first install ObjectVideo VEW or ObjectVideo OnBoard.

 28 
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After you have completed the steps in this chapter, you are ready to perform the 
steps described in the following chapters: 

• To configure real-time event detection and notification using ObjectVideo VEW 
or ObjectVideo OnBoard, see “Completing the ObjectVideo VEW and 
ObjectVideo OnBoard Deployment Process” on page 78. 

• To configure investigative event detection using ObjectVideo Forensics, see 
“Completing the ObjectVideo Forensics Deployment Process” on page 85. 

• To install the ObjectVideo Integrator Toolkit, see “Installing the ObjectVideo 
Integrator Toolkit Applications” on page 106. 
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Connecting the Video Analysis Device(s) to the 
Network (ObjectVideo OnBoard) 

  
This is Step 1 in the ObjectVideo OnBoard 
deployment process. This step is only 
necessary for ObjectVideo OnBoard systems. 

1 

The first step in deploying an ObjectVideo OnBoard system is to connect the Video 
Analysis Devices to the network and assign an IP address to each device. 

A Video Analysis Device is an intelligent surveillance device, such as a camera or a 
DVR, containing ObjectVideo OnBoard technology that enables the device to detect 
events. 

Once all Video Analysis Devices are connected to the network, proceed to “Installing 
the ObjectVideo Server Software” on page 36. 
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Setting Up the ObjectVideo Server and ISE Computers 
(ObjectVideo VEW) 

 
 

This is Step 1 in the ObjectVideo VEW 
deployment process. This step is only 
necessary for ObjectVideo VEW systems. 

1 

The first step in deploying an ObjectVideo VEW system is to set up the ObjectVideo 
Server and ISE computers. In ObjectVideo VEW, the ObjectVideo Server and ISE 
software run on separate computers, both of which have been tested and certified by 
ObjectVideo. ObjectVideo-certified computers meet minimum hardware requirements 
(see “ObjectVideo Server and ISE Hardware Requirements” on page 17) and have all 
prerequisite software preinstalled (see “ObjectVideo Server and ISE Software 
Requirements” on page 225). 

“Setting Up the ObjectVideo Server Computer” on page 32 gives instructions for 
setting up an ObjectVideo Server computer. “Setting Up the ISE Computer” on 
page 33 gives instructions for setting up an ISE computer. 
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Setting Up the ObjectVideo Server Computer 

This section describes how to set up the computer that will run the ObjectVideo 
Server software. 

Before You Start 

Make sure you have a computer certified to run the ObjectVideo Server software. 

To Set Up the ObjectVideo-certified Server Computer 

1. When you receive the ObjectVideo Server computer, unpack the computer, 
inspect it for damage, and place it in the appropriate location (e.g., a server rack 
in a location with a network connection, sufficient power, etc.). 

2. Connect the computer to a keyboard, mouse, and monitor. 

Note: You do not necessarily have to physically connect the computer to a 
keyboard, mouse, and monitor. These input/output devices can be connected to 
the computer via a Keyboard, Video, and Mouse (KVM) switch. 

3. Connect a network cable to the computer and physically connect the computer to 
the network. 

4. Connect a power cable to the computer and plug the computer into a power 
source. 

5. Turn on the computer. 

6. Check the computer’s network link light to ensure that the computer is physically 
connected to the network. 

7. After the computer boots up, perform the initial set-up steps for the operating 
system. Refer to the Windows documentation for more information. 

For example, you may need to activate and register Windows, create an 
administrator account for the computer, enable users to connect via Remote 
Desktop Connection, run Windows Update, etc. 

8. After the operating system is set up, connect the computer to the network in 
Windows. 

The way this is accomplished will vary based on the network environment. For 
example, you may have to configure the operating system for DHCP and assign a 
host name to the computer, or you may need to assign a host name and IP 
address to the computer. Refer to the Windows documentation for more 
information. 

9. Proceed to the next section, “Setting Up the ISE Computer.” 
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Setting Up the ISE Computer 

This section describes how to set up the ObjectVideo-certified computer(s) that will 
run the ISE software. 

Before You Start 

Make sure you have a computer certified to run the VEW ISE software. 
See “ObjectVideo Server and ISE Hardware Requirements” on page 17 for more 
information. 

Setting Up the ISE Computer 

Note: Perform the following steps for each ISE computer. 

1. When you receive the ISE computer from the manufacturer, unpack the 
computer, inspect it for damage, and place it in the appropriate location (e.g., a 
server rack in a location with a network connection, proximity to video feeds, 
sufficient power, etc.). 

2. Connect the computer to a keyboard, mouse, and monitor. 

Note: You do not necessarily have to physically connect the computer directly to 
a keyboard, mouse, and monitor. These input/output devices can be connected to 
the computer via a KVM switch. 

3. Connect a network cable to the computer and physically connect the computer to 
the network. 

4. Connect the video cables from the surveillance cameras or multiplexer/switchers 
to the computer’s video inputs (i.e., the ports on the computer’s video capture 
card). 

5. If you are using serial cameras, connect them to the COM port(s).  
 
Note: If you are connecting multiple serial cameras to a single COM port, you 
must install the ObjectVideo Serial Port Service (see “To Install the VEW ISE 
Software” on page 49). 

The following figure shows an example of an ISE computer’s video inputs and 
COM port. Your computer’s appearance may look different from the one shown. 

 Video inputs 
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COM ports 

Figure 6: ISE Video Inputs and COM port 
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Notes: 

• In VEW Standard and VEW Leader/Follower, a maximum of four video feeds can 
be connected to the computer’s video inputs. A VEW Standard or VEW 
Leader/Follower sensor can monitor four video feeds at a time. In VEW 
FlowControl, a maximum of two video feeds can be connected to the computer’s 
video inputs. A VEW FlowControl sensor can monitor two video feeds at a time. In 
VEW HiRes, a maximum of one video feed should be connected to the computer’s 
video inputs. A VEW HiRes sensor can monitor one video feed at a time. 

• You can connect multiplexers/switchers to a computer running VEW Standard, 
VEW HiRes, or VEW Leader/Follower sensors. VEW Standard and VEW HiRes 
sensors support multiplexed cameras because of their ability to support multiple 
views. Since VEW Leader/Follower sensors may temporarily change views during 
an event, it is not recommended that you use multiplexers/switchers with these 
sensors.  

• Do not connect a multiplexer/switcher to a VEW FlowControl ISE computer. VEW 
FlowControl does not support multiplexed cameras. 

• If the video cable does not have the appropriate connector, use an adapter to 
connect the cable to the video input. 

• If you need to split the video signal, you can use a video distribution amplifier. In 
many cases, there will also be a “looping” connection available via another 
device, such as a switch, a multiplexer/switcher, or a DVR. 

• If the electrical ground at the camera is different than the ground at the ISE 
computer, use a video isolation transformer to avoid signal distortion. 

6. Connect a power cable to the computer and plug the computer into a power 
source. 

7. Turn on the computer. 

8. Check the computer’s network link light to ensure that the computer is physically 
connected to the network. 

9. After the computer boots up, perform the initial set-up steps for the operating 
system. Refer to the Windows documentation for more information. 

For example, you may need to activate and register Windows, create an 
administrator account for the computer, enable users to connect via Remote 
Desktop Connection, run Windows Update, etc. 

10. After the operating system is set up, connect the computer to the network in 
Windows. 

The way this is accomplished will vary based on the network environment. For 
example, you may have to configure the operating system for DHCP and assign a 
host name to the computer, or you may need to assign a host name and IP 
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address to the computer. Refer to the Windows documentation for more 
information. 

11. Proceed to the next section, “Installing the ObjectVideo Server Software.” 
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Installing the ObjectVideo Server Software 

  
This is Step 2 in the ObjectVideo OnBoard 
deployment process. 

   

 
 

This is Step 2 in the ObjectVideo VEW 
deployment process. 

2 

2 

This section describes how to install the ObjectVideo Server software. The 
ObjectVideo Server is the center of communications in the ObjectVideo system. 

If you are deploying ObjectVideo VEW, install the ObjectVideo Server software on the 
ObjectVideo-certified computer you set up in “Setting Up the ObjectVideo Server 
Computer” on page 32. 

If you are deploying ObjectVideo OnBoard, install the ObjectVideo Server software 
on an ObjectVideo-certified computer that meets the specifications described in 
“ObjectVideo Server and ISE Hardware Requirements” on page 17. 

Important: 

• Do not install more than one ObjectVideo Server on your network. Installing 
multiple ObjectVideo Servers causes license management issues and can result in 
network instability. 

• Do not install the ObjectVideo Server software on a network that is running 
SafeNet, Inc. or Rainbow Technologies products. The licensing mechanism used 
by SafeNet and Rainbow Technologies products may interfere with the licensing 
mechanism used by the ObjectVideo system. If SafeNet or Rainbow Technologies 
products are running on the network, contact customer support for assistance 
(see “Getting Support” on page 223).  

Before You Start 

• Make sure that the computer has all the prerequisite software installed. See 
“ObjectVideo Server and ISE Software Requirements” on page 225 for more 
information. 

• The blue ObjectVideo Server installation CD and an installation key are required 
to complete the steps in this section. 
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To Install the ObjectVideo Server Software 

Note: You must be logged in as a Windows user with Administrator privileges to 
install the ObjectVideo Server software. 

1. Insert the ObjectVideo Server installation CD into the computer’s CD drive. 

The installer starts automatically. If it does not start automatically, use Windows 
Explorer to browse to the computer’s CD drive, and then double-click 
AutoSetup.js. 

The ObjectVideo Installation dialog appears. 

2. Click Yes. 

3. Do one of the following: 

• If the Welcome to the ObjectVideo Daemon Service Installation 
Wizard screen appears, proceed to step 4. 

• If the Welcome to the InstallShield Wizard for Sentinel LM 7.3.0.9 
Server screen appears, skip to step 12. 

4. Click Next. 

The License Agreement screen appears. 

5. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

6. Click Next. 

The Ready to Install the Software screen appears. 

7. Click Next. 

The Updating System screen appears, followed by the ObjectVideo Daemon 
Service Configuration screen. 

8. Type the product installation key.  

9. Review the Server Address and Server Port of the computer that will run the 
ObjectVideo Server software. 

By default, the ObjectVideo Server computer’s IP address is specified as 
127.0.0.1. By default, the ObjectVideo Server software listens on port 8076. 

10. Click OK. 

The ObjectVideo Daemon Service has been successfully installed screen 
appears. 
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11. Click Finish. 

The Welcome to the InstallShield Wizard for Sentinel LM 7.3.0.9 Server 
screen appears. The software uses Sentinel LM for license management, so the 
next few screens walk you through the process of installing Sentinel LM. 

12. On the Welcome to the InstallShield Wizard for Sentinel LM 7.3.0.9 Server 
screen, click Next. 

The License Agreement screen appears.  

13. If you agree to the terms of the license agreement, click Yes. 

The Choose Destination Location screen appears. 

14. Do not change the installation location for Sentinel LM. Instead, click Next. 

The Setup Status screen appears while Sentinel LM is being installed, followed 
by the InstallShield Wizard Complete screen. 

15. Click Finish. 

The Welcome to the ObjectVideo Server Installation Wizard screen 
appears. The screen may take a few moments to appear. 

16. On the Welcome to the ObjectVideo Server Installation Wizard screen, click 
Next. 

The Ready to Install the Software screen appears. 

17. Click Next. 

The Updating System screen appears while the ObjectVideo Server is installed 
on the computer, followed by the ObjectVideo Server Configuration dialog. 

18. Do one of the following: 

• Click the button to the right of the Web Server Home Directory field, and 
then browse to the local web server’s document root directory. Click OK on 
the Browse for Folder dialog. 

• In the Web Server Home Directory field, type the local path to the web 
server’s document root directory. 

The Web Server Home Directory is the directory from which the web server 
hosts alert snapshots so that they are available to the Alert Console.  
 
Note: The fields of the ObjectVideo Server Configuration dialog may already 
be populated with the correct data. 

19. In the Web Server Port field, enter the web server’s port number (usually 80). 
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20. In the Purge Database at This Size (MB) field, enter the maximum size the 
ObjectVideo database can be before it is automatically purged. 

In a typical installation, the ObjectVideo database is an MSDE database. If you 
are not using an MSDE database, contact customer support for information on 
what value to enter in this field (see “Getting Support” on page 223). The 
primary purpose of the ObjectVideo database is to store alerts for real-time 
events detected by ObjectVideo VEW and ObjectVideo OnBoard, but it also stores 
other system data such as sensor groups, camera information, and views.  

The total database size that MSDE can support is 2 GB. This means that the total 
amount of data in all tables in the database cannot exceed 2 GB. When the 
amount of data in the database reaches 2 GB, the database stops storing new 
alerts and you cannot add new views. The database is automatically purged when 
it reaches the size you specify in this field. It is recommended that you use the 
default value of 1600 MB (1.6 GB). The value must be less than 2000 MB (2 
GB). 

When you select this value, keep in mind that a health monitor alert notifying you 
that the database is going to be purged occurs at 1.5 GB. See “Maintaining the 
ObjectVideo VEW and ObjectVideo OnBoard Systems” on page 111 or 
“ObjectVideo Forensics and the ObjectVideo Database” on page 129 for more 
information. 

21. Enter the number of days of alerts you want to try to save after the purge in the 
Try Not to Purge <number of days> Days of Recent Alerts field. 

When the ObjectVideo database is purged, not all alerts are necessarily deleted 
from the database. When the database reaches the size indicated in the Purge 
Database at This Size field, the alerts that occurred previous to the number of 
days entered in the Try Not to Purge <number of days> Days of Recent 
Alerts field are deleted. 

If the database size is still larger than the size in the Purge Database at This 
Size field, another day of alerts are deleted. The alerts are deleted in one-day 
increments until the database size is smaller than the size indicated in the Purge 
Database at This Size field. The most recent alerts are preserved. For instance, 
if you used the default value of 7, every alert that occurred before the previous 
week would be deleted. If the database was still too large, a day at a time would 
be deleted (starting from the day farthest from the present) until the database 
was the specified size. 

See “Maintaining the ObjectVideo VEW and ObjectVideo OnBoard Systems” on 
page 111 or “ObjectVideo Forensics and the ObjectVideo Database” on page 129 
for more information. 

22. Click OK. 

The ObjectVideo Server has been successfully installed screen appears. 

23. Click Finish. 
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An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the computer where you installed the ObjectVideo Server software. 

24. Click Yes to reboot the computer. 

Important: You must reboot the computer in order for the ObjectVideo Server 
software to run. The ObjectVideo Server software runs automatically when the 
computer starts up. 

25. Proceed to “Installing Licenses” on page 41. 

Note: The ObjectVideo Management Tool is automatically installed when the 
Daemon Service is installed. The ObjectVideo Management Tool is used to start and 
stop ObjectVideo services, change various configuration settings in the system, and 
set up ObjectVideo Forensics. 
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This section describes how to install licenses on the computer running the 
ObjectVideo Server software. The system uses Sentinel LM for license management. 
Sentinel LM is installed when you install the ObjectVideo Server software.  

You must install licenses in order to run sensors. One license is required for each 
sensor in the system. For example, if you are going to run eight VEW Standard 
sensors on a network, you need to install eight VEW Standard licenses. Once the 
maximum number of licensed sensors is reached, running additional sensors will 
result in existing sensors becoming unusable. 

In addition, you have to install licenses to run FAST. Each simultaneous instance of 
FAST you are going to run requires a license. If you are going to run FAST on two 
computers at the same time on a network, for example, you need to install two FAST 
licenses. When the maximum number of instances of FAST opened simultaneously is 
reached, no other instances of FAST can be opened. 

ObjectVideo will provide you with a license file for each type of license you need to 
install. Each license file contains one or more licenses of a single type. For example, 
if you need to install four OnBoard 100 and two OnBoard 200 licenses, ObjectVideo 
will provide you with two license files, one containing the OnBoard 100 licenses and 
another containing the OnBoard 200 licenses. 

Important: 

• Do not run the ISE software before installing the appropriate licenses. 

• Do not run more sensors than you have licenses for (doing so will cause existing 
sensors to become unusable). 

• If you are deploying ObjectVideo Forensics, you must install both sensor and 
FAST licenses, because sensors generate the forensics data that is analyzed by 
FAST. 

Note: Users can open FAST even when they are not connected to the network. See 
“Checking Out an Authorization for Opening FAST Offline” on page 130 for more 
information about commuter licenses for FAST.  
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To Install Licenses 

1. From the Windows Start menu on the computer running the ObjectVideo Server 
software, select All Programs > ObjectVideo > License Installation Wizard. 

The first screen of the License Installation Wizard appears. 

2. Click Next. 

The Provide Your Locking Code to ObjectVideo screen appears. 

3. Send an e-mail message to license@objectvideo.com.  

This e-mail message must contain the following information: 

• locking code  

• host name of the computer running the Sentinel LM license server (this 
should be the host name of the computer running the ObjectVideo Server 
software) 

• number of sensors  

• sensor types  

ObjectVideo will send a license file to you by e-mail. 

4. Save the license file to the hard drive of the computer running the ObjectVideo 
Server software. 

5. Check the box at the bottom of the Provide Your Locking Code to 
ObjectVideo screen, and then click Next. 

The Install the License screen appears. 

6. Click the Load the license code from a file button. 

7. In the Open dialog, browse to the license file, and then click OK. 

The license code appears in the text box. 

8. Click Next. 

The Licenses Installed Successfully screen appears. 

9. Click Finish. 
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10. Do one of the following: 

• If you are setting up an ObjectVideo OnBoard system, proceed to “Installing 
the OnBoard ISE Software” on page 44. 

• If you are setting up an ObjectVideo VEW system, proceed to “Installing the 
VEW ISE Software” on page 48. 

Note: If the ObjectVideo Server hardware changes (e.g., if you install the 
ObjectVideo Server on a different machine, install a new Network Interface Card, 
etc.), the locking code will also change, and you will have to obtain a new license 
code from ObjectVideo. 
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This section describes how to install the ISE software for ObjectVideo OnBoard 
deployments. The ISE software manages sensors, which detect events within 
surveillance video. 

Install the ISE software on an ObjectVideo-certified computer that meets the 
specifications described in “ObjectVideo Server and ISE Hardware Requirements” on 
page 17. 

Before You Start 

• Make sure that the computer has all the prerequisite software installed. See 
“ObjectVideo Server and ISE Software Requirements” on page 225 for more 
information. 

• You must have an installation key and OnBoard ISE installation CD to complete 
this section. 

Important: Do not install and run the ISE software before you install licenses, as 
described in “Installing Licenses” on page 41. Installing and running the ISE before 
you install the licenses can cause the system to become unstable. 

Note: You must be logged in as a Windows user with Administrator privileges to 
install the ISE software. 
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To Install the OnBoard ISE Software 

Note: Perform the following steps for each computer that will run OnBoard ISE 
software. 

1. Insert the OnBoard ISE installation CD into the computer’s CD drive. 

The installer starts automatically. If it does not start automatically, use Windows 
Explorer to browse to the computer’s CD drive, and then double-click 
AutoSetup.js. 

The ObjectVideo Installation dialog appears. 

2. Click Yes. 

3. Do one of the following: 

• If the Welcome to the ObjectVideo Daemon Service Installation 
Wizard screen appears, proceed to step 4. 

• If the Welcome to the ObjectVideo OnBoard ISE Installation Wizard 
screen appears, skip to step 12. This can occur if the Daemon Service is 
already installed on the computer (e.g., because you installed the 
ObjectVideo Server on the computer, which includes the Daemon Service).  

4. Click Next. 

The License Agreement screen appears. 

5. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

6. Click Next. 

The Ready to Install the Software screen appears. 

7. Click Next. 

The Updating System screen appears, followed by the ObjectVideo Daemon 
Service Configuration screen. 

8. Type the product installation key. 

9. Do one of the following: 

• If the ObjectVideo Server software is installed on another computer on the 
network, change the Server Address to the host name (e.g., OBVServer1) 
or IP address (e.g., 192.168.1.1) of the ObjectVideo Server computer. 

If you use the ObjectVideo Server computer’s host name, you must have a 
DNS server running on your network. You can also use a hosts file for name 
resolution (see “Adding a Host to a Hosts File” on page 140). If your network 
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uses DHCP, you must use the host name of the computer running the 
ObjectVideo Server software rather than the computer’s IP address, because 
the IP address may change when the computer is rebooted. 

• If you are installing the ISE software on the same computer as the 
ObjectVideo Server, do not change the default Server Address (127.0.0.1), 
because that is an IP address reserved for the local computer. 

Note: The Server Port (8076) is the default port on which the ObjectVideo 
Server software listens. It is unlikely that you will have to change this value. 

10. Click OK. 

The ObjectVideo Daemon Service has been successfully installed screen 
appears. 

11. Click Finish. 

The Welcome to the ObjectVideo OnBoard ISE Installation Wizard screen 
appears. 

12. Click Next. 

The Ready to Install the Software screen appears. 

13. Click Next. 

The Updating System screen appears while the ISE software is installed on the 
computer, followed by a screen indicating that the installation of the ISE software 
was successful. 

14. Click Finish. 

The Welcome to the ObjectVideo Forensics Store Installation Wizard 
screen appears. 

15. Click Next. 

The Ready to Install the Software screen appears. 

16. Click Next. 

The Updating System screen appears while the Forensics Store service is 
installed on the computer, followed by the ObjectVideo Forensics Store 
Configuration dialog. 

17. Do one of the following: 

• Click the button to the right of the Forensics Data Directory field, browse 
to the local directory in which forensics data will be stored. Click OK on the 
Browse for Folder dialog. Click OK on the ObjectVideo Forensics Store 
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Configuration dialog. The ObjectVideo Forensics Store has been 
successfully installed screen appears. 

• In the Forensics Data Directory field, type the path to the local directory in 
which forensics data will be stored, and then click OK. The ObjectVideo 
Forensics Store has been successfully installed screen appears. 

You must specify a local forensics data directory, even if you have not purchased 
ObjectVideo Forensics. Forensics data is only actually generated when the sensor 
supports metadata and you have enabled the sensor to store the data. 

The path must be a local path (e.g., F:\Store), and you cannot specify a 
directory path with spaces. If the directories in the path you specify do not 
already exist, the installer will create them for you. 

18. Click Finish. 

An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the computer. 

19. Click Yes to reboot the computer. 

20. Proceed to “Adding Sensors (ObjectVideo OnBoard)” on page 53. 

Important: 

• You must reboot the computer in order for the ISE software to run. The ISE 
software runs automatically when the computer starts up. 

• Do not install or run more ISEs than your licensing arrangement permits. Doing 
so will cause the system to become unstable. 

• Some ObjectVideo systems require vendor-specific files known as Partner 
Packages that determine the appearance and behavior of the system, such as the 
supported sensor, event, response, and object filter types. If the system you are 
deploying requires a Partner Package, copy the Partner Package files to 
C:\Program Files\ObjectVideo\ISE\config on the computer running the ISE 
software. 

Note: The ObjectVideo Management Tool is automatically installed when the 
Daemon Service is installed. The ObjectVideo Management Tool is used to start and 
stop ObjectVideo services, to change various configuration settings in the system, 
and to set up ObjectVideo Forensics. 



Initial Deployment Steps 

Installing the VEW ISE Software 

 
 

This is Step 4 in the ObjectVideo VEW 
deployment process. This step is only 
necessary for ObjectVideo VEW systems. 

4 

This section describes how to install the ISE software for ObjectVideo VEW 
deployments. The ISE software manages sensors, which detect events within 
surveillance video. 

Install the ISE software on the ObjectVideo-certified computer you set up in “Setting 
Up the ISE Computer” on page 33. 

Before You Start 

• Make sure that the computer has all prerequisite software installed. See 
“ObjectVideo Server and ISE Software Requirements” on page 225 for more 
information. 

• You must have an installation key to complete this section. 

• One of the following installation CDs are required to complete the steps in this 
section: 

o The gray/purple VEW Standard ISE CD 

o The gray/orange VEW FlowControl ISE CD 

o The gray/yellow VEW HiRes CD 

o The gray/aqua ObjectVideo Leader/Follower CD 

Important: Do not install and run the ISE software before you install licenses, as 
described in “Installing Licenses” on page 41. Installing and running the ISE before 
you install the licenses can cause the system to become unstable. 

Note: You must be logged in as a Windows user with Administrator privileges to 
install the ISE software. 
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To Install the VEW ISE Software 

Note: Perform the following steps for each ISE computer. 

1. Insert the ISE installation CD into the computer’s CD drive. 

The installer starts automatically. If it does not start automatically, use Windows 
Explorer to browse to the computer’s CD drive, and then double-click 
AutoSetup.js. 

The ObjectVideo Installation dialog appears. 

2. Click Yes. 

3. Do one of the following: 

• If the Welcome to the ObjectVideo Daemon Service Installation 
Wizard screen appears, proceed to step 4. 

• If an ISE installation screen appears (such as the Welcome to the 
ObjectVideo VEW Standard Installation Wizard screen), skip to step 12. 
This can occur if the Daemon Service is already installed on the computer. 

4. Click Next. 

The License Agreement screen appears. 

5. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

6. Click Next. 

The Ready to Install the Software screen appears. 

7. Click Next. 

The Updating System screen appears, followed by the ObjectVideo Daemon 
Service Configuration screen. 

8. Type the product installation key. 

9. Change the Server Address to the host name (e.g., OBVServer1) or IP address 
(e.g., 192.168.1.1) of the ObjectVideo Server computer. 

If you use the ObjectVideo Server computer’s host name, you must have a DNS 
server running on your network. You can also use a hosts file for name 
resolution (see “Adding a Host to a Hosts File” on page 140). If your network 
uses DHCP, you must use the host name of the computer running the 
ObjectVideo Server software rather than the computer’s IP address, because the 
IP address may change when the computer is rebooted. 
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Note: The Server Port (8076) is the default port on which the ObjectVideo 
Server software listens. It is unlikely that you will have to change this value. 

10. Click OK. 

The ObjectVideo Daemon Service has been successfully installed screen 
appears. 

11. Click Finish. 

The first ISE installation screen appears. 

12. Click Next. 

The Ready to Install the Software screen appears. 

13. Do one of the following: 

• If you are not installing a VEW HiRes ISE, proceed to step 14. 

• If you are installing a VEW HiRes ISE, select a resolution (640 x 480 or 720 
x 480) from the Resolution field, and then proceed to step 14. 

Selecting 720 x 480 may result in a slightly longer monitoring range where 
events can be detected by ObjectVideo. The 640 x 480 setting is the correct 
aspect ratio for most computers, and you may want to select this option if 
you are going to export Alert Console images to a Hypertext Markup 
Language (HTML) file. 

14. Click Next. 

The Updating System screen appears while the ISE software is installed on the 
computer, followed by a screen indicating that the installation of the ISE software 
was successful. 

15. Click Finish. 

16. Do one of the following: 

• If the ObjectVideo Installation screen appears, proceed to step 17. 

• If the Welcome to the ObjectVideo Forensics Store Installation Wizard 
screen appears, proceed to step 20. 

17. Do one of the following when asked if you would like to install the ObjectVideo 
Serial Port service: 

• If you want to install the service, click Yes. Proceed to step 18. 

• If you do not want to install the service, click No. Proceed to step 20. 
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The ObjectVideo Serial Port service allows multiple VEW Leader/Follower sensors 
acting as followers to connect to a single COM port on the ISE computer. You will 
need to install and run this service if you have multiple cameras connected to an 
ISE computer with a single COM port. 

18. In the Welcome to the ObjectVideo Serial Port Service Installation Wizard 
screen, click Next. 

The Updating System screen appears while the ObjectVideo Serial Port service 
is installed, followed by the ObjectVideo Serial Port Service has been 
successfully installed screen. 

19. Click Finish. 

20. In the Welcome to the ObjectVideo Forensics Store Installation Wizard 
screen, click Next. 

The Ready to Install the Software screen appears. 

21. Click Next. 

The Updating System screen appears while the Forensics Store service is 
installed on the computer, followed by the ObjectVideo Forensics Store 
Configuration dialog. 

22. Do one of the following: 

• Click the button to the right of the Forensics Data Directory field, browse 
to the local directory in which forensics data will be stored. Click OK on the 
Browse for Folder dialog. Click OK on the ObjectVideo Forensics Store 
Configuration dialog. The ObjectVideo Forensics Store has been 
successfully installed screen appears. 

• In the Forensics Data Directory field, type the path to the local directory in 
which forensics data will be stored, and then click OK. The ObjectVideo 
Forensics Store has been successfully installed screen appears. 

You must specify a forensics data directory, even if you have not purchased 
ObjectVideo Forensics. A certain amount of forensics data is stored on all VEW 
ISE computers by default. 

The path must be a local path (e.g., F:\Store), and you cannot specify a 
directory path with spaces. If the directories in the path you specify do not 
already exist, the installer will create them for you. 

23. Click Finish. 

An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the ISE computer. 

24. Click Yes to reboot the computer. 
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25. Proceed to “Installing the VEW/OnBoard Client Applications” on page 55. 

Important: 

• You must reboot the computer in order for the ISE software to run. The ISE 
software runs automatically when the computer starts up. 

• Do not install or run more ISEs than your licensing arrangement permits. Doing 
so will cause the system to become unstable. 

• Some ObjectVideo systems require vendor-specific files known as Partner 
Packages that determine the appearance and behavior of the system, such as the 
supported sensor, event, response, and object filter types. If the system you are 
deploying requires a Partner Package, copy the Partner Package files to 
C:\Program Files\ObjectVideo\ISE\config on the computer running the ISE 
software. 

Note: The ObjectVideo Management Tool is automatically installed when the 
Daemon Service is installed. The ObjectVideo Management Tool is used to start and 
stop ObjectVideo services, to change various configuration settings in the system, 
and to set up ObjectVideo Forensics.  
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This section describes how to add ObjectVideo OnBoard sensors. In ObjectVideo 
OnBoard, you must add sensors after installing the ISE software. This step is not 
necessary for ObjectVideo VEW, because sensors are automatically added when the 
VEW ISE software is installed. 

Sensors monitor video to detect events in real-time and trigger alerts as events 
occur. One sensor is responsible for monitoring each video feed. OnBoard 100, 
OnBoard 200, and OnBoard 1000 sensors detect different event types. See 
“ObjectVideo OnBoard” on page 3 for information about the types of events 
ObjectVideo OnBoard sensors can detect. 

These sensors may support metadata. If a sensor supports metadata, it can 
generate the forensics data that ObjectVideo Forensics uses to search for past 
events. These sensors are identified as OnBoard 100MD, OnBoard 200MD, and 
OnBoard 1000MD in the ObjectVideo Management Tool. Except for their ability to 
support metadata, these sensors are identical to other OnBoard sensors. 

The steps in this section are performed using the ObjectVideo Management Tool on 
the computer running the ISE software. The number of sensors that can be created 
varies based on the sensor type, hardware configuration, and licensing. 

To Add a Sensor 

1. On the computer running the ISE software, run the ObjectVideo Management 
Tool (Start > All Programs > ObjectVideo > ObjectVideo Management 
Tool). 

2. In the ISE tab, click the Add Sensor button. 

The Add Sensor Type dialog appears. 

3. Select the type of sensor you want to create, and then click OK. 

A new sensor tab is created on the ISE tab. The new tab is named with a unique 
sensor ID generated by the system. 

4. Click Apply to apply your changes. 

If you do not click Apply, the sensor will not be added. The Number of Active 
Sensors is updated automatically to reflect the addition of the new sensor. 
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5. Do one of the following: 

• If you want to add another sensor, return to step 2. 

• If you have finished adding sensors, proceed to the next section, “Installing 
the VEW/OnBoard Client Applications.” 

Important: 

• Do not create more sensors than you have licenses to support. Doing so will 
cause the system to become unstable. 

• When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on that computer. This may take a 
few minutes. Only services that were running when you clicked Apply will be 
restarted. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. 

Note: If the Video Analysis Device is not a camera and supports multiple views, the 
system may be set up using a multiplexer/switcher, which enables one sensor to 
monitor multiple video feeds. 
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The VEW/OnBoard client applications are the System Configuration Tool, Rule 
Management Tool, and Alert Console. When you install the VEW/OnBoard client 
applications, you can choose to install only the Alert Console, only the Rule 
Management Tool and System Configuration Tool, or all of the VEW/OnBoard client 
applications. 

The role of these applications within the system depends on the products they are 
being used with, as described in the sections that follow.  

Note: After you install the client applications, you may wish to use Windows security 
to restrict access to each of the applications, so that system administrators have 
access to the System Configuration Tool only and security professionals have access 
to the Rule Management Tool and Alert Console only. 

About the Alert Console 

In ObjectVideo VEW and ObjectVideo OnBoard, the Alert Console displays alerts as 
events occur and allows you to search for alerts. Alerts provide a snapshot of the 
event and additional information, such as the location at which the event occurred, 
the camera the event took place in front of, and the date and time on which the 
event occurred.  

ObjectVideo provides an optional DVR Alert Console feature for some types of DVRs. 
The DVR Alert Console allows you to view a live video feed from a sensor that 
receives an alert. It also allows you to view a video segment from the time period 
when the alert occurred. Contact customer support for information on obtaining the 
DVR Alert Console (see “Getting Support” on page 223). 

About the System Configuration Tool 

The System Configuration Tool is used to set up the system’s configuration, enter 
information about components, and perform other system-related tasks. The System 
Configuration Tool is typically used right after the system is installed. 
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About the Rule Management Tool 

In ObjectVideo VEW and ObjectVideo OnBoard, the Rule Management Tool is used to 
set up rules for surveillance cameras. Rules tell the system which events to look for 
and how to respond when an event occurs. The system saves alerts in a database for 
later searching using the Alert Console, and it can be set up (using the Rule 
Management Tool) to respond to events by displaying alerts in the Alert Console, 
sending alerts by e-mail, or following objects with a PTZ camera (for VEW 
Leader/Follower).  

The Rule Management Tool is used to define an initial camera view during the set-up 
of the ObjectVideo Forensics or ObjectVideo VEW system if you are using VEW 
Standard, VEW HiRes, or VEW Leader/Follower sensors. For the system to detect 
events for the sensor, at least one view has to be set up for every video feed a 
sensor is monitoring and for every preset position on a PTZ camera. The Rule 
Management Tool is also used to create additional views for VEW Standard, VEW 
HiRes, VEW Leader/Follower, and ObjectVideo OnBoard sensors that support multiple 
views. 

Before You Start 

• Make sure that the computer you are installing the client applications on meets 
the “Client Application Hardware Requirements” on page 21. 

• Make sure that the computer has all the prerequisite software installed. See 
“Client Application Software Requirements” on page 226 for more information. 

• The red VEW/OnBoard client applications installation CD and an installation key 
are required to complete the steps in this section. 

To Install the VEW/OnBoard Client Applications 

On a computer that meets the minimum requirements for the VEW/OnBoard client 
applications (see “Minimum System and Environmental Requirements” on page 17), 
insert the VEW/OnBoard client applications installation CD in the computer’s CD 
drive. 

One of the following occurs: 

• An HTML page opens. Follow the instructions on the HTML page to install the 
software. 

• The HTML page does not open, and the installer does not run. If this occurs, 
use Windows Explorer to browse to the computer’s CD drive and double-click 
Installation_Instructions.htm. Follow the instructions on the HTML page. 

• In the event that you are unable to access the HTML page, the directions are 
included in the following section. 
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Complete the following steps to install the software: 

1. Use Windows Explorer to browse to the installation CD. 

2. On the CD, double-click AutoSetup.js. 

The ObjectVideo Installation dialog appears. 

3. Click Yes. 

4. Do one of the following: 

• If the Welcome to the ObjectVideo Daemon Service Installation 
Wizard screen appears, proceed to step 5. 

• If the Welcome to the ObjectVideo VEW/OnBoard Client Applications 
Installation Wizard screen appears, skip to step 13. This occurs if the 
Daemon Service is already installed on the computer. 

5. Click Next. 

The License Agreement screen appears. 

6. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

7. Click Next. 

The Ready to Install the Software screen appears. 

8. Click Next. 

The Updating System screen appears, followed by the ObjectVideo Daemon 
Service Configuration screen. 

9. Type the product installation key. 

10. Change the Server Address to the host name (e.g., OBVServer1) or IP address 
(e.g., 192.168.1.1) of the computer running the ObjectVideo Server software. 

If you use the computer’s host name, you must either have a DNS server running 
on your network or a hosts file for name resolution (see “Adding a Host to a 
Hosts File” on page 140 for more information). If your network uses DHCP, you 
must use the host name of the computer running the ObjectVideo Server 
software rather than the computer’s IP address, because the IP address may 
change when the computer is rebooted. 

Note: The Server Port (8076) is the default port on which the ObjectVideo 
Server software listens. It is unlikely that you will have to change this value. 

11. Click OK. 
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The ObjectVideo Daemon Service has been successfully installed screen 
appears. 

12. Click Finish. 

The Welcome to the ObjectVideo VEW/OnBoard Client Applications 
Installation Wizard screen appears. 

13. On the Welcome to the ObjectVideo VEW/OnBoard Client Applications 
Installation Wizard screen, click Next. 

The Select Applications screen opens. 

14. If desired, select Rule Management Tool and System Configuration Tool 
and/or Alert Console from the left side of the window. 

A drop-down menu appears. 

15. From the drop-down menu, select whether you want to install the software. 
By default, all of the software is installed. 

If you select Entire feature will be unavailable from the menu, the software 
will not be installed. Selecting either of the other options will result in the 
software being installed. If you click Reset, all the VEW/OnBoard client 
applications will be installed. 

16. Click Next. 

The Ready to Install the Software screen appears. 

17. Click Next. 

The Updating System screen appears while the VEW/OnBoard client 
applications are installed on the computer, and then the ObjectVideo 
VEW/OnBoard Client Applications have been successfully installed screen 
appears. 

18. Click Finish. 

An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the VEW/OnBoard client application computer. 

19. Click Yes to reboot the computer. 
 
You must reboot the computer in order for the System Configuration Tool, Rule 
Management Tool, and Alert Console to operate. 

20. If you want to use the DVR Alert Console, install it on the computer(s) running 
the Alert Console. 

See “About the Alert Console” on page 55 for more information on this feature. 
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21. Proceed to the next section, “Assigning a Video Source to a Sensor.” 

Important: Some ObjectVideo systems require vendor-specific files known as 
Partner Packages that determine the appearance and behavior of the system, such 
as the supported sensor, event, response, and object filter types. If the system you 
are deploying requires a Partner Package, copy the Partner Package files to 
C:\Program Files\ObjectVideo\Administration Tools\config on the computer 
running the VEW/OnBoard client application software. 

Note: The ObjectVideo Management Tool is automatically installed when the 
Daemon Service is installed. The ObjectVideo Management Tool is used to start and 
stop ObjectVideo services and change various configuration settings in the system. 
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This section describes how to assign a video source to a sensor. This is accomplished 
using the ObjectVideo Management Tool on the computer running the ISE software. 

In ObjectVideo VEW, when you assign a video source to a sensor, you are assigning 
the video feed the sensor will monitor. One sensor is responsible for monitoring each 
video feed. See “To Assign Video Sources to ObjectVideo VEW Sensors” for step-by-
step instructions. 

In ObjectVideo OnBoard, when you are assigning a video source, you are associating 
a sensor with a Video Analysis Device. See “To Assign Video Sources to ObjectVideo 
OnBoard Sensors” on page 62 for more information. 

When you have finished selecting the video source, click Apply. 

You can verify that the video source has been properly selected by opening the 
System Configuration Tool. If you have the System Configuration Tool open, you 
must click the Refresh Configuration button to display the new configuration. 

 

Select the sensor icon in the System Configuration Tool. Click the View tab to verify 
that a snapshot of video source you selected appears. See the System Configuration 
Tool Help for more information about the View tab. 

After you have completed this section, proceed to “Validating the Installation” on 
page 63. 

To Assign Video Sources to ObjectVideo VEW Sensors 

In the sensor’s tab on the ISE tab, select a video source for the sensor from the 
Video Source list. The list displays the ISE computer’s video inputs. The video 
inputs correspond to the video capture ports on the ISE computer. This is the source 
of the video feed that the ISE computer is receiving from a surveillance camera or 
multiplexer/switcher. The sensor analyzes this video feed. The number of video 
inputs listed does not necessarily correspond to the number of live camera feeds 
connected to the ISE computer. 

 60 



Initial Deployment Steps 

Select one of the following for each sensor: 

• device://video:0 

• device://video:1 

• device://video:2 

• device://video:3 

You must select a different video source for every sensor. Two or more sensors 
cannot share the default Video Source of device://video:0 or any of the other 
Video Source values. 

Important: 

• You must assign a different video source to each sensor. If you assign the same 
video source to two or more sensors, the system will not operate properly. 

• When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on that computer. This may take a 
few minutes. Only services that were running when you clicked Apply will be 
restarted. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. If you have the 
Rule Management Tool or System Configuration Tool open, you must click the 
Refresh Configuration button in these tools to display the new configuration. 

 

Notes: 

• It is not necessary to associate sensors with video sources that are not receiving 
a live camera feed. For example, in ObjectVideo VEW, if the video input on the 
ISE computer is not connected to a camera or multiplexer/switcher, there is no 
need to associate a sensor with that video input. To avoid confusion, you may 
want to rename unassigned sensors to indicate that they do not have a video 
source (e.g., Unassigned or No Video Source). 

• Next to the Video Source is the Selector field. If you are using an ObjectVideo-
certified computer to run the ISE software, you should never have to change this 
field. You would only change this setting if you have a video card that requires 
you to choose between physical inputs. 
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To Assign Video Sources to ObjectVideo OnBoard 
Sensors 

In the sensor’s tab on the ISE tab, enter a video source for the sensor. Use the 
Video Source field to associate a sensor with a Video Analysis Device. The 
convention for assigning video sources is determined by the type of Video Analysis 
Device you are using. Contact your Video Analysis Device vendor for instructions. 

Important: 

• You must assign a different video source to each sensor. If you assign the same 
video source to two or more sensors, the system will not operate properly. 

• When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on that computer. This may take a 
few minutes. Only services that were running when you clicked Apply will be 
restarted. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. If you have the 
Rule Management Tool or System Configuration Tool open, you must click the 
Refresh Configuration button in these tools to display the new configuration. 
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Validating the Installation 

 
 

This is Step 7 in the ObjectVideo VEW 
deployment process. 

   

   
This is Step 8 in the ObjectVideo OnBoard 
deployment process. 

7 

8 

In this section, you will ensure that the system is running properly so that you can 
troubleshoot any problems you observe. Validating the installation involves the 
following: 

• Using the System Configuration Tool to check the system 

• Validating that the Alert Console can connect to the ObjectVideo Server 

After you take the steps in this section, do one of the following: 

• If you are deploying ObjectVideo VEW, proceed to “Creating Views 
(ObjectVideo VEW)” on page 70. 

• If you are deploying ObjectVideo OnBoard, proceed to “Forcing or Adding 
Views (ObjectVideo OnBoard)” on page 72. 

Using the System Configuration Tool to Check the 
System  

Run the System Configuration Tool. By default, if everything is working properly, the 
System Configuration Tool automatically connects to the ObjectVideo Server running 
on the network, and the Tool displays the ISE(s) you have installed with their 
sensor(s). 

This section describes what a properly running system looks like after you have 
completed the ISE installation process and assigned video sources. If your system 
does not seem to be running properly, skip to “Symptoms of System Problems” on 
page 67. 
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The following figure shows a System Configuration Tool window displaying a newly 
installed system with all components running and communicating and a VEW 
Standard ISE with four sensors. VEW Standard sensors are initially in a Searching 
for Known View status, indicated by a yellow dot.  

 

A system with VEW Leader/Follower sensors would appear the same as the figure 
above, except with VEW Leader/Follower sensor icons instead of VEW Standard 
icons. 

 

In the following figure, the System Configuration Tool window displays a VEW 
FlowControl ISE and two sensors. VEW FlowControl sensors are initially in a Known 
View status, indicated by a green dot. 
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In the following figure, the System Configuration Tool window displays a VEW HiRes 
ISE and one sensor. VEW HiRes sensors are initially in a Searching for Known 
View status, indicated by a yellow dot. 

 

In the following figure, the System Configuration Tool window displays an OnBoard 
ISE with an OnBoard 1000 sensor. Once they are assigned a video source, OnBoard 
sensors are in a Known View status, indicated by a green dot. 

 

A system with OnBoard 100 sensors would appear the same as the previous figure, 
except with OnBoard 100 icons instead of OnBoard 1000 icons.  

 

A system with OnBoard 200 sensors would appear the same as the figure above, 
except with OnBoard 200 icons instead of OnBoard 1000 icons. 

 

Note: You should see an ObjectVideo OnBoard sensor icon for every sensor you 
added in “Adding Sensors (ObjectVideo OnBoard)” on page 53. 
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Check for the following, which indicate that the system is running properly: 

• The Connect Status should be Connected, and the Server Status should 
be Online. Both statuses are displayed in the upper-right corner of the 
System Configuration Tool window. 

 

• On the left side of the System Configuration Tool window, under the 
ObjectVideo Server icon, one ISE icon should appear for each ISE that is 
running on the network. 

 

By default, the name of each ISE is the host name of the computer that the ISE 
software is running on. 

Sensor icons represent sensors that monitor video feeds for events. Based on the 
table that follows, verify that the appropriate number of sensor icons appear (per ISE 
icon) with the default sensor status. 

Sensor Type Sensor 
Icon 

Number of  
 Sensor Icons 

Initial Sensor Status 

VEW Standard  4 Searching for Known View status 
that eventually becomes an 
Unknown View status. These 
statuses are indicated by a yellow 
dot next to each sensor icon. 

VEW 
Leader/Follower 

 4 Searching for Known View status 
that eventually becomes an 
Unknown View status. These 
statuses are indicated by a yellow 
dot next to each sensor icon. 

VEW HiRes  1 Searching for Known View status 
that eventually becomes an 
Unknown View status. These 
statuses are indicated by a yellow 
dot next to each sensor icon. 

VEW 
FlowControl 

 2 Known View status. This status is 
indicated by a green dot next to 
each sensor icon. (If the status is 
not Known View immediately, it 
should be within a few seconds.) 
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Sensor Type Sensor Number of  Initial Sensor Status 
Icon  Sensor Icons 

OnBoard 100  Varies according 
to license and 

hardware 
configuration 

Known View status. This status is 
indicated by a green dot next to 
each sensor icon. 

OnBoard 200  Varies according 
to license and 

hardware 
configuration 

Known View status. This status is 
indicated by a green dot next to 
each sensor icon. 

OnBoard 1000  Varies according 
to license and 

hardware 
configuration 

Known View status. This status is 
indicated by a green dot next to 
each sensor icon. 

See the “System Configuration Tool/Rule Management Tool Troubleshooting” on page 
175 for more information about sensor statuses. 

Each sensor’s name starts with the host name of the computer running the ISE 
software, followed by a string of random characters. 

When you select an ISE icon and click the View tab, a snapshot of a video feed 
should appear for each sensor with an assigned video source. 

Note: If the system does not seem to be running properly, refer to the next section, 
“Symptoms of System Problems,” on page 67.  

Symptoms of System Problems 

The following symptoms in the System Configuration Tool indicate that a problem 
may have occurred. Refer to the indicated page in “System Configuration Tool/Rule 
Management Tool Troubleshooting” for information about how to address the 
problem. 

Table 7: Symptoms of System Problems 

Symptom Page 

The Server Status is Offline. 

 

177
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Symptom Page 

Only the ObjectVideo Server 
icon appears, with no ISE 
icons. 

 

183

An Operation timed out 
message appears in the 
bottom center of the System 
Configuration Tool window.  

 

189

The Connection Failure 
dialog appears. 

 

182

The Connect Status is 
DAEMON UNAVAILABLE. 

 

182

The Server Status is 
Unknown. (The Connect 
Status can vary in this case.) 

 

178

One or more of the sensors 
displayed in the System 
Configuration Tool are in an 
Unvalidated status, with a 
question mark beside the 
sensor icon(s).  

 

198

To Verify that the Alert Console Connects to the 
System 

1. Open the Alert Console. 

2. Verify that the Server Status is Online. 
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The Server Status message appears in the lower-left corner of the Alert 
Console. 

 

If the Server Status is not Online, the Alert Console is not communicating 
properly. Refer to “Alert Console Troubleshooting” on page 203 for more 
information. 

Note: You will not receive any alerts unless you have created a rule in the Rule 
Management Tool that requires an alert response, and an event has occurred to 
trigger that response. Refer to “Creating Rules” on page 80 for more information. 
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Creating Views (ObjectVideo VEW) 

 
 

This is Step 8 in the ObjectVideo VEW 
deployment process. This step is only 
necessary for ObjectVideo VEW systems. 

8 

You must create at least one view before you create a VEW Standard, VEW HiRes, or 
VEW Leader/Follower rule or ObjectVideo Forensics scenario. Sensors cannot detect 
events until you define a view. A view (also referred to as a stored view) is a 
surveillance camera’s field of view that has been designated in the system for 
monitoring by a sensor. For sensors that support multiple views, views are used to 
accommodate the use of PTZ surveillance cameras and multiplexers/switchers.  

Notes:  

• VEW FlowControl does not support views. Some ObjectVideo OnBoard sensors 
may also support multiple views, but the initial view of all ObjectVideo OnBoard 
sensors is automatically assigned by the system when the video source is 
assigned to the sensor. 

• If a VEW Leader/Follower sensor is only going to follow objects, not detect 
events, you do not need to create a view for the sensor. 

To Create an Initial View  

1. Run the Rule Management Tool. 

2. In the Rule Manager area on the left side of the Rule Management Tool window, 
select the sensor to which you want to add a view. 

3. Click the View tab on the right side of the Rule Management Tool window. 

The snapshot on the left shows the feed from the surveillance camera. The 
snapshot on the right contains the text Unknown View. 

4. Do one of the following, if desired: 

• Leave the camera in the current field of view. 

• If the camera is a PTZ camera, move or zoom the camera to a position or 
zoom level you want the system to monitor. 

• If the camera corresponds to several cameras on a multiplexer/switcher, 
switch to the camera you want the system to monitor. 

5. Click the Add button between the two snapshots. 

The Add View dialog appears. 
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6. Type a Name and Description for the new view. 

Use a name that will make the view easily recognizable. 

The table that follows describes the rest of the properties displayed on the Add 
View dialog. 

Table 8: View Properties 

Property Description 

Created By The Windows user ID of the user who created the view. 

Created On The date and time on which the view was created. 

Modified By The Windows user ID of the last user who edited the view.  

Modified 
On 

The date and time on which the view was last modified. 

Filters Indicates whether or not object filters have been defined for this 
view. Object filters are optional. The field contains the text 
Undefined, because the view is new and no object filters have been 
defined for the view yet. If you are using ObjectVideo VEW or 
ObjectVideo OnBoard for real-time event detection, you can create 
object filters later by editing the view. If you are using ObjectVideo 
Forensics only, there is no need to define an object filter from this 
dialog. 

7. Click OK. 

A snapshot of the new view appears at the bottom of the View tab. The snapshot 
has a green box around it, indicating that the live camera feed matches the new 
view you have created. The snapshot of the view is also added to the right of the 
Live Camera Feed snapshot as the Active View. 

In addition, a green dot appears to the left of the sensor’s name and the view’s 
name in the Rule Manager area on the left side of the Rule Management Tool 
window. 

8. Repeat steps 2-7 for every VEW Standard, VEW HiRes, and VEW Leader/Follower 
sensor that will detect events. 

9. Proceed to “Editing and Reviewing Component Properties” on page 75. 

Note: After you have created the initial view, you cannot create additional views for 
that sensor until you pan the camera or switch to another camera on the 
multiplexer/switcher. See the Rule Management Tool Help for information about 
creating additional views, managing views, and troubleshooting views.  
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Forcing or Adding Views (ObjectVideo OnBoard) 

   

This is Step 9 in the ObjectVideo OnBoard 
deployment process. This step is only 
necessary for ObjectVideo OnBoard systems. 

9

When the ObjectVideo OnBoard system is installed, a default view is created that 
reflects the field of view of the camera at the time of the installation. 

ObjectVideo OnBoard sensors may have the capability to support multiple views 
based on the Video Analysis Device you are using. Contact your Video Analysis 
Device vendor for more information. The Rule Management Tool provides different 
options based on whether the sensor has the capability to support multiple views. 

If your sensor only supports a single view, this default view will be the field of view 
for which you create rules unless you change the default view. You can change a 
sensor’s default view by moving the surveillance camera or adjusting the zoom of 
the camera and then using the Rule Management Tool to force the view. This is an 
optional step for ObjectVideo OnBoard deployments. See “To Force a View” below for 
instructions. 

If your sensor supports multiple views, you can add a new view for the sensor. This 
is an optional step for ObjectVideo OnBoard deployments. See “To Add an Additional 
View” on page 73 for instructions. 

Note: If using multiple views, remember that differences between views may require 
different rule settings between views. 

To Force a View 

1. Run the Rule Management Tool. 

2. On the left side of the Rule Management Tool window, select the sensor icon 
associated with the view you want to change. 

The status of the sensor should be Unknown View (with a yellow dot beside the 
sensor icon), because you moved the camera or adjusted its zoom and the 
sensor no longer recognizes the camera’s field of view. You can only force the 
view if the sensor’s status is Unknown View. 

3. On the right side of the Rule Management Tool window, select the View tab. 

4. Click the Force button between the two snapshots in the upper portion of the 
View tab. 

5. When the Force View dialog appears, select the view and click the Force View 
button. 
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The Forcing View dialog is displayed until the view is added. The view now 
matches the Live Camera Feed. It replaces the Unknown View snapshot in the 
Active View area, and a green box appears around the view in the lower portion 
of the View tab, indicating that the sensor is now monitoring that view. 

6. Repeat steps 2-5 for every sensor on which you want to force a view. 

7. Proceed to the next section, “Editing and Reviewing Component Properties.” 

To Add an Additional View 

1. Run the Rule Management Tool. 

2. In the Rule Manager area on the left side of the Rule Management Tool window, 
select the sensor to which you want to add a view. 

3. Click the View tab on the right side of the Rule Management Tool window. 

The snapshot on the left shows the video feed from the surveillance camera. 

4. Do one of the following, if desired: 

• If the camera is a PTZ camera, move or zoom the camera to a position or 
zoom level you want the system to monitor. 

• If the camera corresponds to several cameras on a multiplexer/switcher, 
switch to the camera you want the system to monitor. 

5. Click the Add button between the two snapshots. 

The Add View dialog appears. 

6. Type a Name and Description for the new view. 

Use a name that will make the view easily recognizable. 

The table that follows describes the rest of the properties displayed on the Add 
View dialog. 

Table 9: View Properties 

Property Description 

Created By The Windows user ID of the user who created the view. 

Created On The date and time on which the view was created. 

Modified By The Windows user ID of the last user who edited the view.  

Modified 
On 

The date and time on which the view was last modified. 
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Property Description 

Filters Indicates whether or not object filters have been defined for this 
view. Object filters are optional. The field contains the text 
Undefined, because the view is new and no object filters have been 
defined for the view yet. If you are using ObjectVideo VEW or 
ObjectVideo OnBoard for real-time event detection, you can create 
object filters later by editing the view. If you are using ObjectVideo 
Forensics only, there is no need to define an object filter from this 
dialog. 

7. Click OK. 

A snapshot of the new view appears at the bottom of the View tab. The snapshot 
has a green box around it, indicating that the live camera feed matches the new 
view you have created. The snapshot of the view is also added to the right of the 
Live Camera Feed snapshot as the Active View. 

In addition, a green dot appears to the left of the sensor’s name and the view’s 
name in the Rule Manager area on the left side of the Rule Management Tool 
window. 

8. Repeat steps 2-7 for every sensor on which you want to add a view. 

9. Proceed to the next section, “Editing and Reviewing Component Properties.” 

Note: Video Analysis Devices are configured to only support a limited number of 
views. If you receive an error when you try to add a view, consult your Video 
Analysis Device vendor. 
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Editing and Reviewing Component Properties 

 
 

This is Step 9 in the ObjectVideo VEW 
deployment process. 

   

   
This is Step 10 in the ObjectVideo OnBoard 
deployment process. 

9 

10 

When you select any component (ObjectVideo Server, ISE, or sensor) on the left side 
of the System Configuration Tool window, information about that component appears 
in the Properties tab on the right side of the window. As this section describes, 
some fields provide read-only information about your configuration and other fields 
allow you to enter data. All properties are also displayed (read-only) in the Rule 
Management Tool. 

Important: If the Operation timed out message appears in the bottom left of the 
System Configuration Tool window when you select a component, the Tool may not 
be displaying the current component properties. See “Sensor Synchronization Times 
Out and Operation Timed Out Message Appears” on page 189 for information on why 
this message may appear. 

Notes: 

• With the exception of the Source and Status fields, the Properties tab is for 
your reference only and does not affect the operation of the system in any way. 

• You can click Reset to automatically restore editable fields to the values they had 
when the component was last selected. 

• Make sure that you click Apply to save any changes you make to the component 
properties. 

Editing and Reviewing ObjectVideo Server and ISE 
Properties 

You can enter and view information about the ObjectVideo Server and ISE(s) in the 
Properties tab. 

To Edit and Review ObjectVideo Server and ISE Properties 

1. Select the ObjectVideo Server icon on the left side of the System Configuration 
Tool window. 
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The Properties tab displays the name of the ObjectVideo Server and the version 
number of the ObjectVideo Server software you are running. 

2. Select an ISE icon on the left side of the System Configuration Tool window. 

3. If desired, in the Properties tab, enter the Name, Description, and Location 
of the ISE. 

These fields are for your reference only, so you can use whatever naming 
conventions you have established. Avoid giving ISEs the same name. Unique 
names will make it easier to identify ISEs in the System Configuration Tool. 

4. Review the ISE fields described in the table that follows. 

Table 10: ISE Properties 

Property Meaning 

Version The version number of the ISE software 

Net Address The IP address of the computer running the ISE software and the 
TCP port number 

Status  The status the ISE is reporting to the System Configuration Tool 

Sensors A list of the sensors running on the same computer as the ISE 
software 

5. Click Apply to save your changes. 

6. Repeat steps 2–5 for each ISE in your configuration. 

Editing and Reviewing Sensor Properties 

You may want to enter information about your sensors in the Properties tab. There 
are also read-only sensor properties that can be reviewed from this tab. 

To Edit and Review Sensor Properties 

1. Select a sensor icon on the left side of the System Configuration Tool window. 

2. If desired, complete the fields described in the table that follows. 

Table 11: Sensor Properties to Edit 

Property Meaning 

Name The name of the sensor. Avoid giving sensors the same name. Unique 
names will make it easier to identify sensors in the Rule Management 
Tool and System Configuration Tool. 

Description Any description of the sensor. 
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Property Meaning 

Location Where the camera is physically located: Indoor or Outdoor. You can 
also select other and type a location in the Location field. 

Source In ObjectVideo VEW, this is the name of the video input on the ISE 
computer associated with the sensor. If you select other from the 
Source list, you can enter the path to an AVI file (e.g., 
C:\Media\default.avi) in the field below the Source list. The AVI 
file must be located on the ISE computer. 

In ObjectVideo OnBoard, use the Source field to associate a sensor 
with a Video Analysis Device. 

See the System Configuration Tool Help for information on assigning 
the source in the System Configuration Tool. You can also assign the 
source in the ObjectVideo Management Tool using the instructions in 
“Assigning a Video Source to a Sensor” on page 60. 

Make The manufacturer of the camera. 

Model The model number of the camera. Choices may populate based on the 
Make selection. 

Spec Any additional specifications. May be populated based on the Model 
selection. 

Type The type of camera: Black & White, Color, Active IR, Thermal, 
IDN, or other. 

Mount The type of mount the camera utilizes: Fixed, Fixed Dome, PTZ, 
Auto Dome, or other. 

3. Review the sensor fields described in the table that follows. 

Table 12: Sensor Properties to Review 

Property Meaning 

Intelligent Sensor 
Engine 

The name of the ISE. 

Group  If applicable, the group the sensor belongs to. 

Status The status of the sensor. See the System Configuration Tool 
Help for more information about sensor status. 

4. Click Apply to save your changes. 

5. Repeat steps 1–4 for each sensor icon in your configuration. 



 

Completing the ObjectVideo VEW 
and ObjectVideo OnBoard 
Deployment Process 
This chapter describes the final steps in setting up ObjectVideo VEW and ObjectVideo 
OnBoard. These systems detect events in real time and notify users of those events. 
You do not need to complete the steps in this chapter if you do not want to take 
advantage of the ObjectVideo VEW or ObjectVideo OnBoard real-time event detection 
capabilities and are going to use only ObjectVideo Forensics or the ObjectVideo 
Integrator Toolkit. 

To complete the ObjectVideo VEW and ObjectVideo OnBoard set-up process, perform 
the initial installation and set-up steps described in “Initial Deployment Steps” 
starting on page 28, and then take the following steps described in this chapter: 

• Calibrating VEW Leader/Follower sensors (VEW Leader/Follower only) 

• Creating rules 

• Configuring the system for e-mail responses (optional) 

• Creating contacts (optional) 

• Testing the alert sound (optional) 
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Calibrating VEW Leader/Follower Sensors 

VEW Leader/Follower allows a PTZ camera to follow an object that triggered an event 
in another camera's view. The sensor that originally detects the event is known as 
the leader. The sensor that subsequently follows the object is known as the follower. 

In the Leader/Follower Calibration Tool, you calibrate the follower to the leader 
sensor's view. During this process, you determine how the follower will pan, tilt, and 
zoom to target an object. The Leader/Follower Calibration Tool is part of the 
ObjectVideo Integrator Toolkit. To install the ObjectVideo Integrator Toolkit, see 
“Installing the ObjectVideo Integrator Toolkit Applications” on page 106. 

Before you create a VEW Leader/Follower rule that contains a follow object response, 
you must use the Leader/Follower Calibration Tool. 

The Help system available with the Leader/Follower Calibration Tool contains detailed 
information on how to calibrate VEW Leader/Follower sensors. To open the Help in 
the Leader/Follower Calibration Tool, select Contents from the Help menu. 
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Creating Rules 

The installation and set-up process is complete for ObjectVideo VEW and ObjectVideo 
OnBoard. You are ready to start using the system. The steps below provide a brief 
introduction on how to create rules. Rules tell the system which events to look for on 
the video feeds from surveillance cameras and how to respond to those events. 

See the Rule Management Tool Help’s “Getting Started” topic for detailed information 
about how to create rules in ObjectVideo VEW and ObjectVideo OnBoard. To access 
the Help, select Help > Contents in the Rule Management Tool window. 

To Create a Rule 

1. In the Rule Manager area on the left side of the Rule Management Tool window, 
select the view icon, VEW FlowControl sensor icon, or OnBoard sensor icon for 
which you want to create a rule. 

2. Click the Rules tab on the right side of the Rule Management Tool window. 

3. Click New. 

The first screen of the Rule Wizard appears. 

4. If desired, edit the Name and Description fields. 

5. Click Next. 

The Create Event screen appears. 

6. Select Create New Event or Copy From Existing Event. 

7. If you are copying from an existing event, select an event from the Existing 
Event drop-down list. 

8. If desired, edit the event name. 

9. Select an event type. 

10. Complete the Event Specification area, and then click Next. 

11. Specify a schedule, and then click Next. 

12. Specify one or more responses. Click Next on each Create Response screen. 

13. On the last Create Response screen, click Finish. 

A rule must be active before it can trigger alerts. When a rule is first created, it is 
inactive. You can tell that a rule is inactive because there is no check mark next 
to the rule’s name in the Active column. 

14. Activate the rule by checking the box in the Active column to the right of the 
rule’s name. 
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Note: Each Video Analysis Device supports a limited number of active rules. The 
number of active rules supported varies depending on the Video Analysis Device 
being used. Contact your Video Analysis Device vendor for more information. 
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Configuring the System for E-mail Responses 
(Optional) 

When you create rules, you have the option of having ObjectVideo VEW and 
ObjectVideo OnBoard generate e-mail-based alerts when events occur. If you are 
going to use e-mail-based responses, you must use the System Configuration Tool to 
specify an SMTP server and a sending e-mail address. 

To Configure the System for E-mail Responses 

1. Start the System Configuration Tool, if it is not already running. 

2. Select File > Options. 

The System Configuration Tool Options dialog appears. 

3. Click the Connection tab. 

4. In the E-mail (SMTP) Server field, enter the host name or IP address of the 
SMTP server used to send alert e-mail messages. 

5. In the E-mail Response Sender field, enter an e-mail address. 

When e-mail alert messages are sent, this is the e-mail address that the 
messages are sent from. The name entered here will appear in the From field of 
response e-mail messages. If an alert e-mail is replied to, it will be sent to this 
address. 

6. Click OK. 

Note: An e-mail response will not occur unless a rule has been created that requires 
an e-mail response and an alert is triggered due to that rule. See the Rule 
Management Tool Help for information about creating e-mail responses for rules. 
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Creating Contacts (Optional) 

Contacts are created and managed in the Contacts tab of the Rule Management 
Tool. Contacts help you quickly find the contact information of coworkers and 
associates and make it easier for you to create e-mail-based responses to events. 
Contacts can be stored in a file on your local computer or shared on a computer 
network for centralized contact management. 

To Create Contacts 

1. Start the Rule Management Tool, if it is not already running. 

2. Select File > Options. 

The Rule Management Tool Options dialog appears. 

3. Click the Contacts tab. 

4. Click Add. 

The Contact Data window appears. 

5. Enter the contact information in the Contact Data window. 

Note: The Name and E-Mail fields are required. 

6. Click OK. 

7. Repeat steps 4–6 for each contact you want to add. 

8. Click Apply in the Rule Management Tool Options dialog to save the contacts 
you have added. 

Notes: 

• You can click the Reset button to “undo” the addition of a new contact. 

• Providing an e-mail address in the E-mail field assists users when they create e-
mail-based responses to events. The user can type only the name of the e-mail 
recipient, rather than having to type the recipient’s entire e-mail address. 
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Testing the Alert Sound (Optional) 

The Alert Console can play an audible alert when new alerts are displayed in the 
Alert Console. In order for the Alert Console to play a sound when an event occurs, 
the appropriate event response must have been set up for that event using the Rule 
Management Tool. 

If it is not already running, open the Alert Console. You can test whether you are 
able to hear audible alerts by selecting Test Alert Sound from the Tools menu. This 
option plays an example alert sound. The only purpose for this option is to allow you 
to see if your computer is capable of generating an alert sound. 

If you do not hear an alert sound, consult “Alert Console Troubleshooting” on 
page 203 for information on how to fix this problem. 

After you have completed the installation of ObjectVideo VEW and ObjectVideo 
OnBoard, you can do the following: 

• To complete the set-up and installation of ObjectVideo Forensics, see 
“Completing the ObjectVideo Forensics Deployment Process” on page 85. 

• To install the ObjectVideo Integrator Toolkit, see “Installing the ObjectVideo 
Integrator Toolkit Applications” on page 106. 



 

Completing the ObjectVideo 
Forensics Deployment Process 
This chapter describes how to complete the installation and set-up of ObjectVideo 
Forensics, which collects data about live video for later analysis. Only complete the 
steps in this chapter if you are going to use ObjectVideo Forensics. 

You must install and configure ObjectVideo VEW or ObjectVideo OnBoard with 
metadata before you can use ObjectVideo Forensics. ObjectVideo VEW or 
ObjectVideo OnBoard components are required to set up the ObjectVideo Forensics 
system and to analyze surveillance video for later analysis by ObjectVideo Forensics. 

After you have completed the steps in “Initial Deployment Steps” starting on 
page 28, perform the steps described in this chapter to complete the ObjectVideo 
Forensics set-up and installation process: 

• Customizing forensics storage settings 

• Sharing the forensics data directory for access by FAST 

• Enabling forensics for ObjectVideo OnBoard sensors 

• Validating that forensics data is being generated 

• Installing FAST 

• Creating scenarios 
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Customizing Forensics Storage Settings 

This section describes how to customize the following ObjectVideo Forensics settings: 

• Setting the time span for the storage of forensics data 

• Customizing settings that affect the disk space used for forensics data 

• Setting the File Clipping Interval 

You must be logged in as a Windows user with Administrator or Power User 
privileges to complete the steps in this section. 

Setting the Time Span for the Storage of Forensics 
Data 

You can customize the time span for which the Forensics Store service stores 
forensics data. This setting is configured for each sensor separately using the 
ObjectVideo Management Tool. For example, you can configure the Forensics Store 
service so that it stores one sensor’s forensics data for four days at a time and 
another sensor’s forensics data for ten days at a time. When the specified time span 
is exceeded, the Forensics Store service begins deleting the oldest primitives and 
video files. By default, the Forensics Store service stores seven days of forensics 
data for each sensor. 

Note: Increasing the forensics data storage time span for a sensor increases the 
amount of drive space occupied by forensics data. Consult “Target Time Spans and 
Disk Space Used for Forensics Data” on page 87 before increasing the time span. 

To Set the Time Span for the Storage of Forensics Data 

1. Run the ObjectVideo Management Tool on the ISE computer. 

2. On the Forensics Store tab, click the Advanced button. 

The Forensics Store Advanced Options dialog appears. 

3. On the bottom of the Forensics Store Advanced Options dialog, click the tab 
associated with the sensor for which you want to change the Target Time Span. 

4. Change the Target Time Span to the desired time span. 

The Target Time Span is specified in days, hours, minutes, and seconds 
(DD.HH:MM:SS). The default Target Time Span is seven days (7.00:00:00). 

Note: The Target Time Span is not guaranteed. Other settings affect the 
amount of data that is stored (i.e., the amount of disk space occupied by 
forensics data), and they are based on factors such as remaining disk space and 
the expected data stored based on estimated bit rates. See “Customizing Settings 
that Affect the Disk Space Used for Forensics Data” on page 89 for more 
information. 
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5. Click OK. 

6. Click the Apply button on the ObjectVideo Management Tool window. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 

Target Time Spans and Disk Space Used for Forensics Data 

The tables that follow reflect the amount of data stored when the default settings for 
Primitive Stream Bit Rate and Video Stream Bit Rate are used on the Forensics 
Store Advanced Options tab. Changing these settings affects the amount of data 
being stored, but you should not change them without consulting customer support 
for assistance (see “Getting Support” on page 223). 

To access the Forensics Store Advanced Options tab in the ObjectVideo 
Management Tool, open the ObjectVideo Management Tool on an ISE computer, and 
then click the Forensics Store tab. On the Forensics Store tab, click the 
Advanced button. 

For all types of sensors, the default Primitive Stream Bit Rate is the same, at 
122,880 bits per second (bps). The Video Stream Bit Rate settings vary, 
depending on the type of sensor being used. For VEW Standard, VEW FlowControl, 
VEW Leader/Follower, and ObjectVideo OnBoard sensors, the default rate is 
563,200 bps. For VEW HiRes sensors, the default rate is 2,252,800 bps. 
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The storage units in the tables are indicated in megabytes (MB), gigabytes (GB), or 
terabytes (TB). 

Table 13: Max. Total Disk Space Used by Multiple Sensors Over Time (VEW 
Standard, VEW FlowControl, VEW Leader/Follower, and ObjectVideo 
OnBoard) 

Disk Space 
Time Span 

1 Sensor 2 Sensors 3 Sensors 4 Sensors 

1 second 83.75 KB 167.5 KB 251.25 KB 335 KB 

1 minute 4.907 MB 9.814 MB 14.722 MB 19.629 MB 

1 hour 294.434 MB 588.867 MB 883.301 MB 1.15 GB 

1 day 6.901 GB 13.802 GB 20.702 GB 27.603 GB 

5 days 34.504 GB 69.008 GB 103.512 GB 138.016 GB 

7 days 48.306 GB 96.611 GB 144.917 GB 193.222 GB 

10 days 69.008 GB 138.016 GB 207.024 GB 276.031 GB 

14 days 96.611 GB 193.222 GB 289.833 GB 386.444 GB 

30 days 207.024 GB 414.047 GB 621.071 GB 828.094 GB 

180 days 1.213 TB 2.426 TB 3.639 TB 4.852 TB 

365 days 2.46 TB 4.92 TB 7.379 TB 9.839 TB 
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Table 14: Max. Total Disk Space Used by Sensor Over Time (VEW HiRes) 

Time Span Disk Space (1 Sensor) 

1 second 290 KB 

1 minute 16.992 MB 

1 hour 0.996 GB 

1 day 23.895 GB 

5 days 119.476 GB 

7 days 167.267 GB 

10 days 238.953 GB 

14 days 334.534 GB 

30 days 716.858 GB 

180 days 4.2 TB 

365 days 8.517 TB 

The amount of forensics data stored is also affected by the Min Disk Space 
Available In Bytes setting on the Forensics Store Advanced Options tab. The 
purpose of the Min Disk Space Available In Bytes setting is to preserve a specific 
amount of drive space on the computer running the Forensics Store service. When 
the amount of space remaining on the Forensics Store service computer’s hard drive 
reaches the Min Disk Space Available In Bytes setting (about 47.68 MB by 
default), the Forensics Store service starts deleting the oldest primitives and video 
files until the available drive space is above the threshold. 

Customizing Settings that Affect the Disk Space Used 
for Forensics Data 

Several settings affect how much disk space is occupied by the forensics data stored 
by the Forensics Store service. You can customize these settings based on the disk 
space available on the computer(s) on which forensics data is being stored. 

Most of the settings that affect the amount of disk spaced used for forensics data are 
configured on the computer running the Forensics Store service from the 
ObjectVideo Management Tool’s Forensics Store Advanced Options dialog. 
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To access the Forensics Store Advanced Options dialog, take the following steps: 

1. Run the ObjectVideo Management Tool on the ISE computer, if it is not 
already running. 

2. On the Forensics Store tab, click the Advanced button. 

The Forensics Store Advanced Options dialog appears. 

The Forensics Store Advanced Options settings listed in the table that follows 
affect the amount of disk space used for forensics data. 

Table 15: Forensics Store Advanced Options Settings that Affect Disk Space 

Setting Description Default Value 

Min Disk Space Available 
In Bytes 

Specifies the minimum 
amount of space that must 
remain available on the disk 
where forensics data is 
being stored. See “Setting 
the Min Disk Space Available 
In Bytes” on page 91 for 
more information. 

50,000,000 bytes 
(about 47.68 MB) 

Store Check Interval Specifies how often the 
Forensics Store service 
checks to make sure that 
the time span for storing 
forensics data has not been 
exceeded and that the 
forensics data is not taking 
up too much disk space. See 
“Setting the Store Check 
Interval” on page 92 for 
more information. 

2 minutes 

Primitive Stream Bit 
Rate and Video Stream 
Bit Rate 

The maximum estimated bit 
rates at which primitives and 
video data for a video feed 
are transferred from the 
sensor to the Forensics 
Store service and stored. 
These are per-sensor 
settings. Do not change 
these settings without 
consulting customer 
support. See “Setting the 
Time Span for the Storage of 
Forensics Data” on page 86 
for more information. 

122,880 bps for 
primitives  
 

563,200 bps for VEW 
Standard, VEW 
Leader/Follower, VEW 
FlowControl, and 
ObjectVideo OnBoard 
video 
 

2,252,800 bps for VEW 
HiRes video 
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Setting Description Default Value 

Target Time Span The total time period for 
which the Forensics Store 
service stores forensics data 
for a sensor. This is a per-
sensor setting. See “Setting 
the Time Span for the 
Storage of Forensics Data” 
on page 86 for more 
information. 

7 days 

Note: The type of video compressor used also affects the amount of forensics data 
stored. Compressor settings are configured using the ObjectVideo Management Tool, 
but they should not be changed without consulting customer support (see “Getting 
Support” on page 223). 

Setting the Min Disk Space Available In Bytes 

The Min Disk Space Available In Bytes setting in the ObjectVideo Management 
Tool’s Forensics Store Advanced Options dialog specifies the minimum amount of 
space that must remain available on the disk where forensics data is being stored. 
This setting only affects forensics storage on the computer running the Forensics 
Store service. 

When this limit is reached, the Forensics Store service begins deleting the oldest 
video and primitives files for each sensor in the system until the amount of available 
disk space is above the Min Disk Space Available In Bytes. A health monitor alert 
is also generated when this limit is reached. The alert is displayed on the Alert 
Console when it is generated and can be searched for using the Alert Console. 

The default setting is 50,000,000 bytes, which is equivalent to about 47.68 MB. If 
you plan to use more than 47.68 MB of disk space for non-forensics data on the 
computer running the Forensics Store service, you should increase this number. If 
you plan to use less than that amount for non-forensics data, decrease the number. 

The Forensics Store service checks for this limit and other forensics storage-related 
limits at the interval specified in the Store Check Interval. See “Setting the Store 
Check Interval” on page 92 for more information. 

To Set the Min Disk Space Available In Bytes 

1. Run the ObjectVideo Management Tool on the ISE computer, if it is not already 
running. 

2. On the Forensics Store tab, click the Advanced button. 

The Forensics Store Advanced Options dialog appears. 

3. Change the Min Disk Space Available In Bytes setting to the desired number 
of bytes. 
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4. Click OK. 

5. Click the Apply button on the ObjectVideo Management Tool window. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 

Setting the Store Check Interval 

The Store Check Interval on the ObjectVideo Management Tool’s Forensics Store 
Advanced Options dialog specifies how often the Forensics Store service checks to 
make sure that the time span for storing forensics data has not been exceeded and 
that the forensics data is not taking up too much disk space. 

At the specified interval, the Forensics Store service checks the following: 

• Whether the Target Time Span for each sensor’s forensics data has been 
met or exceeded. See “Setting the Time Span for the Storage of Forensics 
Data” on page 86 for more information. 

• Whether the Min Disk Space Available In Bytes setting has been reached. 
See “Setting the Min Disk Space Available In Bytes” on page 91 for more 
information. 

• Whether the storage space used for each sensor’s forensics data has met or 
exceeded the amount of data expected based on the Primitive Stream Bit 
Rate, Video Stream Bit Rate, and Target Time Span. 

If the Forensics Store service determines that the time period specified in the Target 
Time Span has been exceeded for a sensor, it deletes the oldest video and 
primitives files for that sensor until the forensics data is within the specified time 
span. 

If the Min Disk Space Available In Bytes setting has been reached, a health 
monitor alert is generated and displayed on the Alert Console, and the Forensics 
Store service deletes the oldest video and primitives files for the relevant sensors 
until adequate disk space is available. The health monitor alert is also stored in the 
database on the ObjectVideo Server for later searching using the Alert Console. 

The Forensics Store service also checks to make sure that the expected amount of 
data is being stored during the Target Time Span, based on the Primitive Stream 
Bit Rate and Video Stream Bit Rate. The expected amounts of data are described 
in “Target Time Spans and Disk Space Used for Forensics Data” on page 87. If more 
than the expected amount of data has been generated, the Forensics Store service 
deletes the oldest video and primitives files for the relevant sensors until the 
expected amount of forensics data remains. 
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To Set the Store Check Interval 

1. Run the ObjectVideo Management Tool on the ISE computer, if it is not already 
running. 

2. On the Forensics Store tab, click the Advanced button. 

The Forensics Store Advanced Options dialog appears. 

3. Change the Store Check Interval setting to the desired time between checks. 

The Store Check Interval is in hours, minutes, and seconds (HH:MM:SS). The 
default setting is one hour (01:00:00). 

4. Click OK. 

5. Click the Apply button on the ObjectVideo Management Tool window. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 

Setting the File Clipping Interval 

As the Forensics Store service receives forensics data (video and primitives) from the 
sensor, it stores the video and primitives as files. Video files and primitives files are 
created in separate directories for each sensor under the Store Base Directory, 
which is specified when you install the Forensics Store service and is configured on 
the ObjectVideo Management Tool’s Forensics Store tab. The files are clipped 
before they are stored, which means that the Forensics Store service allows the files 
to cover only a specific amount of time. 

The File Clipping Interval on the Forensics Store Advanced Options dialog is 
the maximum time in hours, minutes, and seconds (HH:MM:SS) before each video 
and primitives file being stored is clipped and a new video or primitives file is 
created. The default value is 10 minutes (00:10:00). 

There are advantages to having a relatively short File Clipping Interval (5 to 10 
minutes). A short File Clipping Interval enables you to create and run scenarios 
using FAST on more recent forensics data, because you cannot create or run a 
scenario on forensics files while they are being created by the Forensics Store 
service. For example, if you wanted to run a scenario in FAST for an event that took 
place 5 minutes ago, you may have to wait for the Forensics Store service to finish 
creating the forensics files for that period before you can create and run a scenario 
on those files using FAST. 

In addition, FAST can retrieve snapshots from stored video quicker while you are 
running a scenario if you set a short File Clipping Interval. 
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To Set the File Clipping Interval 

1. Run the ObjectVideo Management Tool on the ISE computer, if it is not already 
running. 

2. On the Forensics Store tab, click the Advanced button. 

The Forensics Store Advanced Options dialog appears. 

3. Change the File Clipping Interval setting as desired. 

4. Click OK. 

5. Click the Apply button on the ObjectVideo Management Tool window. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 
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Sharing the Forensics Data Directory for Access by 
FAST 

When you install the ISE software and the Forensics Store service, you specify the 
local directory where forensics data should be stored. You need to share this 
directory in Windows so that FAST can access the forensics data. 

To Share the Forensics Data Directory 

1. On the computer running the ISE software, run Windows Explorer.  

2. Browse to the directory you designated for forensics data storage during the 
installation process. 

The forensics data directory was specified during the ISE installation, which is 
described in “Installing the VEW ISE Software” on page 48 or “Installing the 
OnBoard ISE Software” on page 44. 

3. Right-click the directory, and then select Sharing and Security from the menu 
that appears. 

4. On the Sharing tab, select Share this folder. 

Important: Do not change the Share Name. The Share Name must be the 
same as the directory name specified during the ISE installation. 

5. Click the Permissions button. 
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The Permissions for dialog appears. In the Group or user names area, the 
Everyone icon appears, as shown in the following figure. In the Permissions 
for Everyone area at the bottom of the dialog, the Read permission is selected 
in the Allow column. These default Windows permissions are adequate for FAST 
to access the forensics data. 

 

6. Click OK, and then click OK on the directory’s Properties dialog. 

In Windows Explorer, the folder icon for the directory indicates that it is shared, 
as shown in the figure below. 
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Enabling Forensics Storage for ObjectVideo OnBoard 
Sensors 

By default, ObjectVideo OnBoard sensors that support the use of metadata are not 
enabled to store forensics data. Each sensor must be enabled to store forensics data 
in the ObjectVideo Management Tool. 

Note: By default, ObjectVideo VEW sensors store forensics data automatically. 

To Enable Forensics Storage 

1. On the computer running the ISE software, run the ObjectVideo Management 
Tool (Start > All Programs > ObjectVideo > ObjectVideo Management 
Tool). 

2. Start the Forensics Store service. 

See “To Start the Forensics Store Service” on page 128 for instructions. 

3. Turn on forensics storage for each individual sensor. 

See “To Enable Forensics Data Storage” on page 128 for instructions. 

4. See the next section for instructions on how to verify that the sensor is 
generating forensics data.
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Verifying that Forensics Data is Generated 

This step is only necessary on computers running sensors that support the creation 
of forensics data.  

To Verify Forensics Data Generation 

1. On the computer running the ISE software, open Windows Explorer. 

2. Browse to the forensics data directory. 

The table below indicates the number of subdirectories that should appear under the 
forensics data directory. 

Table 16: Forensic Subdirectories by ISE Type 

ISE Number of Forensic Subdirectories 

VEW Standard 4 

VEW Leader/Follower 4 

VEW HiRes 1 

VEW FlowControl 2 

ObjectVideo OnBoard (100MD, 200MD, 
1000MD) 

One subdirectory for each ObjectVideo 
OnBoard sensor you have created. 

Each subdirectory contains the forensics data that is being stored for one video feed 
that the sensor is monitoring. The subdirectories have names consisting of a random 
string of letters and numbers. These correspond to the sensor ID assigned by the 
system to the video feed being monitored. Each of these subdirectories should 
contain two additional subdirectories: one called primitive and another called video, 
each of which contains at least one file. These files are the primitives and video being 
stored for the video feed. 

If you do not see any subdirectories under the main storage directory, try waiting 
10–15 minutes and clicking the F5 key to refresh Windows Explorer. If no directories 
or files appear, there may be a problem. Refer to “Forensics Store Service 
Troubleshooting” on page 216 for possible solutions to the problem.
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Installing FAST 

FAST is the central software application in ObjectVideo Forensics. FAST enables you 
to define scenarios, which specify the events that FAST looks for within forensics 
data. When you run the scenario to detect events, FAST detects events and displays 
information about the events it has detected. 

The types of events FAST can detect depend on the type of ObjectVideo VEW or 
ObjectVideo OnBoard sensor that you used to gather the forensics data. See 
“ObjectVideo VEW” or “ObjectVideo OnBoard” on page 3 for more information on the 
types of events that can be detected by each product. 

Note: You must be logged in as a Windows user with Administrator privileges to 
install FAST. 

Before You Start 

• Make sure that the computer you are installing FAST on meets the “FAST 
Requirements” on page 21. 

• Make sure that the computer has all the prerequisite software installed. See 
“Client Application Software Requirements” on page 226 for more information. 

• The green FAST installation CD is required to complete the steps in this section. 

To Install FAST 

Insert the FAST installation CD in the computer’s CD drive. 

One of the following occurs: 

• An HTML page opens. Follow the instructions on the HTML page to install the 
software. 

• The HTML page does not open, and the installer does not run. If this occurs, 
use Windows Explorer to browse to the computer’s CD drive and double-click 
Installation_Instructions.htm. Follow the instructions on the HTML page. 

Important: 

• FAST is only part of the ObjectVideo Forensics system. If you do not install and 
configure the entire ObjectVideo Forensics system as described in “Initial 
Deployment Steps” on page 28 and the previous sections in this chapter, the 
system will not function properly. 

• If they are not already installed, install the MPEG-4 video compressor, Microsoft 
.NET Framework 1.1, Java Runtime Environment 1.4.2_03, Microsoft 
DirectX 9.0b, and Windows Media Player 9. See the appendix on page 224 for 
detailed instructions.  
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To Install the FAST Software 

1. Use Windows Explorer to browse to the installation CD. 

2. On the CD, double-click AutoSetup.js. 

The ObjectVideo Installation dialog appears.  

3. Click Yes. 

The Welcome to the ObjectVideo Forensics Analysis Scenario Tool 
Installation Wizard screen appears. 

4. Click Next. 

The License Agreement screen appears. 

5. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

6. Click Next. 

The Ready to Install the Software screen appears. 

7. Click Next. 

The Updating System screen appears, followed by the FAST Configuration 
screen. 

8. In the License Server field, type the host name or IP address of the computer 
on which the Sentinel LM license server is running. This should be the same as 
the host name or IP address of the ObjectVideo Server computer. 

9. Click OK.  

The FAST has been successfully installed screen appears. 

10. Click Finish. 

An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the computer. 

11. Click Yes to reboot the computer. 
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Important: 

• You must reboot the computer in order for FAST to operate. 

• Some ObjectVideo systems require vendor-specific files known as Partner 
Packages that determine the appearance and behavior of the system, such as the 
supported sensor, event, response, and object filter types. If the system you are 
deploying requires a Partner Package, copy the Partner Package files to 
C:\Program Files\ObjectVideo\FAST\config on the computer running the 
FAST software. 
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Creating Scenarios 

The installation and set-up process of ObjectVideo Forensics is complete. You are 
ready to start using ObjectVideo Forensics. 

The steps below provide a brief introduction on how to create scenarios. A scenario 
specifies the events that FAST looks for within stored forensics data. An event is 
security-related activity or other activity of interest that takes place within a 
camera’s field of view. FAST allows you to create many types of events and then see 
whether any of the events occurred, adjusting the time ranges, cameras, event 
types, etc., as often as necessary until FAST produces the desired results. 

See the FAST Help for detailed information about how to create scenarios. To access 
the FAST Help, select Help > Contents in the FAST window. 

You can create a scenario using the Scenario Wizard, or you can define an event in 
the FAST window's Scenarios area. This section describes both approaches. 

To Create a Scenario 

1. Do one of the following: 

• When you open FAST, the What would you like to do? dialog may appear. 
Click OK to create a new scenario. 

• Click the New Scenario button  in the FAST window. 

• Select File > New Scenario in the FAST window. 

• Press Ctrl + N on your keyboard when in the FAST window. 

If you are using the Scenario Wizard to create new scenarios, the Select 
Location screen of the wizard appears. 

If you are not using the Scenario Wizard, the new scenario appears in the 
Scenarios area on the left side of the FAST window. 

2. Edit the name in the Scenario Name field, if desired. 

3. For the Forensics Location, specify the path to the root directory where the 
forensics data is stored. 

The Forensics Location can be on a network or the local computer. See the 
FAST Help for information on the approaches that can be used to set the 
directory. 
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4. Do one of the following: 

• If you are using the Scenario Wizard, click Next on the Select Location 
screen. The Searching for data files dialog appears while FAST checks the 
location for the forensics data. If an error occurs, refer to the troubleshooting 
in the FAST Help. 

• If you are not using the Scenario Wizard, select the scenario icon , if it is 
not already selected. 

5. Click a sensor icon from the list of sensors. 

FAST will run the scenarios on the forensics data associated with the sensor icon 
you select. One or more snapshots of the views associated with the sensor 
appear in the Views area when you select a sensor icon. 

The sensor icon indicates the types of events you can create for a sensor. The 
sensor icon you select may represent any type of video feed, such as a fixed 
camera, a PTZ camera, or more than one video feed connected to an ISE via a 
multiplexer/switcher. 

6. In the Scenario Time Range area, select the time range for which you want to 
run the scenario. 

FAST looks for events within the time period you specify for the scenario. 

To select a time range, do one of the following: 

• Click and move the controls on the left and right sides of the green time 
range bar. 

• Adjust the dates and times in the time range inputs in the lower right and left 
corners of the Scenario Time Range area. 

7. If you selected a VEW Standard, VEW HiRes, VEW Leader/Follower, or 
ObjectVideo OnBoard sensor icon in step 5, click a view in the Views area. 
Otherwise, skip to the next step. (You do not have to select a view for VEW 
FlowControl sensors.) 

A blue box appears around the snapshot you select. The view you select in the 
Views area is the surveillance camera field of view FAST will analyze for events. 

8. Do one of the following: 

• If you are using the Scenario Wizard, click Next. 

• If you are not using the Scenario Wizard, click the Apply button in the lower-
right corner of the FAST window. 
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9. Do one of the following: 

• If you are using the Scenario Wizard, click the New button on the Create 
Events screen. 

• If you are not using the Scenario Wizard, click the Events icon  in the 
Scenarios area, and then click the New button in the lower-right corner of 
the FAST window. 

10. In the Event Wizard screen, type a name for the event in the Name field. 

11. Select the type of event you want to create. 

12. Complete the Event Specification area. 

See the FAST Help for more information about event types and the Event 
Specification area. 

13. Click Finish on the Event Wizard screen. 

14. If you want to create additional events for this scenario, return to step 9. 
Otherwise, proceed to step 15. 

Creating multiple events for a scenario enables you to check for several events at 
the same time when you run the scenario. 

15. Do one of the following: 

• If you are using the Scenario Wizard, click Finish. 

• If you are not using the Scenario Wizard, skip to step 18. 

16.  Do one of the following: 

• If the Run Scenario dialog appears, go to the next step. 

• If the Run Scenario dialog does not appear, skip to step 18. 

17. On the Run Scenario dialog, do one of the following: 

• Click Yes to run the scenario. Skip to step 19. 

When you run the scenario, FAST analyzes the forensics data for the events 
you have specified, detects events, and lists the events it has detected. 

• Click No if you do not want to run the scenario, and then skip to step 19. 

18. Run the scenario, if desired. 
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19. Save the scenario by clicking the Save Scenario button in the FAST window or 
selecting File > Save Scenario. 

You must save the scenario in order to access it after you close FAST. See the FAST 
Help for information on running and saving scenarios. 



 

Installing the ObjectVideo 
Integrator Toolkit Applications 
The ObjectVideo Integrator Toolkit is a group of software applications used by 
customer support personnel and integrators to plan for, maintain, and troubleshoot 
the system. 

The following applications are included in the ObjectVideo Integrator Toolkit: 

• Alert Backup Estimator – Used to estimate how often you should search for 
database size health monitor alerts. If a database size alert occurs, alerts are 
about to be purged from the ObjectVideo database and you should back up 
the alerts stored in the database. 

• Camera Placement Tool – Used to determine the ideal surveillance camera 
settings and location of cameras to optimize event detection. 

• Leader/Follower Calibration Tool – Used to calibrate the follower to the leader 
sensor's view. Determines how the follower will pan, tilt, and zoom to target 
an object. You only need to install the Leader/Follower Calibration Tool if you 
are using VEW Leader/Follower sensors. 

• Object Sizing Tool – Used to determine the size (in pixels) of objects within a 
camera’s field of view. It allows you to determine whether objects of a certain 
size will be reliably detected by a sensor. 

• Parameter Configuration Tool– Used during advanced troubleshooting tasks to 
improve event detection. The Parameter Configuration Tool allows you to 
access parameters that determine how events are detected by each sensor. 
The Tool is also used for some advanced configuration tasks. 

The ObjectVideo Integrator Toolkit applications can be installed on the same 
computer as the VEW/OnBoard client applications and FAST. 

Before You Start 

• Make sure that the computer you are installing the ObjectVideo Integrator Toolkit 
on meets the “ObjectVideo Integrator Toolkit Requirements” on page 21. 

• Make sure that the computer has all the prerequisite software installed. See 
“Client Application Software Requirements” on page 226 for more information. 

• The ObjectVideo Integrator Toolkit installation CD and an installation key are 
required to complete the steps in this section. 
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To Install the ObjectVideo Integrator Toolkit 
Applications 

1. Insert the ObjectVideo Integrator Toolkit installation CD in the computer’s CD 
drive. 

The ObjectVideo Installation dialog appears. 

2. Click Yes. 

One of the following occurs: 

• A dialog appears indicating that you do not have the Microsoft .NET 
Framework 1.1. Click OK. An HTML page opens. Follow the instructions on the 
HTML page to install the software. 

• The Welcome to the ObjectVideo Daemon Service Installation Wizard 
screen appears. Proceed to step 3. 

• The Welcome to the ObjectVideo Integrator Toolkit Installation 
Wizard screen appears, because the Daemon Service is already installed on 
the computer. This can occur if ObjectVideo software was previously installed 
on the computer. Skip to step 11. 

• The HTML page does not open, and the installer does not run. If this occurs, 
use Windows Explorer to browse to the computer’s CD drive and double-click 
Installation_Instructions.htm. Follow the instructions on the HTML page. 

3. Click Next. 

The License Agreement screen appears. 

4. If you agree to the terms of the license agreement, click the I accept the 
license agreement option. 

5. Click Next. 

The Ready to Install the Software screen appears. 

6. Click Next. 

The Updating System screen appears, followed by the ObjectVideo Daemon 
Service Configuration screen. 

7. Type the product installation key. 

8. Change the Server Address to the host name (e.g., OBVServer1) or IP address 
(e.g., 192.168.1.1) of the computer running the ObjectVideo Server software. 

If you use the computer’s host name, you must have a DNS server running on 
your network. You can also use a hosts file for name resolution (see “Adding a 
Host to a Hosts File” on page 140). If your network uses DHCP, you must use the 
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host name of the computer running the ObjectVideo Server software rather than 
the computer’s IP address, because the IP address may change when the 
computer is rebooted. 

Note: The Server Port (8076) is the default port on which the ObjectVideo 
Server software listens. It is unlikely that you will have to change this value. 

9. Click OK. 

The ObjectVideo Daemon Service has been successfully installed screen 
appears. 

10. Click Finish. 

The Welcome to the ObjectVideo Integrator Toolkit Installation Wizard 
screen appears. 

11. On the Welcome to the ObjectVideo Integrator Toolkit Installation Wizard 
screen, click Next. 

The Select Applications screen opens. 

12. If desired, select Parameter Configuration Tool, Camera Placement Tool, 
Object Sizing Tool, Alert Backup Estimator, and/or Leader/Follower 
Calibration Tool from the left side of the window. 

A drop-down menu appears. Also, the right side of the Select Applications 
screen indicates how much disk space the installation of that application will 
require. 

The Leader/Follower Calibration Tool is only required if you are using VEW 
Leader/Follower sensors. 

13. From the drop-down menu, select whether you want to install the software. 
By default, all of the software is installed. 

If you select Entire feature will be unavailable from the menu, the software 
will not be installed. Selecting either of the other options will result in the 
software being installed. If you click Reset, all of the software will be installed. 

14. Click Next. 

The Ready to Install the Software screen appears. 

15. Click Next. 

The Updating System screen appears while the ObjectVideo Integrator Toolkit 
applications are installed on the computer, and then the ObjectVideo 
Integrator Toolkit applications have been successfully installed screen 
appears. 

16. Click Finish. 
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An ObjectVideo Installation dialog appears, asking whether you want to reboot 
the ObjectVideo Integrator Toolkit computer. 

17. Click Yes to reboot the computer. 

Important: 

• You must reboot the computer in order for the ObjectVideo Integrator Toolkit 
applications to operate. 

• Some ObjectVideo systems require vendor-specific files known as Partner 
Packages that determine the appearance and behavior of the system, such as the 
supported sensor, event, response, and object filter types. If the system you are 
deploying requires a Partner Package, copy the Partner Package files to 
C:\Program Files\ObjectVideo\Integrator Toolkit\config on the computer 
running the ObjectVideo Integrator Toolkit. 

Note: The ObjectVideo Management Tool is automatically installed when the 
Daemon Service is installed. The ObjectVideo Management Tool is used to start and 
stop ObjectVideo services and change various configuration settings in the system. 



 

Maintaining the System 
This chapter describes how to maintain ObjectVideo VEW, ObjectVideo OnBoard, and 
ObjectVideo Forensics and provides information about other maintenance tasks for 
the ObjectVideo system. It is critical that you review the information in this chapter 
to ensure the continued operation of the system.  

This guide does not cover the maintenance of the hardware and operating systems 
on which the ObjectVideo software runs. For information about this type of 
maintenance, consult the appropriate vendor documentation and apply industry best 
practices. 
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Maintaining the ObjectVideo VEW and ObjectVideo 
OnBoard Systems 

This section describes the following ObjectVideo VEW and ObjectVideo OnBoard 
maintenance tasks: 

• Preparing to purge the ObjectVideo database 

• Deleting images files from the computer running the ObjectVideo Server 
software 

Important: If you are also using ObjectVideo Forensics, follow the maintenance 
instructions in “Maintaining the ObjectVideo Forensics System” on page 121 in 
addition to the instructions in this section. 

Preparing to Purge the ObjectVideo Database 

Important: 

• You must read and follow the instructions in this section if you are using 
ObjectVideo VEW or ObjectVideo OnBoard. Failing to do so means you may 
have no record of the alerts automatically purged from the ObjectVideo database. 

• You will need the Alert Backup Estimator to complete the steps in this section. 
The Alert Backup Estimator is an ObjectVideo Integrator Toolkit application. See 
“Installing the ObjectVideo Integrator Toolkit Applications” on page 106 for 
information on how to install the Alert Backup Estimator. 

• You will need the installation key for the ObjectVideo Server to complete the 
steps in this section. The installation key is found in the ObjectVideo Management 
Tool. Open the ObjectVideo Management Tool on the computer running the 
ObjectVideo Server software. In the Connection tab, the key is located in the 
Installation Key field. 

The ObjectVideo database runs on the same computer that runs the ObjectVideo 
Server software. Its primary purpose is to store alerts for real-time events detected 
by ObjectVideo VEW and ObjectVideo OnBoard, but it also stores other system data 
such as sensor groups, sensor information, and ObjectVideo VEW views. Alerts often 
contain one or more snapshots (digital pictures) of an incident from a surveillance 
camera, so they can take up a significant amount of space in the ObjectVideo 
database. 

Alert records vary in size based on the type of sensor that detected the event, the 
resolution of the alert, and the number of snapshots that were in the alert. Alerts 
contain one or two snapshots based on the type of event. See the Alert Console Help 
for more information about the number of snapshots included in alerts.  
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See the table below for information on the average alert size. 

Table 17: Average Alert Size by Sensor Type, Number of Alert Snapshots, 
and Resolution 

Type of Sensor Snapshot 
Resolution 

Number of Alert 

Snapshots 

Total Alert Size 
(KB) 

1 45 VEW Standard, 
VEW FlowControl, 

or  VEW 
Leader/Follower 

320 x 240 

2 92 

1 70 640 x 480 

2 120 

1 78 

VEW HiRes 

720 x 480 

2 128 

1 Varies 
(determined by 

resolution) 

OnBoard 100, 
OnBoard 200, or 
OnBoard 1000 

Varies (default is 
320 X 240) 

2 Varies 
(determined by 

resolution) 

Since alert records take up a significant amount of space in the ObjectVideo 
database, alerts are purged from the ObjectVideo database automatically. 

In a typical installation, the ObjectVideo database is an MSDE database. If you are 
not using an MSDE database, contact customer support for more information about 
maintaining the ObjectVideo database. The total database size that MSDE can 
support is 2 GB (2,000 MB). This means that the total amount of data in all tables in 
the database cannot exceed 2 GB. When the amount of data in the database reaches 
2 GB, the database stops storing new alerts.  

When the ObjectVideo Server is installed, you select at what size the ObjectVideo 
database should be automatically purged. This option is explained in “Installing the 
ObjectVideo Server Software” on page 36. It is recommended that you use the 
default value of 1.6 GB (1,600 MB). The value must be less than 2 GB (2,000 MB). If 
you select a value less than 1.5 GB (1,500 MB), the database size health monitor 
alert that indicates that the ObjectVideo database is about to be purged will never be 
generated.  

The database size alert notifies you that the ObjectVideo database is about to be 
purged so that you can export alerts to one or more HTML files using the Alert 
Console. Unless you export the alerts, you will not have access to them in the future. 
See “Determining When to Export Alerts” on page 113 for more information. Purging 
the database does not affect any of the system information (views, sensor groups, 
etc.) stored in the database.  
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When the ObjectVideo Server is installed, you also enter the number of days of alerts 
you want to try to save after the purge in the Try Not to Purge <number of days> 
Days of Recent Alerts field. This option is explained in “Installing the ObjectVideo 
Server Software” on page 36. When the ObjectVideo database is purged, not all 
alerts are necessarily deleted from the database. When the database reaches the 
size indicated in the Purge Database at This Size field, the alerts that occurred 
previous to the number of days entered in the Try Not to Purge <number of days> 
Days of Recent Alerts field are deleted. 

If the database size is still larger than the size in the Purge Database at This Size 
field, another day of alerts are cleared. The alerts are cleared in day increments until 
the database size is smaller than the size indicated in the Purge Database at This 
Size field. The most recent alerts are preserved. For instance, if you used the default 
value of 7, every alert that occurred before the previous week would be cleared. If 
the database was still too large, a day at a time would continue to be cleared 
(starting from the day farthest from the present) until the database was the specified 
size. 

Determining When to Export Alerts 

When the system detects that the database has reached 1.5 GB, a dialog opens and 
a health monitor alert appears in the Alert Console indicating that the database is 
almost full. The database size alert appears so that you have time to export 
important alerts to HTML files using the Alert Console. Unless you export the alerts, 
you will not have access to them in the future. Inform all Alert Console users that 
they must notify a system administrator when this alert appears. You can also search 
for past occurrences of this alert, as described in “Searching for Database Size 
Alerts” on page 115. 

To determine when to export alerts using the Alert Console, do the following, as 
described in this section: 

• Set up a schedule for searching for database size health monitor alerts. 

• Use the Alert Console to periodically search for the database size health 
monitor alert that warns that the database has reached 1.5 GB. 

Setting a Schedule to Search for Database Size Alerts 

You can estimate how often you will need to search for database size health monitor 
alerts using the ObjectVideo Integrator Toolkit’s Alert Backup Estimator. Once you 
have estimated how often the alerts should be searched, you can set a schedule for 
searching in the Alert Console and search for the database size alerts regularly based 
on that schedule. 

To Set a Schedule for Searching for Database Size Alerts 

1. Determine the average number of alerts that are occurring per day in the 
ObjectVideo system, and make note of this number. 
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You can do this by using the Alert Console’s Search Alerts tab to perform a 
search on ALL the sensors during a 7-day period. The Alert Console Help 
describes how to perform searches in detail. 

For example, run a search for all alerts that have occurred from 12:00 a.m., 
March 1, to 12:00 a.m., March 8. The Alert Console displays a list of all alerts 
that have occurred during that period. The bottom-center of the Alert Console 
displays the number of alerts that were retrieved during the search. For example, 
it might say Retrieved 280 alerts. 

Divide the number of alerts retrieved by the number of days. For example, if a 
total of 280 alerts were triggered during a 7-day period, the average number of 
alerts per day would be 40. 

2. Take the number of alerts from step 1 and divide that number by the number of 
sensors in your system, and make note of this number. 

This gives you the average number of alerts generated per sensor per day. For 
example, if you determined that 40 alerts are generated per day in the 
ObjectVideo system, and you have 2 sensors in the ObjectVideo system, an 
average of about 20 alerts are being generated per sensor per day. 

3. Using the Alert Backup Estimator, enter how many of each type of sensor is 
detecting events in the Number of Sensors area. 

For instance, if you had a total of three sensors (two VEW Standard sensors and 
one VEW HiRes sensor with a resolution of 720 x 480), you would enter 2 in the 
VEW Standard field, 1 in the VEW HiRes (720 x 480) field, and 0 in all the 
remaining sensor fields. 

Since all ObjectVideo OnBoard alerts are the same size, the total number of 
ObjectVideo OnBoard sensors is entered in a single field. The default processing 
resolution for ObjectVideo OnBoard sensors is 320 x 240. If an ObjectVideo 
OnBoard sensor is using a different resolution or the sensor you are using does 
not appear in the Number of Sensors area, see the Alert Backup Estimator Help 
for information on how to customize the options available in the Estimator. Select 
Help > Contents to access the Help in the Alert Backup Estimator. 

4. Enter the number of alerts you determined in step 2 in the Average No. of 
Alerts (per Sensor per Day) field. 
 

5. Click Calculate. 

The No. of Days before Alert Search is Needed field displays how often you 
should search for database size alerts using the Alert Console. 

6. Based on the number of days determined in step 5, create a schedule for 
searching for database size alerts, and keep to the schedule to ensure that you 
have time to export important alerts before the database is purged automatically. 
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7. Reevaluate the schedule regularly, in case the average number of alerts changes 
over time. 

Important: 

• The Alert Backup Estimator only provides an approximation of when you should 
search for the database size alert. You can check the size of the ObjectVideo 
database to determine its exact size. See “Checking the Size of the Database” on 
page 118 for more information. 

• If the ObjectVideo database is set to be purged at less than 1,500 MB (1.5 GB), 
the database size alert will never be generated. The size at which the database is 
purged is configured when you install the ObjectVideo Server software. See 
“Installing the ObjectVideo Server Software” on page 36 for more information. 

• If your system includes VEW Standard, VEW HiRes, or VEW Leader/Follower 
sensors, the views you create using the Rule Management Tool are stored in the 
database and can occupy a significant amount of space. Each view you create for 
a VEW Standard sensor and VEW Leader/Follower sensor occupies around 1 MB 
of space in the database. Each view you create for a VEW HiRes sensor occupies 
around 4 MB of space in the database. If you have a large number of views, you 
may need to search for database size alerts more frequently. It is possible for the 
database to be entirely filled up with just views and sensor groups, especially if 
you have created many VEW HiRes views. 

Searching for Database Size Alerts 

If you want to find out whether the ObjectVideo database has reached 1.5 GB, you 
can use the Alert Console to search for database size health monitor alerts. These 
alerts are triggered when the system detects that the database has reached or 
exceeded 1.5 GB. An alert is triggered every 6 hours after the initial database size 
alert is triggered, until the database is purged. 

The alert contains the following text: Attention! The database is almost full and 
is about to be purged automatically. Contact customer support or your 
system administrator. A System Warning snapshot accompanies the alert. 
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Search for the database size alert from the Alert Console’s Search Alerts tab. Select 
the desired date and time ranges, select Database from the Sensors list, and then 
click Find Now. The Database option only appears in the Sensors list if at least 
one database size alert has been triggered. Detailed instructions are provided in the 
Alert Console Help. 

Exporting Alerts to an HTML File 

Before the ObjectVideo database is purged, it is highly recommended that you use 
the Alert Console to generate HTML-based reports for important alerts stored in the 
database. Once the database is purged, these reports are the only record you will 
have of past alerts. 

The Alert Console can export all of the alerts displayed on the Console to an HTML 
file, which can be viewed using a web browser (such as Microsoft Internet Explorer) 
or a word processor (such as Microsoft Word) and printed. 

Reports are generated from the Current Alerts tab or Search Alerts tab. Only 
those alerts displayed in the tab the report is generated from will be included in the 
report. For instance, if you generate a report from the Search Alerts tab, only those 
alerts that are displayed in the Search Alerts tab will be included in the report. 
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To Generate a Report 

1. Do one of the following: 

• If you want to generate a report containing only the most recent alerts 
displayed on the Alert Console, select the Current Alerts tab. 

• If you want to generate a report of past alerts, select the Search Alerts tab, 
and then perform a search. You can search for events that occurred during a 
specific date and time range and on specific sensors. Be aware that the 
Search Alerts tab can only display 1,000 alerts at a time, so you may need 
to perform multiple searches and generate multiple reports. See the Alert 
Console Help for more information about performing searches. 

2. Since the Alert Console exports all of the currently visible alerts to the report file, 
you may want to clear any alerts from the Console that you do not want to 
appear in the report. To clear an alert, right-click the alert and select Clear Alert 
from the menu that appears. Be aware, however, that this action cannot be 
undone. (Clearing an alert is not equivalent to deleting it from the database.) 

3. In the Alert Console window, select Actions > Export Alerts. You can also press 
Ctrl + E on your keyboard. 

The Save As dialog appears. 

4. Browse to the location where you want to save the alerts, rename the file if 
desired, and then click Save. 

When you save the file, the Alert Console will automatically create a directory 
where all of the snapshots for the report are stored as JPEG files. 

Notes: 

• If markup is displayed on snapshots in the Alert Console at the time the report is 
generated, the snapshots in the report will display markup. 

• See the Alert Console Help for information on opening and printing alert reports. 

Verifying a Purge Has Occurred 

To ensure that the purge has occurred, you can confirm that the archive file resulting 
from the purge has been created and the size of the database is less than the limit 
you set during the installation of the ObjectVideo Server software. 

Verifying that the Archive File Exists 

When the purge occurs, an archive file is created at C:\Program 
Files\ObjectVideo\Server\Data on the computer where the ObjectVideo Server 
software is installed. All archive files begin with OBVArchive, followed by the year, 
month, date, and time of the last alerts that were deleted during the purge. 
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Archive files use the following format: 

OBVArchiveYYYYMMDDHHMMSS.bak 

This is an example of an archive file name: 

OBVArchive20040405115300.bak  

In this example, alerts from no later than April 5, 2004 at 11:53 am would appear in 
the database. If an archive file does not appear when you suspect the database 
should have been purged, you can check the size of the ObjectVideo database using 
the instructions in the next section. 

Note: Archive files can be large, so you may want to move them to an alternate 
location after they are generated. If the database purges frequently, you may need 
to regularly move these files. 

Checking the Size of the Database 

You can check the size of the ObjectVideo database to verify that the purge has 
occurred. The checkObjectStore.bat script enables you to check the database’s 
size. If the size of the database is larger than the maximum size you selected when 
the ObjectVideo Server software was installed, automatic purging has not worked 
correctly. If this is the case, see “Maintenance Troubleshooting” on page 217. 

You can check the database size anytime. This may be useful if you have not yet 
received a database size alert, but you suspect that your database is nearing the 
maximum size. Before the database is purged, you should export alerts using the 
instructions in “Exporting Alerts to an HTML File” on page 116. 

The commands described in this section need to be run from the command prompt 
on the computer running the ObjectVideo Server software. To access the command 
prompt in Windows, click Start > Run, type cmd in the Open field, and then click 
OK. 

To Check the Size of the Database 

1. From a command prompt on the computer running the ObjectVideo Server 
software, change directories to the ObjectVideo Server installation directory. 

To change directories, type the following in the command prompt window, and 
then press the Enter key: 

cd C:\Program Files\ObjectVideo\Server 

The command prompt displays the following: 

C:\Program Files\ObjectVideo\Server> 

2. Check the current size of the database by typing the following, and then pressing 
Enter: 

checkObjectStore.bat hostname installationkey 
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The hostname is the host name of the computer running the ObjectVideo Server 
software, and the installationkey is the installation key used when installing 
the ObjectVideo Server software on that computer. Omit any hyphens in the 
installation key. 

For example, if the computer’s host name is server1 and the installation key is 
12345, you would type the following in the command prompt: 

checkObjectStore.bat server1 12345 

Text that resembles the following appears on the command prompt: 

 

On the right side of the command prompt, make note of the value under the 
database_size column. The database_size indicates the size of the current 
ObjectVideo database. If the database size displayed is at or above 1,500 MB 
(1.5 GB), you need to purge the database. In the example shown in the previous 
figure, the size of the database is 985.38 MB. 

Important: If the database_size ever indicates that the ObjectVideo database 
is 2,000 MB (2 GB) or larger, contact customer support immediately (see 
“Getting Support” on page 223). Alerts are not being saved into the database. 

Note: Running checkObjectStore.bat with no arguments displays help text for 
the script. 

Current 
database size 
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Deleting Image Files from the Computer Running the 
ObjectVideo Server Software 

If you have set up e-mail-based alerts, any snapshots associated with those alerts 
are stored as .jpg files in C:\Windows\Temp on the computer running the 
ObjectVideo Server software. The file names begin with VideoFrame. It is 
recommended that you periodically delete these files from the computer. 
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Maintaining the ObjectVideo Forensics System 

This section describes the following ObjectVideo Forensics maintenance tasks: 

• Backing up forensics data 

• Checking for forensics storage health monitor alerts 

• Stopping and starting forensics storage 

It also describes how ObjectVideo Forensics data affects the ObjectVideo database. 

Note: If you are using ObjectVideo VEW or ObjectVideo OnBoard for real-time event 
monitoring and notification, you should also follow the maintenance instructions in 
the previous section, “Maintaining the ObjectVideo VEW and ObjectVideo OnBoard 
Systems,” starting on page 111. 
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Backing Up Forensics Data 

The Forensics Store service deletes forensics data when certain limitations on 
storage are met, as described in “Customizing Settings that Affect the Disk Space 
Used for Forensics Data” on page 89. A command line utility called the Forensics 
Media Extractor enables you to regularly back up forensics data before it is deleted. 
FAST can be used to run scenarios on the backed up data later on. 

You can use the Forensics Media Extractor to back up data on a remote computer or 
the local computer. Forensics data can be backed up for all sensors or individual 
sensors. 

The Forensics Media Extractor is provided on the following CDs in the 
ForensicsMediaExtractor directory: 

• All ISE installation CDs 

• VEW/OnBoard client applications installation CD 

• FAST installation CD 

• ObjectVideo Integrator Toolkit installation CD 

The Forensics Media Extractor is also installed on any computer on which the 
Daemon Service is installed, which includes the following: 

• The ObjectVideo Server computer 

• All ISE computers 

• All computers running VEW/OnBoard client applications 

• All computers on which the ObjectVideo Integrator Toolkit is installed 

The Forensics Media Extractor is installed in the following directory on these 
computers: 

C:\Program Files\ObjectVideo\Forensics Media Extractor 

The tool is also installed with FAST, in the following directory: 

C:\Program Files\ObjectVideo\FAST\Forensics Media Extractor 

The commands described in this section need to be run from a command prompt. To 
access the command prompt in Windows, click Start > Run, type cmd in the Open 
field, and then click OK. 

Note: If you want to use the Forensics Media Extractor from another computer, you 
can run it from an installation CD or copy the entire ForensicsMediaExtractor 
directory from the CD to the computer. However, the computer must have the 
Microsoft .NET Framework 1.1 installed in order to run the Forensics Media Extractor. 
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The Microsoft .NET Framework 1.1 is provided on the FAST installation CD and the 
VEW/OnBoard client applications installation CD under DotNET\dotnetfx.exe. 

To Back Up Forensics Data 

1. From a command prompt on a computer with the Forensics Media Extractor, 
change directories to the location of the Forensics Media Extractor files. 

For example, if the Forensics Media Extractor is on the ISE computer, to change 
directories, type the following in the command prompt window, and then press 
the Enter key: 

cd C:\Program Files\ObjectVideo\Forensics Media Extractor 

In this case, the command prompt would the display the following: 

C:\Program Files\ObjectVideo\Forensics Media Extractor> 

2. Type the following in the command prompt, and then press Enter: 

forensicsmediaextractor.exe backup sourcedirectory targetdirectory 
starttime endtime 

The sourcedirectory is the directory or network path for the location of the 
forensics data you want to back up (for example, F:\Store or \\ISE1\Store). 

Make sure that you type the path to either the root forensics data directory or an 
individual sensor’s forensics data directory, but not the primitive or video 
subdirectories. Individual sensors’ directories are usually long strings of letters 
and numbers. An example of the path to such a directory is 
\\ISE1\Store\2dd91d2a-39f4-4713-b1fd-549ea4bc9762. 

If you type the path to the root forensics directory, all of the forensics data below 
it for the time range you specified will be backed up. If you type the path to an 
individual sensor’s forensics data directory, only that sensor’s forensics data will 
be backed up for the time range you specified. 

The Forensics Media Extractor only backs up the data in the Store Base 
Directory specified in the ObjectVideo Management Tool. 

The targetdirectory is the directory or network path for the location to which 
you want to back up the data. In order to back up data to the directory using the 
Forensics Media Extractor, you must have Full Control permissions for the 
directory in Windows. 

The starttime and endtime are optional. They are the beginning and end 
times, respectively, of the segment of forensics data you want to back up. Both 
should be in the following format: 

YYYYMMDD.HHMMSS.FFF 

The time you enter should be based on a 24-hour clock (e.g., 204000 would be 
8:40 p.m.). FFF represents milliseconds and should almost always be set to 000. 
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For example, if you wanted to back up data from May 1, 2006 at 1 p.m. to 
May 7, 2006 at 1 p.m., you would type the following: 

20060501.130000.000 20060507.130000.000 

An example of a complete backup operation is as follows: 

forensicsmediaextractor.exe backup C:\Store \\backup1\backupdir 
20060501.130000.000 20060507.130000.000 
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Checking for Forensics Storage Health Monitor Alerts 

An important aspect of maintaining ObjectVideo Forensics is to regularly check for 
and respond to health monitor alerts that relate to forensics data storage. Health 
monitor alerts are generated by the system to indicate how the system is operating. 
If the Min Disk Space Available In Bytes setting in the ObjectVideo Management 
Tool is reached, a health monitor alert is generated, displayed on the Alert Console if 
the Console is open, and stored in the alert database. 

The Min Disk Space Available In Bytes setting specifies the minimum amount of 
space that must remain available on the disk where forensics data is being stored. It 
is set to 47.68 MB by default. When this threshold is reached, forensics data is lost, 
because the Forensics Store service starts deleting the oldest primitives and video 
files until the available drive space is above the threshold.  

If a forensics storage health monitor alert appears, you can reduce the Min Disk 
Space Available In Bytes so that the forensics data can occupy more space on the 
computer. You can also decrease the Target Time Span for some or all sensors. 
The Target Time Span is the duration for which forensics data is stored for a 
sensor. It is possible that you have set a Target Time Span that is too long and 
forensics data is taking up too much space on disk, possibly to the point that the 
Forensics Store service is not storing data for the time period specified. See 
“Customizing Forensics Storage Settings” on page 86 for more information about 
changing these settings. 

The alert contains the following text: Attention! The forensics system is running 
out of disk space. A System Warning snapshot with an exclamation point 
accompanies the alert. 

 

When the alert is generated, it is displayed on the Alert Console. If you are using 
ObjectVideo VEW or ObjectVideo OnBoard for real-time event detection, the Alert 
Console user will see it when it appears and should contact customer support or a 
system administrator. 

If you are only using ObjectVideo Forensics, however, and are not using ObjectVideo 
VEW or ObjectVideo OnBoard for real-time event detection, users will probably not 
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be running the Alert Console frequently. For this reason, it is important to regularly 
check for the health monitor alerts using the Alert Console. The next section 
describes how to search for forensics storage health monitor alerts. 

To Search for Forensics Storage Health Monitor Alerts Using the 
Alert Console 

1. Run the Alert Console. 

2. Click the Search Alerts tab. 

3. Select the desired date and time ranges. 

4. From the Sensors list, select the name of the ISE that generated the health 
monitor alert, and then click Find Now. 

The name of the ISE only appears in the Sensors list if at least one forensics 
storage health monitor alert has been triggered. 
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Stopping and Starting Forensics Storage 

This section describes how to stop and start the generation of forensics data. 
Stopping and starting forensics data are tasks that may need to be performed during 
the routine operation of ObjectVideo Forensics. You must be logged in as a Windows 
user with Administrator or Power User privileges to complete the steps in this 
section. 

Stopping Forensics Data Storage 

You can take the following approaches to stopping forensics data storage using the 
ObjectVideo Management Tool: 

• You can stop storing forensics data for an individual video feed being 
monitored by a sensor. 

• You can stop the Forensics Store service on the ISE computer. If you take this 
approach, no forensics data is stored for any video feeds being monitored by 
sensors. 

To Disable Forensics Data Storage 

1. Open the ObjectVideo Management Tool on the computer running the ISE 
software, if it is not already running. 

2. Click the ISE tab. 

3. On the sensor tab at the bottom of ISE tab, deselect Store Forensics Data. 

4. Click the Apply button. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 

To Stop the Forensics Store Service 

1. Open the ObjectVideo Management Tool on the computer running the ISE 
software, if it is not already running. 

2. Click the Stop button next to ObjectVideo Forensic Store Service. 

You will know that the service has stopped when the field next to the service says 
Stopped. 

Note: The Forensics Store service will start again automatically if you reboot the ISE 
computer. 
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Starting Forensics Data Storage 

Forensics data is stored when the Forensics Store service is running and a sensor has 
been enabled to store the data. 

Important: Regardless of the settings in the ObjectVideo Management Tool, 
ObjectVideo OnBoard sensors will only generate forensics data if they support 
metadata. 

To Enable Forensics Data Storage 

1. Open the ObjectVideo Management Tool on the computer running the ISE 
software. 

2. Click the ISE tab. 

3. On the sensor tab at the bottom of ISE tab, select Store Forensics Data. 

4. Click the Apply button. 

When you click Apply, the ObjectVideo Management Tool automatically stops 
and restarts the ObjectVideo services running on the computer. This may take a 
few minutes. You will know that the services are restarted when the field next to 
each service in the ObjectVideo Management Tool says Running. Only services 
that were running when you clicked Apply will be restarted. 

To Start the Forensics Store Service 

1. Open the ObjectVideo Management Tool on the computer running the ISE 
software. 

2. Click the Start button next to ObjectVideo Forensic Store Service. 

You will know that the service has started when the field next to the service says 
Running. 

Note: In order for the Forensics Service to store data, the ISE service must also be 
running, and the Store Forensics Data option for each sensor on the ISE tab must 
be selected. 
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ObjectVideo Forensics and the ObjectVideo Database 

This section describes how ObjectVideo Forensics affects the ObjectVideo database. 
In a typical installation, the ObjectVideo database is an MSDE database. MSDE has a 
2 GB storage space limitation, but it should be automatically purged before the 
database reaches this size. If you are not using MSDE, contact customer support for 
more information (see “Getting Support” on page 223). 

ObjectVideo Forensics, ObjectVideo VEW, and ObjectVideo OnBoard use the 
ObjectVideo database, but ObjectVideo Forensics uses far less space in the database, 
because forensics-related event occurrences detected by FAST are not stored in the 
database. If you are using ObjectVideo VEW or ObjectVideo OnBoard for real-time 
event detection and notification, it is critical that you follow the instructions in 
“Preparing to Purge the ObjectVideo Database” on page 111 to save important alerts 
to HTML files before a purge occurs. 

If you are using ObjectVideo Forensics exclusively, you should never need to purge 
the ObjectVideo database, because in ObjectVideo Forensics, only views, groups, and 
health monitor alert data are stored in the database. Purging the database deletes 
health monitor alerts, but it does not delete groups and views. However, health 
monitor alerts take up a very small amount of space in the database, and it would 
take a large number of views to fill the database. 

Each health monitor alert occupies only about 4 KB in the ObjectVideo database. This 
means that it would take 393,225 health monitor alerts to fill the entire ObjectVideo 
database. 

You must create at least one view for each VEW Standard, VEW HiRes, and VEW 
Leader/Follower sensor that is going to detect events. Each view created for a VEW 
Standard or VEW Leader/Follower sensor occupies around 1 MB of space in the 
database. Each view created for a VEW HiRes sensor occupies around 4 MB of space 
in the database. This means that it would take around 384 VEW HiRes views or 
1,536 VEW Standard or VEW Leader/Follower views to fill the ObjectVideo database. 
ObjectVideo OnBoard views are not stored in the ObjectVideo database. 

Note: VEW FlowControl does not support views. 

If you are not using ObjectVideo VEW for real-time event detection but you receive a 
database size health alert containing the following text, contact customer support: 
Attention! The database is almost full and is about to be purged 
automatically. Contact customer support or your system administrator. A 
System Warning snapshot accompanies the alert. 
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Checking Out an Authorization for Opening FAST 
Offline 

Normally, FAST requires a connection to the network and the Sentinel LM license 
server (which runs on the ObjectVideo Server computer) in order to run. However, 
some users may wish to use FAST offline, because they are away from the office or 
unable to connect to the network for some other reason. This can be accomplished 
using a software application called WCommute. 

WCommute enables a user to check out an authorization to use a commuter license 
for FAST for a limited period of time (up to 30 days), and then to check in the 
authorization when it is no longer needed. While an authorization is checked out, the 
number of available uses of FAST decreases for other users, so you should 
encourage users to check out authorizations for the minimum number of days 
necessary and to check in the authorization promptly after reconnecting to the 
network. 

You will be unable to open FAST if an authorization you have checked out expires 
while you are offline. When an authorization expires, it immediately becomes 
available for other users connected to the license server. 

To Check Out an Authorization 

1. While the computer on which FAST is installed has a connection to the network 
on which the license server is running, from the Windows Start menu, select All 
Programs > ObjectVideo > Forensics > FAST > Manage Commuter 
License. 

WCommute opens. 

2. Do one of the following: 

• Click the Search Subnet button to have WCommute automatically search for 
a license server on the current subnet. The host name of the computer 
running the license server appears. Under the host name, one or more 
available authorizations for FAST commuter licenses are listed. Select an 
authorization. 

• Click Single Server to find a specific license server by host name or IP 
address. This option enables you to find a license server on another subnet. 
Type the host name or IP address in the field provided, and then click OK. 
WCommute searches for the license server and displays the server and the 
available authorizations on the main window. Select an authorization. 

3. Specify the duration for which you want to check out the authorization in the 
Please enter the number of days until the authorization expires field. 

The maximum duration is 30 days. Specify the minimum number of days 
necessary, because while an authorization is checked out, fewer uses of FAST are 
available to other users. 
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4. Click Check Out. 

A red checkmark appears to the left of the authorization you have checked out. 
You can now use FAST while you are offline. When you reconnect to the network, 
make sure that you check in the authorization to make it available to other users, 
as described in the next section. 

To Check In an Authorization 

1. While the computer FAST is installed on has a connection to the network on 
which the license server is running, from the Windows Start menu, select All 
Programs > ObjectVideo > Forensics > FAST > Manage Commuter 
License. 

WCommute opens. 

2. Do one of the following: 

• Click the Search Subnet button to have WCommute automatically search for 
a license server on the current subnet. The host name of the computer 
running the license server appears. Under the host name, one or more 
available authorizations for FAST commuter licenses are listed. 

• Click Single Server to find a specific license server by host name or IP 
address. This option enables you to find a license server on another subnet. 
Type the host name or IP address in the field provided, and then click OK. 
WCommute searches for the license server and displays the server and the 
available authorizations on the main window. 

3. If an authorization has a red check mark next to it, you have checked it out. 
Select the authorization, and then click Check In. 

The check mark next to the authorization disappears. 
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Other Maintenance Tasks 

This section describes the following tasks that may be performed during the 
operation of ObjectVideo VEW, ObjectVideo OnBoard, ObjectVideo Forensics, and the 
ObjectVideo Integrator Toolkit: 

• Changing the ObjectVideo Server settings 

• Working with the ObjectVideo services 

• Working with licenses 

• Adding a host to a hosts file 

• Deleting and replacing corrupt parameter files 

You must be logged in as a Windows user with Administrator or Power User 
privileges to complete the steps in this section. 
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Changing the ObjectVideo Server Settings 

If desired, you can change the ObjectVideo Server that a computer on the system is 
communicating with. This is not a normal part of the installation process, but it is 
necessary if you want to use an ObjectVideo Server other than the server you 
entered during the installation of the Daemon Service. 

To change the ObjectVideo Server, open the ObjectVideo Management Tool. With the 
exception of the computer where FAST is installed, the ObjectVideo Management 
Tool is installed on every computer where ObjectVideo software is installed. It is 
automatically installed at the same time that the Daemon Service is installed. The 
Connection tab of the ObjectVideo Management Tool displays the server address 
and port number of the ObjectVideo Server. 

You can change the Server Address and Port to the host name (e.g., OBVServer1) 
or IP address (e.g., 192.168.1.1) of the computer running the ObjectVideo Server 
software. By default, the ObjectVideo Server listens on port 8076. You should not 
need to change the default port number. 

Click Apply to save the settings. 

When you click Apply, the ObjectVideo Management Tool automatically stops and 
restarts the ObjectVideo services running on that computer. See “Working with the 
ObjectVideo Services” on page 134 for more information about ObjectVideo services. 
You will know that the services are restarted when the field next to each service in 
the ObjectVideo Management Tool says Running. Only services that were running 
when you clicked Apply will be restarted. If you have the Rule Management Tool or 
System Configuration Tool open, you must click the Refresh Configuration button 
in these applications to display the new configuration. 

Note: 

• Changes made to the ObjectVideo Management Tool only affect the ObjectVideo 
software running on that computer. Unlike the Rule Management Tool and the 
System Configuration Tool, the ObjectVideo Management Tool is not a distributed 
application. In other words, you cannot run the ObjectVideo Management Tool on 
one computer to change settings or manage Windows services on another 
computer. You must run the ObjectVideo Management Tool on the local computer 
to make configuration changes and manage services for the ObjectVideo software 
on the local computer. 

• If you use the computer’s host name, you must have a DNS server running on 
your network. You can also use a hosts file for name resolution (see “Adding a 
Host to a Hosts File” on page 140). If your network uses DHCP, you must use the 
host name of the computer running the ObjectVideo Server software rather than 
the computer’s IP address, because the IP address may change when the 
computer is rebooted. 
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Working with the ObjectVideo Services 

Several ObjectVideo components are deployed as Windows services. These services 
start automatically when the computers running the ObjectVideo components boot 
up. This chapter describes the services and how to start and stop them, should the 
need arise. Services are started and stopped using the ObjectVideo Management 
Tool. With the exception of the computer where FAST is installed, the ObjectVideo 
Management Tool is installed on every computer where ObjectVideo software is 
installed. It is automatically installed at the same time that the Daemon Service is 
installed. 

Important: You must be logged in as a Windows user with Administrator or Power 
User privileges in order to work with the ObjectVideo services. 

Note: The field next to the service name indicates whether a service is Running or 
Stopped. You may also see a status of Starting when the service is about to run 
and Stopping when the service is about to stop. 

Starting and Stopping ObjectVideo Server Services 

The ObjectVideo Server uses the following ObjectVideo software deployed as 
Windows services: 

• ObjectVideo Communication Server – The core ObjectVideo Server component 
that performs many of the system’s communications tasks. 

• ObjectVideo Daemon Service – Enables the ObjectVideo Server to 
communicate with the other ObjectVideo components. 

• ObjectVideo Alert Logger – Receives event information from the sensor(s) and 
stores alerts in the alert database. 

When these three services are running, the ObjectVideo Server is running. 

Note: The ObjectVideo Forensic Store Service and ObjectVideo Serial Port Service 
may appear in the ObjectVideo Management Tool if ISE software is running on the 
same computer as the ObjectVideo Server software. See “Starting and Stopping the 
ISE Services” on page 136 for more information on the ObjectVideo Forensic Store 
Service and ObjectVideo Serial Port Service. 

The Sentinel LM license server software is a Windows service running on the same 
computer as the ObjectVideo Server software. See the next section for instructions 
on stopping and starting the service. 

To start the ObjectVideo services displayed in the ObjectVideo Management Tool, 
click the Start All Services button. 

To stop the ObjectVideo services displayed in the ObjectVideo Management Tool, 
click the Stop All Services button. 
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You can also start and stop the services individually. Click the Start button next to 
the service you want to start. Click the Stop button next to the service you want to 
stop. 

If all of the services are stopped and you want to start them individually, start them 
in the following order: 

1. ObjectVideo Communication Server 

2. ObjectVideo Daemon Service  

3. ObjectVideo Alert Logger 

4. ObjectVideo Forensic Store Service (only appears if ISE software is also 
installed on the computer) 

5. ObjectVideo Serial Port Service (may appear if VEW Leader/Follower ISE 
software is also installed on the computer) 

If all of the services are started and you want to stop them individually, stop them in 
the following order: 

1. ObjectVideo Serial Port Service (may appear if VEW Leader/Follower 
software is also installed on the computer) 

2. ObjectVideo Forensic Store Service (only appears if ISE software is also 
installed on the computer) 

3. ObjectVideo Alert Logger 

4. ObjectVideo Daemon Service 

5. ObjectVideo Communication Server 

Important:  

• You must be logged in as a Windows user with Administrator or Power User 
privileges in order to work with the ObjectVideo services. 

• By default, the services are set to the Automatic startup type in Windows, which 
means that they run automatically when the computer starts. Do not change this 
setting. 
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Starting and Stopping the Sentinel LM License Management 
Service 

The Sentinel LM license service runs as a Windows service on the same computer as 
the ObjectVideo Server software. Unlike the other ObjectVideo services, the Sentinel 
LM service is started and stopped using the Windows Service Manager rather than 
the ObjectVideo Management Tool. Take the following steps to start and stop the 
service: 

1. On the computer running the ObjectVideo Server software, open Windows 
Service Manager (Start > Control Panel > Performance and Maintenance > 
Administrative Tools > Services). 

2. Right-click Sentinel LM from the list of services, and then do one of the 
following: 

• To stop the service, select Stop from the menu that appears. 

• To start the service, select Start from the menu that appears. 

Starting and Stopping the ISE Services 

The ISE uses the following ObjectVideo software deployed as Windows services: 

• ObjectVideo Daemon Service – Enables the ISE to communicate with the 
other ObjectVideo components and starts the ISE software. 

• ObjectVideo Forensic Store Service - The ObjectVideo Forensics component 
that stores forensics data for FAST to analyze and use. This service is only 
relevant for sensors that support the creation of forensics data. 

• ObjectVideo Serial Port Service - Allows multiple VEW Leader/Follower 
sensors acting as followers to connect to a single COM port on the ISE 
computer. This service only appears if a user included it in the VEW 
Leader/Follower ISE installation. 

When the Daemon Service is running, the ISE software is running. When the 
Forensics Store service is running, it stores the forensics data it receives from the 
sensor, as long as the sensor is configured to generate forensics data. When the 
ObjectVideo Serial Port Service is running, it allows multiple cameras to be 
connected to an ISE computer with a single COM port (for instance, multiple cameras 
using a serial connection). See the ObjectVideo Management Tool Help for more 
information. 

Note: The ObjectVideo Communication Server and ObjectVideo Alert Logger services 
also appear in the ObjectVideo Management Tool if the ObjectVideo Server software 
is running on the same computer as the ISE software. See “Starting and Stopping 
ObjectVideo Server Services” on page 134 for more information on these services. 

Click the Start All Services button to start all the services. Click the Stop All 
Services button to stop all the services. 
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You can also start and stop the services individually. Click the Start button next to 
the service you want to start. Click the Stop button next to the service you want to 
stop. 

If all of the services are stopped and you want to start them individually, start them 
in the following order: 

1. ObjectVideo Communication Server (only appears if the ObjectVideo 
Server software is also installed) 

2. ObjectVideo Daemon Service 

3. ObjectVideo Alert Logger (only appears if the ObjectVideo Server software 
is also installed) 

4. ObjectVideo Forensic Store Service 

5. ObjectVideo Serial Port Service (only appears if the user included it in the 
VEW Leader/Follower ISE installation) 

If all of the services are started and you want to stop them individually, stop them in 
the following order: 

1. ObjectVideo Forensic Store Service 

2. ObjectVideo Serial Port Service (only appears if the user included it in the 
VEW Leader/Follower ISE installation) 

3. ObjectVideo Alert Logger (only appears if the ObjectVideo Server software 
is also installed) 

4. ObjectVideo Daemon Service 

5. ObjectVideo Communication Server (only appears if the ObjectVideo 
Server software is also installed) 

By default, the services are set to the Automatic startup type in Windows, which 
means that they run automatically when the computer starts. Do not change this 
setting. 

Note: If the documentation advises you to start the ISE services but they are 
already running, stop and restart the ISE services. 
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Starting and Stopping the Daemon Service on a Client 
Application Computer 

The only ObjectVideo-related Windows service that runs on the client application 
computers is the ObjectVideo Daemon Service. This service enables the client 
applications to communicate with the other ObjectVideo components. The Daemon 
Service is started and stopped using the ObjectVideo Management Tool. 

FAST, the Camera Placement Tool, and the Alert Backup Estimator are the only 
ObjectVideo client applications that do not use the Daemon Service. A computer 
running any of the other ObjectVideo client applications must have a Daemon 
Service running on it for the ObjectVideo system to function properly. 

The Daemon Service also runs on the computers running the ObjectVideo Server and 
ISE software. 

To start the Daemon Service, click the Start button. 

To stop the Daemon Service, click the Stop button. 

Important: 

• You must be logged in as a Windows user with Administrator or Power User 
privileges in order to work with the ObjectVideo services. 

• By default, the services are set to the Automatic startup type in Windows, which 
means that they run automatically when the computer starts. Do not change this 
setting. 
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Working with Licenses 

This guide describes the two most common license-related tasks you will need to 
perform on the system: “Installing Licenses” on page 41 describes how to install 
licenses, and “Upgrading or Downgrading the System” on page 143 describes how to 
install additional licenses to upgrade the system. 

The ObjectVideo Server is also accompanied by a Sentinel LM tool called WlmAdmin 
that allows you to perform these and other license-related tasks. The tool is installed 
on the computer running the ObjectVideo Server software under the following path: 

C:\Program Files\ObjectVideo\Server\WlmAdmin.exe 

For information about how to use WlmAdmin, refer to the WlmAdmin documentation, 
which is provided at the following location on the computer running the ObjectVideo 
Server software: 

C:\Program Files\ObjectVideo\Documentation\WlmAdmin Docs\index.html 

Note: If the ObjectVideo Server computer fails or if you change the hard drive or 
primary Ethernet card on the computer running the ObjectVideo Server software, 
contact ObjectVideo to acquire new licenses. 
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Adding a Host to a Hosts File 

On the computers running the ISE and ObjectVideo client application software, you 
specify the ObjectVideo Server by providing the ObjectVideo Server’s IP address or 
host name in the Server Address field of the ObjectVideo Management Tool. If you 
provide the ObjectVideo Server’s host name but your network is not running a DNS 
server, you will need to add a host to the Windows hosts file. 

To add a host to a hosts file, do the following: 

1. On the ISE or ObjectVideo client application computer, stop the ObjectVideo 
services. 

See “Starting and Stopping the ISE Services” on page 136 and “Starting and 
Stopping the Daemon Service on a Client Application Computer” on page 138 
for more information. 

2. Close the ObjectVideo Management Tool and any other ObjectVideo software 
running on the computer. 

3. In Windows Explorer, browse to C:\WINDOWS\system32\drivers\etc. 

4. Open the hosts file using a text editor (such as Windows Notepad).  

5. Directly beneath the last IP address and host name entered in the hosts file, 
type the IP address of the computer running the ObjectVideo Server software, 
press the Tab key, and type the host name of the computer running the 
ObjectVideo Server software. 

6. Save and close the file. 

7. Start the ObjectVideo services. 

See “Starting and Stopping the ISE Services” on page 136 and “Starting and 
Stopping the Daemon Service on a Client Application Computer” on page 138 
for more information. 

8. Repeat steps 1-7 on every computer running the ObjectVideo client 
applications and ISE software. 
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Deleting and Replacing Corrupt Parameter Files 

If a sensor icon is missing from the configuration displayed in the System 
Configuration Tool, the sensor’s parameter model may have become corrupt. Each 
sensor’s parameter settings are saved in a parameter model file. When a parameter 
file is corrupt, it must be deleted from the computer running the ISE software. A new 
parameter model for the sensor is automatically created when the ObjectVideo 
services on the computer running the ISE software are started. 

Important: Before you complete the steps in this section, try every solution 
described in “ISE Not Communicating with the ObjectVideo Server” on page 186. 
Deleting parameter files permanently removes any changes you have made to the 
default parameter settings. Back up existing parameter files before deleting them 
using the instructions in this article. 

To Delete and Replace Corrupt Parameter Files 

1. Stop the ObjectVideo services on the computer running the ISE software (see 
“Starting and Stopping the ISE Services” on page 136). 

2. In Windows Explorer, browse to C:\Program Files\ObjectVideo\ISE. 

3. To make the parameter model files easier to locate, in Windows Explorer, select 
Details from the View menu and click the Type heading to order the files by file 
type. 

4. Select the XML parameter model file for each sensor whose icon is missing from 
the System Configuration Tool. 

The parameter model files start with the unique string of letters and numbers 
assigned to the sensor by the ObjectVideo system and end in -SensorConfig-
ParameterModel.xml. 

Important: Do not delete any files that do not end in -SensorConfig-
ParameterModel.xml. 

5. Back up the parameter model files to another location. 

You can do this by copying the files and pasting them into a different directory on 
the computer running the ISE software. This ensures that you can copy the 
original parameter files back into this directory in the event that they are not 
corrupt and are not causing the sensor icons to disappear from the System 
Configuration Tool and Rule Management Tool. This will preserve any changes 
you have made to the parameter model. 

6. Delete the parameter model files for each sensor. 

7. Start the ObjectVideo services on the computer running the ISE software (see 
“Starting and Stopping the ISE Services” on page 136). 

When the services are restarted, a new parameter model file replaces each 
deleted parameter model file. 
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8. Click the Refresh Configuration button in the System Configuration Tool to 
display the missing sensor icons. 

9. Do one of the following: 

• If the missing sensor(s) appear in the System Configuration Tool, use the 
Parameter Configuration Tool to make any changes to the new parameter 
model that had been made to the original parameter model that was deleted. 
After you take this step, the parameter models for the sensors will be 
restored, and no further action is necessary. 

• If the missing sensor(s) do not appear, proceed to step 10. 

10. Stop the ObjectVideo-related Windows services on the computer running the ISE 
software (see “Starting and Stopping the ISE Services” page 136). 

11. Copy the parameter model files you backed up in step 5 to their original location 
in C:\Program Files\ObjectVideo\ISE. 

12. Contact customer support (see “Getting Support” on page 223). 



 

Upgrading or Downgrading the 
System 
This chapter describes how to do the following with the system: 

• Increase the number of sensors monitoring video feeds 

• Allow more instances of FAST to run simultaneously 

• Upgrade or downgrade ObjectVideo OnBoard sensors 

For information about upgrading to another version of an ObjectVideo product (e.g., 
upgrading from release 2.5 to release 3.0), contact customer support (see “Getting 
Support” on page 223). 
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Increasing Sensor Number 

The number of sensors actively monitoring video feeds is determined by licensing. 
You can increase the number of sensors in your system by installing additional 
licenses. To purchase additional licenses to upgrade an ObjectVideo system, contact 
customer support (see “Getting Support” on page 223). Once you have received your 
new license file, install it according to the instructions in “To Install Licenses” on 
page 42. 

To accommodate additional active sensors, you may also wish to increase the 
number of ISEs in your system (this would be necessary if, for example, you lack 
enough storage space for forensics data on your current system). Follow the 
instructions in “Installing the OnBoard ISE Software” on page 44 or “Installing the 
VEW ISE Software” on page 48 to install each additional ISE. You may need to 
receive installation CDs from ObjectVideo in order to install the software you have 
purchased. 

Important: Do not install and run the new ISE software before you install the new 
licenses. Installing and running the new software before you install the licenses can 
cause the system to become unstable. 

To validate that the upgrade was successful, take the steps in the following chapters 
and sections of this guide, in the order listed. 

Table 18: Validating and Completing the Upgrade 

Chapter or Section What to Do 

 “Assigning a Video Source to a Sensor,” 
page 60

Follow the instructions in the section to 
assign a video input to the sensor icon 
associated with each newly licensed 
sensor. 

“Using the System Configuration Tool to 
Check the System,” page 63

 

Follow the instructions in the section to 
make sure that the newly licensed and 
installed sensors in your system do not 
have an Unvalidated (ObjectVideo VEW) 
or Lost Communication (ObjectVideo 
OnBoard) status. If they do, refer to the 
troubleshooting articles on page 175. 

 “Creating Views,” page 70 Follow the instructions in the section to 
create an initial view for each new VEW 
Standard, VEW HiRes, and VEW 
Leader/Follower sensor monitoring a 
video feed. 
Note: It is not necessary to create views 
for VEW FlowControl sensors. The initial 
view is automatically created for 
ObjectVideo OnBoard sensors. 
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Chapter or Section What to Do 

“Editing and Reviewing Component 
Properties,” page 75

 

Follow the instructions in the section to 
edit and review the properties of any new 
sensor icons or ISE icons listed in the 
upgraded system. 

After you have taken the steps in the sections cited in the table, you may wish to 
perform other tasks to complete the upgrade.  

• For ObjectVideo VEW and ObjectVideo OnBoard deployments, refer to 
“Completing the ObjectVideo VEW and ObjectVideo OnBoard Deployment 
Process” on page 78.  

• For ObjectVideo Forensics deployments, refer to “Completing the ObjectVideo 
Forensics Deployment Process” on page 85. 
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Upgrading FAST 

To upgrade FAST to allow more instances to run simultaneously, purchase an 
upgraded FAST license (see “Getting Support” on page 223). 

Once you have received the new license file, install the license according to the 
instructions in “To Install License” on page 42. Then follow the instructions in 
“Installing FAST” on page 99 to install additional instances of FAST. 
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Upgrading or Downgrading ObjectVideo OnBoard 
Sensors 

It may be possible to upgrade or downgrade existing ObjectVideo OnBoard sensors 
to a different type of OnBoard sensor. Contact your Video Analysis Device vendor for 
instructions. This can be used to change sensor types within the same version of the 
software. For instance, you could upgrade an OnBoard 100 sensor to OnBoard 200.  

See “ObjectVideo OnBoard” on page 3 for information on which features are 
supported by each ObjectVideo OnBoard sensor type.



 

Uninstalling the Software 
This chapter describes how to uninstall the components of an ObjectVideo system. In 
order to uninstall the software, you must log in as a Windows user with 
Administrator privileges. 

Important: If you plan on reinstalling the ObjectVideo system after completely 
uninstalling the software, additional steps may be required. Consult the ObjectVideo 
Troubleshooting Knowledge Base at http://www.objectvideo.com/kb (or 
http://www.objectvideo.com/kb/partners for partners) or customer support for more 
information. 

Note: You cannot uninstall the Daemon Service if the Microsoft .NET Framework is 
not installed. If you have uninstalled the Microsoft .NET Framework, reinstall it 
before attempting to uninstall the ObjectVideo Server software, ISE software, 
VEW/OnBoard client applications, or ObjectVideo Integrator Toolkit applications. 
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To Uninstall the ISE Software 

Note: In ObjectVideo OnBoard, if you are running both the ISE and ObjectVideo 
Server software on the same computer, remove the ISE software prior to removing 
the ObjectVideo Server software. 

1. On a computer running the ISE software, open the ObjectVideo Management 
Tool.  

2. Click the Stop All Services button to stop the ISE services. 

3. Verify that the status for all services is Stopped. 

4. Exit the ObjectVideo Management Tool. 
 
You must close the ObjectVideo Management Tool before uninstalling the 
software. 

5. In the Windows Control Panel, open Add or Remove Programs. 

6. Select ObjectVideo Forensics Store from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

7. Click Yes. 

The ObjectVideo Forensics Store screen appears while the software is being 
uninstalled. 

8. Do one of the following: 

• If the ObjectVideo Serial Port Service appears in the list of programs, 
proceed to step 9. 

• If the ObjectVideo Serial Port Services does not appear, proceed to step 
11. 

9. Select the ObjectVideo Serial Port Service, and then click the Remove 
button. 

The Add or Remove Programs screen appears. 

10. Click Yes. 

The ObjectVideo Serial Port Service screen appears while the software is 
being uninstalled. 

11. Select ObjectVideo VEW Standard ISE, ObjectVideo VEW FlowControl ISE, 
ObjectVideo VEW HiRes ISE, ObjectVideo Leader/Follower ISE, or 
ObjectVideo OnBoard ISE from the list of programs, and then click the 
Remove button. 
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The Add or Remove Programs screen appears. 

12. Click Yes to uninstall the software. 

13. Do one of the following: 

• If you have been running ISE and ObjectVideo Server software on the same 
computer, proceed to “Uninstalling the ObjectVideo Server Software” on page 
151.  

• If only ISE software in installed on this computer, proceed to step 14. 

14. Select ObjectVideo Daemon Service from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

15. Click Yes. 

The ObjectVideo Daemon Service screen appears while the software is being 
uninstalled. 
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Uninstalling the ObjectVideo Server Software 

Uninstalling the ObjectVideo Server software involves the following steps: 

• Uninstalling the ObjectVideo Server software 

• Uninstalling the Sentinel LM license management software 

• Deleting the ObjectVideo database 

If you want to keep the information in the ObjectVideo database (such as stored 
alerts, groups, views, etc.), do not delete the ObjectVideo database. You may need 
the information in the database if you reinstall the ObjectVideo Server software or 
migrate to a later version of the software. 

Note: In ObjectVideo OnBoard, if you are running both the ISE and ObjectVideo 
Server software on the same computer, remove the ISE software prior to removing 
the ObjectVideo Server software. 

To Uninstall the ObjectVideo Server Software 

1. On the computer running the ObjectVideo Server software, open the ObjectVideo 
Management Tool.  

2. Click the Stop All Services button. 

3. Verify that the status for all services is Stopped. 

4. Exit the ObjectVideo Management Tool. 
 
You must close the ObjectVideo Management Tool before uninstalling the 
software. 

5. Follow the instructions in “Starting and Stopping the Sentinel LM License 
Management Service” on page 136 to stop the service for the Sentinel LM license 
server. 

6. In the Windows Control Panel, open Add or Remove Programs. 

7. Select ObjectVideo Server from the list of programs, and then click the 
Remove button. 

The Add or Remove Programs screen appears. 

8. Click Yes. 

The ObjectVideo Server screen appears while the software is being uninstalled. 

9. Select Sentinel LM 7.3.0.9 Server from the list of programs, and then click the 
Change/Remove button. 

10. On the Confirm File Deletion dialog, click OK. 
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11. Click Finish. 

12. Select ObjectVideo Daemon Service from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

13. Click Yes. 

The ObjectVideo Daemon Service screen appears while the software is being 
uninstalled. 

To Delete the ObjectVideo Database 

This section describes how to delete the main ObjectVideo database, which contains 
stored alerts, groups, views, etc., and two supporting databases that store other 
system data. If you want to keep the information in the ObjectVideo database (such 
as stored alerts, groups, views, etc.), do not follow the instructions in this section. 
You may need the information in the database if you reinstall the ObjectVideo Server 
software or migrate to a later version of the software. 

In the instructions that follow, <Enter> means press the Enter key on your 
keyboard. Take the following steps to delete the ObjectVideo database: 

1. From a command prompt on the computer running the ObjectVideo Server 
software, type the following: 

osql -E –S hostname\obvserver <Enter> 

The hostname is the name of the computer on which the database is installed. 

A 1> appears in the command prompt after you press Enter. 

2. Type the following text: 

use master <Enter> 

go <Enter> 

drop database objectstore <Enter> 

go <Enter> 

drop database objectstore_archive <Enter> 

go <Enter> 

drop database objectstore_archivelogdb <Enter> 

go <Enter> 

The database is deleted. 
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To Uninstall the VEW/OnBoard Client Applications 

1. Exit the VEW/OnBoard client applications (Rule Management Tool, System 
Configuration Tool, and Alert Console), if they are running. 

2. On the computer running the VEW/OnBoard client applications, open the 
ObjectVideo Management Tool. 

3. Click the Stop button next to ObjectVideo Daemon Service. 

4. Verify that the status for the service is Stopped. 

5. Exit the ObjectVideo Management Tool. 
 
You must close the ObjectVideo Management Tool before uninstalling the 
software. 

6. In the Windows Control Panel, open Add or Remove Programs. 

7. Select ObjectVideo VEW/OnBoard Client Applications from the list of 
programs, and then click the Remove button. 

The Add or Remove Programs screen appears. 

8. Click Yes. 

The ObjectVideo VEW/OnBoard Client Applications screen appears while the 
software is being uninstalled. 

9. Select ObjectVideo Daemon Service from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

10. Click Yes. 

The ObjectVideo Daemon Service screen appears while the software is being 
uninstalled. 
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To Uninstall the FAST Software 

1. Exit FAST, if it is running. 

2. In the Windows Control Panel, open Add or Remove Programs. 

3. Select ObjectVideo Forensics FAST from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

4. Click Yes. 

The ObjectVideo Forensics FAST screen appears while the software is being 
uninstalled. 
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To Uninstall the ObjectVideo Integrator Toolkit 
Applications 

1. Exit the ObjectVideo Integrator Toolkit applications (Alert Backup Estimator, 
Camera Placement Tool, Leader/Follower Calibration Tool, Object Sizing Tool, and 
Parameter Configuration Tool). 

2. On the computer running the ObjectVideo Integrator Toolkit applications, open 
the ObjectVideo Management Tool. 

3. Click the Stop button next to ObjectVideo Daemon Service. 

4. Verify that the status for the service is Stopped. 

5. Exit the ObjectVideo Management Tool. 
 
You must close the ObjectVideo Management Tool before uninstalling the 
software. 

6. In the Windows Control Panel, open Add or Remove Programs. 

7. Select ObjectVideo Integrator Toolkit from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

8. Click Yes. 

The ObjectVideo Integrator Toolkit screen appears while the software is being 
uninstalled. 

9. Select ObjectVideo Daemon Service from the list of programs, and then click 
the Remove button. 

The Add or Remove Programs screen appears. 

10. Click Yes. 

The ObjectVideo Daemon Service screen appears while the software is being 
uninstalled. 



 

Troubleshooting 
This chapter lists some common problems that can occur while installing, setting up, 
and using a system and possible solutions to the problems: 

• If you encounter a problem while using the installers, see “Installer 
Troubleshooting” on page 157. 

• If you encounter a System Configuration Tool or Rule Management Tool 
problem, see “System Configuration Tool/Rule Management Tool 
Troubleshooting” on page 175. 

• If you encounter an Alert Console problem, see “Alert Console 
Troubleshooting” on page 203. 

• If you encounter a Leader/Follower Calibration Tool problem, see 
“Leader/Follower Calibration Tool Troubleshooting” on page 211. 

• If you encounter a Parameter Configuration Tool problem, see “Parameter 
Configuration Tool Troubleshooting” on page 212. 

• If you encounter an Object Sizing Tool problem, see “Object Sizing Tool 
Troubleshooting” on page 214. 

• If you encounter a FAST problem, see “FAST Troubleshooting” on page 215. 

• If you encounter a problem related to the Forensics Store service, see 
“Forensics Store Service Troubleshooting” on page 216. 

• If you encounter a problem while maintaining the system, see “Maintenance 
Troubleshooting” on page 217. 

Additional troubleshooting articles concerning the day-to-day operation of the system 
are included in the Help for the ObjectVideo client applications. You may also obtain 
access to the online ObjectVideo Troubleshooting Knowledge Base at 
http://www.objectvideo.com/kb (or http://www.objectvideo.com/kb/partners for 
partners). 

The Knowledge Base contains the troubleshooting articles in this chapter, as well as 
other troubleshooting material related to post-installation problems. In addition, it 
contains useful how-to articles describing various system tasks. To obtain an account 
to access the Knowledge Base, contact customer support. Also, contact customer 
support if you are experiencing a problem that is not addressed in this chapter or the 
Help (see “Getting Support” on page 223). 

This chapter does not provide solutions to problems caused by hardware and 
operating system issues. To address such problems, refer to the hardware or 
operating system documentation or contact the appropriate hardware or operating 
system vendor. 
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Installer Troubleshooting 

The articles in this section describe in detail various problems and errors messages 
that can occur during the installation process for ObjectVideo software. The actual 
error messages appear in quotes below. 

Troubleshooting Article Page 

General Problems 

Installer Does Not Start 158

Error Message: The ObjectVideo software has not been installed. See the 
Windows Event Viewer for information on why the installation failed.

159

ObjectVideo Server Installation 

Missing ObjectVideo Server Requirements 161

Error Message: Specified directory is not valid. 163

Error Message: Specified path cannot be found. 164

Error Message: You are not authorized to create the specified directory. 165

Error Message: Unable to create specified directory. 166

Error Message: Invalid port specified. 167

Error Message: Specified directory is not valid. Invalid port specified. 168

ISE Installation 

Missing ISE Requirements 169

Error Message: Specified directory is not valid. 163

Error Message: Specified path cannot be found. 164

Error Message: You are not authorized to create the specified directory. 165

Error Message: Unable to create specified directory. 166

VEW/OnBoard Client Application, FAST, or ObjectVideo Integrator Toolkit 
Installation 

Missing VEW/OnBoard Client Application Requirements 171

Missing FAST Requirements 173

Missing ObjectVideo Integrator Toolkit Requirements 174
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Installer Does Not Start 

Article Number: 1417 

Found In: Installation of ObjectVideo client applications, ObjectVideo Server, and 
ISEs 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

• ObjectVideo Integrator Toolkit 2.5 or later 

Summary: 

The installation instructions do not open or the installer does not start automatically 
when I insert an installation CD. 

Solution: 

For FAST, the VEW/OnBoard client applications, or the ObjectVideo Integrator Toolkit 
applications, use Windows Explorer to browse to the computer’s CD drive. Double-
click Installation_Instructions.htm. Follow the instructions on the HTML page. 

For the ObjectVideo Server and ISE, use Windows Explorer to browse to the 
computer’s CD drive. Double-click AutoSetup.js. This begins the installation 
process. 
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Error Message: The ObjectVideo software has not been installed. See the 
Windows Event Viewer for information on why the installation failed. 

Article Number: 1090 

Found In: Installation of ObjectVideo client applications, ObjectVideo Server, and 
ISEs 

Product(s) Affected: 

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

• ObjectVideo Integrator Toolkit 2.0 or later 

Summary: 

The following message appears when I attempt to install the software: The 
ObjectVideo software has not been installed. See the Windows Event Viewer 
for information on why the installation failed. 

Solution: 

The installation has ended due to an error. Open the Microsoft Event Viewer to 
investigate the cause of the error. 

To Learn More about an Installation Error 

1. Open the Microsoft Event Viewer: 

• In Windows 2000, select Start > Settings > Control Panel > 
Administrative Tools > Event Viewer. 

• In Windows XP, select Start > Control Panel > Performance and 
Maintenance > Administrative Tools > Event Viewer. 

2. Select the applications event log: 

• In Windows 2000, double-click Application Log. 

• In Windows XP, double-click Application. 

3. Look in the Source column of the application events and see if there is an event 
with one of the following sources: 

• WinInstallUtil_[name of application being installed] 
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• MsiInstaller 

4. Do one of the following: 

• If you are not experiencing an error that is derived from one of these sources, 
contact customer support (see “Getting Support” on page 223). If you do 
have an error from one of these sources, proceed to step 5. 

• If you see an event with one of the sources listed in step 3, double-click the 
event to open it. 

The Event Properties dialog opens. 

5. Use the table that follows to diagnose the error. 

Table 19: Event Viewer Error Sources 

Source Cause 

WinInstallUtil_[name of 
application being installed] 

Most errors of this kind are related to the creation of 
ObjectVideo services. On the ObjectVideo Server, 
this error may be related to database access errors. 
If you do not know how to correct the error, contact 
customer support. 

MsiInstaller This error may appear due to a variety of 
unexpected problems. If you do not know how to 
correct the error, contact customer support. 
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Missing ObjectVideo Server Requirements 

Article Number: 1410 

Found In: Installation of ObjectVideo Server 

Product(s) Affected:  

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

• ObjectVideo Integrator Toolkit 2.5 or later 

Summary: 

During installation, you are notified in an error message that you do not have one of 
the requirements for running the ObjectVideo Server software. 

Solution: 

Find the error message in the table below, and then use the appropriate solution. A 
full list of software requirements is listed in “ObjectVideo Server and ISE Software 
Requirements” on page 225. 

Error Message Solution 

This software requires Windows XP 
or Windows Server 2003. 

ObjectVideo Server software must be run 
on Windows XP or Windows Server 2003. 
If you are using another operating 
system, this message will appear. 

This message should never appear if you 
are using ObjectVideo-certified hardware. 
If you receive this message on a certified 
computer, contact customer support for 
assistance (see “Getting Support” on 
page 223). 

If you received this message on a 
computer not certified by ObjectVideo, 
see http://www.microsoft.com for 
information on obtaining and installing 
the correct operating system. 
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Error Message Solution 

You must install the Microsoft SQL 
Server Desktop Engine before 
installing [product name]. 

See “To Install MSDE” on page 234 for 
installation instructions. 

This software requires Microsoft 
.NET Framework version 1.1.4322. 

See “To Install the Microsoft .NET 
Framework” on page 233 for installation 
instructions. 

This software requires Microsoft 
DirectX 9.0b. 

See “To Install Microsoft DirectX” on 
page 231 for installation instructions. 
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Error Message: Specified directory is not valid. 

Article Number: 1494 

Found In: Installation of ObjectVideo Server or ISE 

Product(s) Affected:  

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

• ObjectVideo Integrator Toolkit 3.0 or later 

Summary: 

The Specified directory is not valid message appears when I attempt to install the 
ObjectVideo Server or ISE software. 

Solution: 

For the ObjectVideo Server installer, the problem can occur if an invalid path was 
entered in the ObjectVideo Server Configuration dialog’s Web Server Home 
Directory field. If the computer is running an Apache web server, the default 
document directory is usually C:\Program Files\Apache 
Group\Apache2\htdocs. If the computer is running Microsoft Internet Information 
Server (IIS), the default document directory is usually C:\Inetpub\wwwroot. 

For an ISE installer, the problem can occur if an invalid value was entered in the 
ObjectVideo Forensics Store Configuration dialog’s Forensics Data Directory 
field. 

While specifying a directory in the ObjectVideo Server or ISE installer, one of the 
following could also have occurred: 

• You left the field blank. 

• You typed a directory path containing a space or selected a directory that 
contains a space in the Browse the Folder dialog. 

• You typed a network path in the field. 

Click OK on the error dialog, and then specify a valid directory path. 
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Error Message: Specified path cannot be found. 

Article Number: 1495 

Found In: Installation of ObjectVideo Server or ISE 

Product(s) Affected:  

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

• ObjectVideo Integrator Toolkit 3.0 or later 

Summary: 

The Specified path cannot be found message appears when I attempt to install 
the ObjectVideo Server or ISE software. 

Solution: 

You typed a path with an invalid drive letter:  

• For the ObjectVideo Server installer, the problem occurs in the ObjectVideo 
Server Configuration dialog’s Web Server Home Directory field (e.g., you 
typed W:\Program Files\Apache Group\Apache2\htdocs but the 
computer has no W: drive). 

• For an ISE installer, the problem occurs in the ObjectVideo Forensics Store 
Configuration dialog’s Forensics Data Directory field (e.g., you typed 
W:\Store but the computer has no W: drive).  

Click OK on the error dialog, and then specify a path with a valid drive letter. 
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Error Message: You are not authorized to create the specified directory. 

Article Number: 1496 

Found In: Installation of ObjectVideo Server or ISE 

Product(s) Affected:  

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

• ObjectVideo Integrator Toolkit 3.0 or later 

Summary: 

The You are not authorized to create the specified directory message appears 
when I attempt to install the ObjectVideo Server or ISE software. 

Solution: 

You typed a path to a directory that does exist, but you do not have the Windows 
permissions necessary to create a directory at the specified location: 

• For the ObjectVideo Server installer, the problem occurs in the ObjectVideo 
Server Configuration dialog’s Web Server Home Directory field. 

• For an ISE installer, the problem occurs in the ObjectVideo Forensics Store 
Configuration dialog’s Forensics Data Directory field. 

Your Windows account must have Full Control permissions to create directories at the 
location you specify. Click OK on the error dialog, and then specify a path to a 
location for which you have Full Control permissions in Windows. 
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Error Message: Unable to create specified directory. 

Article Number: 1497 

Found In: Installation of ObjectVideo Server or ISE 

Product(s) Affected:  

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

• ObjectVideo Integrator Toolkit 3.0 or later 

Summary: 

The Unable to create specified directory message appears when I attempt to 
install the ObjectVideo Server or ISE software. 

Solution: 

You specified an invalid directory path: 

• For the ObjectVideo Server installer, the problem occurs in the ObjectVideo 
Server Configuration dialog’s Web Server Home Directory field. The 
Web Server Home Directory is the local directory from which the web 
server hosts alert snapshots so that they are available to the Alert Console. 

• For an ISE installer, the problem occurs in the ObjectVideo Forensics Store 
Configuration dialog’s Forensics Data Directory field. 

You must not specify a directory path with spaces. If the directories in the path you 
specify do not already exist, the installer will create them for you. You must use a 
local directory. 
 
For the ISE installer, specify a path even if you do not plan on using ObjectVideo 
Forensics. 

Click OK on the error dialog, and then specify a valid path. 
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Error Message: Invalid port specified. 

Article Number: 1125 

Found In: Installation of ObjectVideo Server 

Product(s) Affected:  

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

• ObjectVideo Integrator Toolkit 2.0 or later 

Summary: 

The Invalid port specified message appears when I attempt to install the 
ObjectVideo Server software. 

Solution: 

You entered an invalid port number in the ObjectVideo Server Configuration 
dialog’s Web Server Port field. One of the following may have occurred: 

• You may have left the Web Server Port field empty. 

• You may have typed letters in the Web Server Port field instead of numbers. 

• You may have typed a negative number in the Web Server Port field. 

Click OK on the error dialog, and then type a valid port number in the Web Server 
Port field. 
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Error Message: Specified directory is not valid. Invalid port specified. 

Article Number: 1126 

Found In: Installation of ObjectVideo Server 

Product(s) Affected:  

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

• ObjectVideo Integrator Toolkit 2.0 or later 

Summary: 

The following message appears when I attempt to install the ObjectVideo Server 
software: Specified directory is not valid. Invalid port specified. 

Solution: 

In the ObjectVideo Server Configuration dialog in the ObjectVideo Server 
installer, you did not specify a path in the Web Server Home Directory field and 
you entered an invalid port number in the Web Server Port field. Do the following:  

1. Click OK on the error dialog. 

2. Specify the web server’s document directory in the Web Server Home 
Directory field.  

3. Type a valid port number in the Web Server Port field. 
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Missing ISE Requirements 

Article Number: 1498 

Found In: Installation of ISE 

Product(s) Affected:  

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

• ObjectVideo Integrator Toolkit 3.0 or later 

Summary: 

During installation, you are notified in an error message that you do not have one of 
the requirements for running the ISE software. 

Solution: 

Find the error message in the table below, and then use the appropriate solution. A 
full list of software requirements is listed in “ObjectVideo Server and ISE Software 
Requirements” on page 225. 

Error Message Solution 

This software requires Windows XP 
or Windows Server 2003. 

ObjectVideo ISE software must be run on 
Windows XP or Windows Server 2003. If 
you are using another operating system, 
this message will appear.  

This message should never appear if you 
are using ObjectVideo-certified hardware. 
If you receive this message on a certified 
computer, contact customer support for 
assistance (see “Getting Support” on 
page 223). 

If you received this message on a 
computer not certified by ObjectVideo, 
see http://www.microsoft.com for 
information on obtaining and installing 
the correct operating system. 

The ObjectVideo Forensics Store 
requires Microsoft Message Queuing. 

See “To Install MSMQ” on page 232 for 
installation instructions. 

You must install the MPEG-4 video 
compressor before installing the 
ObjectVideo Forensics Store. 

See “To Install the MPEG-4 Video 
Compressor” on page 236 for installation 
instructions. 
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Error Message Solution 

You must install the ObjectVideo 
Daemon Service before installing the 
ObjectVideo Forensics Store. 

You may encounter this message if you 
did not initiate the installation as 
described in the installation instructions. 
See “Installing the VEW ISE Software” on 
page 49 or “Installing the OnBoard ISE 
Software” on page 44 for more 
information. 

You must install the ObjectVideo 
Daemon Service before installing the 
ObjectVideo [ISE type] ISE. 

You may encounter this message if you 
did not initiate the installation as 
described in the installation instructions. 
See “Installing the VEW ISE Software” on 
page 49 or “Installing the OnBoard ISE 
Software” on page 44 for more 
information. 

You must install the MPEG-4 video 
compressor before installing the 
ObjectVideo [ISE type] ISE. 

See “To Install the MPEG-4 Video 
Compressor” on page 236 for installation 
instructions. 

The ObjectVideo [ISE type] ISE 
requires Microsoft Message Queuing. 

See “To Install MSMQ” on page 232 for 
installation instructions. 

This software requires Microsoft 
.NET Framework version 1.1.4322. 

See “To Install the Microsoft .NET 
Framework” on page 233 for installation 
instructions. 

This software requires Microsoft 
DirectX 9.0b. 

See “To Install Microsoft DirectX” on 
page 231 for installation instructions. 
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Missing VEW/OnBoard Client Application Requirements 

Article Number: 1412 

Found In: Installation of VEW/OnBoard client applications 

Product(s) Affected:  

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

During installation, you are notified in an error message that you do not have one of 
the requirements for running the VEW/OnBoard client applications (Rule 
Management Tool, System Configuration Tool, and Alert Console). 

Solution: 

Find the error message in the table below, and then use the appropriate solution. A 
full list of software requirements is listed in “Client Application Software 
Requirements” on page 226.  

Error Message Solution 

This software requires Windows 
2000 or Windows XP. 

The ObjectVideo client applications must 
be run on Windows 2000 or Windows XP. 
If you are using another operating 
system, this message will appear.  

See http://www.microsoft.com for 
information on obtaining and installing 
the correct operating system. 

This software requires Microsoft 
.NET Framework version 1.1.4322. 

See “To Install the Microsoft .NET 
Framework” on page 233 for installation 
instructions. 
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Error Message Solution 

You must install the ObjectVideo 
Daemon Service before installing the 
VEW client applications. 

The ObjectVideo Daemon Service must 
be installed on the computer before the 
VEW/OnBoard client applications can be 
installed. You may encounter this 
message if you did not initiate the 
installation as described in the 
installation instructions. See “To Install 
the VEW/OnBoard Client Applications” on 
page 55 for instructions.  

You must install MDAC version 2.7 or 
higher before installing the 
ObjectVideo VEW client applications. 

See “To Install MDAC” on page 230 for 
installation instructions. 
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Missing FAST Requirements 

Article Number: 1413 

Found In: Installation of FAST 

Product(s) Affected: ObjectVideo Forensics 2.5 or later 

Summary: 

During installation, you are notified in an error message that you do not have one of 
the requirements for running the FAST software. 

Solution: 

Find the error message in the table below, and then use the appropriate solution. A 
full list of software requirements is listed in “Client Application Software 
Requirements” on page 226. 

Error Message Solution 

This software requires Windows 2000 
or Windows XP. 

FAST must be run on Windows 2000 or 
Windows XP. If you are using another 
operating system, this message will 
appear.  

See http://www.microsoft.com for 
information on obtaining and installing 
the correct operating system. 

This software requires Microsoft .NET 
Framework version 1.1.4322. 

See “To Install the Microsoft .NET 
Framework” on page 233 for installation 
instructions. 

You must install the MPEG-4 video 
compressor before installing FAST 

See “To Install the MPEG-4 Video 
Compressor” on page 236 for 
installation instructions. 

You must install Java Runtime 
Environment 1.4.2 before installing 
FAST. 

See “To Install the Java Runtime 
Environment” on page 229 for 
installation instructions. 

You must install Windows Media 
Player 9 before installing FAST. 

See “To Install Windows Media Player 9” 
on page 235 for installation instructions. 

You must install DirectX 9.0b before 
installing FAST. 

See “To Install Microsoft DirectX” on 
page 231 for installation instructions. 
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Missing ObjectVideo Integrator Toolkit Requirements 

Article Number: 1414 

Found In: Installation of ObjectVideo Integrator Toolkit 

Product(s) Affected: ObjectVideo Integrator Toolkit 2.5 or later 

Summary: 

During installation, you are notified in an error message that you do not have one of 
the requirements for running the ObjectVideo Integrator Toolkit. 

Solution: 

Find the error message in the table below, and then use the appropriate solution. 
A full list of software requirements is listed in “Client Application Software 
Requirements” on page 226. 

Error Message Solution 

This software requires Windows 
2000 or Windows XP. 

The ObjectVideo Integrator Toolkit must 
be run on Windows 2000 or Windows XP. 
If you are using another operating 
system, this message will appear. 

See http://www.microsoft.com for 
information on obtaining and installing 
the correct operating system.  

This software requires Microsoft 
.NET Framework version 1.1.4322. 

See “To Install the Microsoft .NET 
Framework” on page 233 for installation 
instructions. 

You must install the ObjectVideo 
Daemon Service before installing 
[product name]. 

The ObjectVideo Daemon Service must 
be installed on the computer before the 
ObjectVideo Integrator Toolkit 
applications can be installed. You may 
encounter this message if you did not 
initiate the installation as described in 
the installation instructions. See 
“Installing the ObjectVideo Integrator 
Toolkit Applications” on page 106 for 
more information. 
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System Configuration Tool/Rule Management Tool 
Troubleshooting 

The figure below shows the process for verifying that all system components are 
installed correctly for the System Configuration Tool and Rule Management Tool. 
Where necessary, it references troubleshooting articles outlined in this chapter. 

Troubleshooting Steps for System Configuration Tool and Rule Management Tool
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Offline Server Status Message 

Article Number: 1370 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

The Server Status message is Offline. 

Solution: 

If the ObjectVideo Server is Offline, it means that the local Daemon Service cannot 
locate an ObjectVideo Server. Problems with the ObjectVideo Server should be 
corrected immediately. A connection to the ObjectVideo Server is required for the 
ObjectVideo system to operate. 

The Offline status can occur for the following reasons: 

• The computer running the ObjectVideo Server software may be shut down. If 
this is the case, turn on the computer. 

• The ObjectVideo Server software may not be running. Use the instructions in 
“Starting and Stopping ObjectVideo Server Services” on page 134 to verify 
whether this is the case. If necessary, start the ObjectVideo Server services. 
Click the Refresh Configuration button in the Rule Management Tool or 
System Configuration Tool. 

• You may have specified the wrong ObjectVideo Server host name, IP address, 
or port number, or the host name or IP address of the computer running the 
ObjectVideo Server software may have changed. Open the ObjectVideo 
Management Tool and verify that the Server Address and Port are 
configured correctly. 

• The ObjectVideo Server may be unavailable due to network issues. Check 
your network to ensure that all the components are operating normally. See 
Appendix B, “Diagnosing Network Problems,” on page 237 for more 
information. 
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Unknown Server Status Message 

Article Number: 1377 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

The Server Status is Unknown. 

Solution: 

The Unknown status may appear for the following reasons: 

• The Rule Management Tool or System Configuration Tool cannot locate a 
Daemon Service on the local machine. If this has occurred, the Connect 
Status message is DAEMON UNAVAILABLE. Refer to “Connection Failure 
Dialog Appears/Daemon Unavailable Connect Status Message” on page 182 
for instructions on solving this problem. 

• The computer running the ObjectVideo Server software may be shut down. If 
this is the case, turn on the computer. 

• The ObjectVideo Server software is not running, and you need to restart it 
(see “Starting and Stopping ObjectVideo Server Services” on page 134). After 
restarting the ObjectVideo Server services, click the Refresh Configuration 
icon in the Rule Management Tool or System Configuration Tool. 

• You may have specified the wrong ObjectVideo Server host name, IP address, 
or port number, or the host name or IP address of the computer running the 
ObjectVideo Server software may have changed. Open the ObjectVideo 
Management Tool and verify that the Server Address and Port are correct. 

• The ObjectVideo Server may be unavailable due to network issues. Check 
your network to ensure that all the components are operating normally. See 
Appendix B, “Diagnosing Network Problems,” on page 237 for more 
information. 
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Note: In many cases, an Unknown status is a transitional status before the 
Daemon Service determines the status of the ObjectVideo Server. You will 
frequently see the Unknown status appear just before an Online or Offline 
status. 
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After Changing the ObjectVideo Server, Correct Configuration Not Displayed 

Article Number: 1362 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

I changed the Server Address and/or Port in the Connection tab of the 
ObjectVideo Management Tool, but the new configuration has not been displayed in 
the Rule Management Tool and System Configuration Tool. 

Solution: 

If the configuration has not been displayed, one of the following may have occurred: 

• You entered the Server Address and/or Port incorrectly. Check to be sure 
that the exact Server Address for the computer running the ObjectVideo 
Server software was entered in the Connection tab of the ObjectVideo 
Management Tool. If the network is using dynamic IP addresses, a host name 
should have been used rather than an IP address. If you specify a host name 
and the network is not running a DNS server, you will need to add the host 
name and IP address of the computer running the ObjectVideo Server 
software to the Windows hosts file on the VEW/OnBoard client application 
computer (see “Adding a Host to a Hosts File” on page 140 for more 
information). 

• You did not click Apply after entering the new Server Address and/or Port 
in the ObjectVideo Management Tool. Click Apply after making any changes. 

• You did not refresh the configuration in the Rule Management Tool or System 
Configuration Tool. Changes are not displayed until the configuration is 
refreshed. Click the Refresh Configuration button in the Rule Management 
Tool or System Configuration Tool. 

• You refreshed the configuration in the Rule Management Tool or System 
Configuration Tool before the ObjectVideo services began running. The 
ObjectVideo services are restarted automatically when any connection change 
is applied in the ObjectVideo Management Tool. When you click Apply, the 
ObjectVideo Management Tool automatically stops and restarts the 
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ObjectVideo services running on that computer. It only restarts services that 
were running when you clicked the Apply button. You will know that the 
services are restarted when the field next to each service in the ObjectVideo 
Management Tool says Running. After the services are running, Click 
Configuration > Refresh in the Rule Management Tool or System 
Configuration Tool. 

• You did not change the Server Address and/or Port on all of the necessary 
computers. Changes made to the ObjectVideo Management Tool only affect 
the software running on that computer. Unlike the Rule Management Tool and 
the System Configuration Tool, the ObjectVideo Management Tool is not a 
distributed application. In other words, you cannot run the ObjectVideo 
Management Tool on one computer to change settings or manage Windows 
services on another computer. You must run the ObjectVideo Management 
Tool on the local computer to make configuration changes and manage 
services for the software on the local computer. 
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Connection Failure Dialog Appears/Daemon Unavailable Connect Status 
Message 

Article Number: 1407 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

The Connection Failure dialog appears and the Connect Status message is 
DAEMON UNAVAILABLE. 

Solution: 

If the Connection Failure dialog appears and the Connect Status message is 
DAEMON UNAVAILABLE, the Rule Management Tool or System Configuration Tool 
cannot locate a Daemon Service on the local machine. This can occur for the 
following reasons: 

• The Daemon Service is not running, and you need to start it (see “Starting 
and Stopping the Daemon Service on a Client Application Computer” on page 
138). After you start the Daemon Service, refresh the configuration in the 
Rule Management Tool or System Configuration Tool by clicking the Refresh 
Configuration button.  

• The Daemon Service is not installed on the computer. Follow the instructions 
in “Installing the VEW/OnBoard Client Applications” on page 55 to install the 
Daemon Service (the Daemon Service is automatically installed when you 
take the steps required to install the Rule Management Tool and System 
Configuration Tool.) 

Make sure that you enter the correct installation key when prompted. If you 
do not enter a valid installation key, the Daemon Service will not be installed, 
and the Rule Management Tool and System Configuration Tool will not 
function correctly. 
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No ISEs are Listed 

Article Number: 1360 

Found In: System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

Only the ObjectVideo Server icon appears when the System Configuration Tool is 
opened, or some sensor icons are not displayed in the System Configuration Tool. 

 

Solution: 

If you run the System Configuration Tool and only the ObjectVideo Server icon 
appears, several problems may have occurred. 

First, click the Refresh Configuration button. 

If refreshing the configuration does not work, you can determine which problem has 
occurred by checking the Connect Status and Server Status. The Connection 
Failure dialog also appears in some cases. The table that follows describes these 
problems, their possible causes, and solutions. 
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Table 20: System Problems and Solutions 

Symptoms Possible Cause Solution 

One or more ISEs are not 
connected to or 
communicating with the 
ObjectVideo Server. (This 
only occurs if the 
ObjectVideo Server and 
ISE software are installed 
on separate computers). 

See “ISE Not 
Communicating with the 
ObjectVideo Server” on 
page 186. 

The ISE has a different 
installation key than the 
client software. 

In the ObjectVideo 
Management Tool, check 
the Installation Key field 
on the Connection tab. 
Ensure that all the 
computers in your system 
have the same installation 
key. 

Server Status is Online 

Connect Status is 
Connected 

The ISE services were 
started when the 
ObjectVideo Server 
services were not running. 
(This only occurs if the 
ObjectVideo Server and 
ISE software are installed 
on separate computers.) 

See “ISE Not 
Communicating with the 
ObjectVideo Server” on 
page 186. 
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Symptoms Possible Cause Solution 

The computer running the 
ObjectVideo Server 
software is shut down. 

Reboot the computer 
running the ObjectVideo 
Server software and click 
Configuration > Refresh 
to refresh the 
configuration. 

The ObjectVideo Server 
software is not running. 

See “Starting and 
Stopping ObjectVideo 
Server Services” on 
page 134 to verify 
whether the ObjectVideo 
Server services are 
running, and start them if 
necessary. Click 
Configuration > 
Refresh. 

Server Status is Offline 
Connect Status is 
Connected 

A network connection 
problem is preventing the 
System Configuration Tool 
from connecting to the 
computer running the 
ObjectVideo Server 
software. 

Resolve any networking 
issues. See Appendix B, 
“Diagnosing Network 
Problems,” on page 237 
for more information. Click 
Configuration > 
Refresh. 

Server Status is 
Unknown 
Connect Status is 
DAEMON UNAVAILABLE 
(the Connection Failure 
Dialog appears)  

The Daemon Service on 
the Rule Management Tool 
computer is not running or 
is not installed on the 
computer. 

See “Connection Failure 
Dialog Appears/Daemon 
Unavailable Connect 
Status Message” on page 
182 for more information. 
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ISE Not Communicating with the ObjectVideo Server 

Article Number: 1367 

Found In: Alert Console, Rule Management Tool, and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

In the Alert Console, Rule Management Tool, and System Configuration Tool, the 
Server Status is Online, indicating communication with the ObjectVideo Server. 
However, one or more of the following has occurred to indicate communication 
failure between an ISE and the ObjectVideo Server: 

• In the Alert Console, no alerts are being displayed for a particular sensor or a 
set of sensors on an ISE. 

• In the Rule Management Tool, the sensors associated with a particular ISE 
are not displayed. 

• In the System Configuration Tool, the ISE icon for the sensors is not 
displayed. 

Note: The scenarios listed above can only occur if the ObjectVideo Server and ISE 
software are installed on separate computers. 

Solution: 

One of the following is occurring: 

• The computer that is running the ISE software may be shut off. If this is the 
case, start the computer. 

• The computer running the ISE software may have the wrong ObjectVideo 
Server host name, IP address, or port number. Open the ObjectVideo 
Management Tool and verify that the Server Address and Port are correct. 

• The computer running the ISE software may not recognize the host name of 
the ObjectVideo Server computer. This can occur if the network is not using a 
DNS server. Add the host name and IP address of the ObjectVideo Server to 
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the Windows hosts file on the ISE computer by following the instructions 
“Adding a Host to a Hosts File” on page 140.  

• The ISE computer may not be connected to the network or other network 
issues may be taking place. Check the connectivity between the ISE computer 
and the other ObjectVideo system components. See Appendix B, “Diagnosing 
Network Problems,” on page 237 for more information. 

• The ISE computer may have been started when the ObjectVideo services on 
the ObjectVideo Server computer were not running. The ISE is not able to 
obtain the license information from the ObjectVideo Server. Be sure the 
ObjectVideo services on the ObjectVideo Server are running (see “Starting 
and Stopping ObjectVideo Server Services” on page 134). Once the 
ObjectVideo Server services are running, reboot the ISE computer. Refresh 
the configuration in the System Configuration Tool. If sensors still do not 
appear in the System Configuration Tool, the sensors’ parameter models may 
have become corrupt. See “Deleting and Replacing Corrupt Parameter Files” 
on page 141 for more information.  

Note: After trying each of the solutions above, click the Refresh Configuration 
button in the Rule Management Tool or System Configuration Tool, if the problem 
exists in one of those tools. This displays the latest configuration and allows you to 
verify whether the solution was successful. 
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No Sensor Icons Are Listed or Sensor Icons Are Missing 

Article Numbers: 1408 

Found In: System Configuration Tool and Rule Management Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

Some or all of the sensor icons are missing from the left side of the System 
Configuration Tool or Rule Management Tool window. 

Solution:  

Note: If you have the Rule Management Tool and System Configuration Tool 
installed on the same computer, you should first check the System Configuration 
Tool to see if ISE icons appear. The Rule Management Tool never displays ISE icons. 
If ISE icons do not appear in the System Configuration Tool, you will need to use the 
solutions in “No ISEs are Listed” on page 178. 

The following problems may cause sensor icons to not appear: 

• In ObjectVideo OnBoard, no sensors were created in the ObjectVideo 
Management Tool. See “Adding Sensors (ObjectVideo OnBoard)” on page 53 
for instructions on how to create sensors. 

• A sensor has been deleted by a user in the ObjectVideo Management Tool.  

• A sensor's parameter model file has become corrupt. See “Deleting and 
Replacing Corrupt Parameter Files” on page 141 for more information. 
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Sensor Synchronization Times Out and Operation Timed Out Message 
Appears 

Article Number: 1374 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

It appears that the sensor synchronization did not complete and an Operation 
timed out message appears in the bottom center of the Rule Management Tool 
window or System Configuration Tool window. 

Solution: 

This message may appear when you load the configuration, refresh the 
configuration, or select a component from the left side of the window. If this 
message appears, the system is not communicating properly, and the most current 
configuration may not be displayed. 

This message may be related to the Connect Status and Server Status. These 
statuses are displayed in the top-right corner of the Rule Management Tool and 
System Configuration Tool window.  

Check the status, and then refer to the appropriate troubleshooting article: 

• “Connection Failure Dialog Appears/Daemon Unavailable Connect Status 
Message” on page 182 

• “Offline Server Status Message” on page 177 

• “Unknown Server Status Message” on page 178 

An operation timing out may also be related to the Synch Wait (secs) setting or 
Config Wait (secs) setting in the Options dialog’s Connection tab. The dialog is 
accessed from the Rule Management Tool or System Configuration Tool window by 
selecting File > Options.  

The Config Wait (secs) setting determines how long (in seconds) the Rule 
Management Tool or System Configuration Tool waits for the local Daemon Service 
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to load the entire configuration (arrangement of components) from the ObjectVideo 
Server. The default value of this setting is 10 seconds. This value can be set from 
1 to 300 seconds. When you are experiencing heavy network traffic, you may want 
to increase the wait time to prevent the operation from timing out. 

The Synch Wait (secs) setting determines how long (in seconds) the Rule 
Management Tool or System Configuration Tool waits for the Daemon Service to 
synchronize rules, views, and other data with an ISE or sensor. The default value of 
this setting is 10 seconds. This value can be set from 1 to 300 seconds.  

The Daemon Service synchronizes data when you select a sensor or an ISE for the 
first time during a session. During synchronization, the component properties are 
updated. While the Rule Management Tool or System Configuration Tool is waiting 
for this to take place, a Synchronizing status box appears. You can close this box 
without affecting the Daemon Service’s loading of the data. If you close the status 
box or the Rule Management Tool or System Configuration Tool stops waiting, the 
Daemon Service continues loading the data in the background. When you are 
experiencing heavy network traffic, you may want to increase the wait time to 
prevent the operation from timing out. 
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Bad Signal Sensor Status 

Article Number: 1499 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Bad Signal. 

If the status is Bad Signal, there is a problem with the video signal. The video is not 
being checked against rules. Sensors that support forensics data may no longer 
generate useful primitives and video. The presence of any of the following conditions 
creates a Bad Signal camera status:  

• Camera disconnected from the computer running the ISE software or the 
Video Analysis Device 
 
Note: In ObjectVideo OnBoard, if the Video Analysis Device is a camera, you 
will receive a Lost Communication sensor status when the camera is 
disconnected or turned off (see “Lost Communication Sensor Status” on 
page 193). 

• Camera turned off 

• Low dynamic range 

Low dynamic range means that there is not enough contrast within the video images. 
This could be caused by any of the following: 

• Poor or excessive illumination of the camera’s field of view 

• The camera's field of view is out of focus 

• Poor calibration of the camera 

For instance, the camera’s field of view at night may have too little illumination or 
the glare of the sun could wash out the camera’s field of view. You can attempt to fix 
the contrast problem by using a camera with better contrast or changing the lighting 
conditions in the vicinity of the camera. 
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Following Sensor Status 

Article Number: 1471 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: ObjectVideo VEW 3.0 or later (Leader/Follower) 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Following. 

Solution: 

The Following status is the normal sensor status for a sensor monitoring a PTZ 
camera that has begun following an object in response to event detection. See the 
Rule Management Tool Help for more information on the follow object response type. 

The sensor icon is accompanied by a cautionary yellow dot. In the View tab, the 
Live View switches to a view of the object being tracked. In the Rule Management 
Tool, the Active View is replaced by the Following signal status. 

While the Following status does not indicate a problem, a sensor cannot detect any 
new events or store any useful forensics data while it is in this status. 

The follower remains in Following status until it is done tracking the event. When 
the sensor stops following the object, its status is determined by how you set up the 
Follow Object response in the Rule Wizard: 

• If the sensor is to Return to Initial View after tracking, then it will return to 
a Known View status. 

• If the sensor is to Remain in Current View after tracking, then it will switch 
to an Unknown View status. 
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Lost Communication Sensor Status 

Article Number: 1500 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Lost 
Communication. The video is not being checked against rules. Sensors that support 
forensics data may no longer generate useful primitives and video. 

Solution: 

If the status is Lost Communication, the sensor running on the OnBoard ISE 
computer cannot communicate with the Video Analysis Device. This can occur for any 
of the following reasons: 

• A video source has not been assigned to the sensor or an invalid video source 
was assigned to the sensor. 

• The Video Analysis Device was turned off or unplugged. 

• A network problem is preventing the sensor from communicating with the 
Video Analysis Device. 

Take the following steps to fix the problem. After each step, validate whether the 
sensor's status has changed by clicking the Refresh Configuration button: 

1. In the System Configuration Tool, make sure that a valid video source has 
been assigned to the sensor. 

The video source is specified below the Source field in the sensor’s 
Properties tab. See “Assigning a Video Source to a Sensor” on page 60 for 
more information. 

2. Make sure that the Video Analysis Device (i.e., the camera, DVR, or other 
device that detects events using ObjectVideo technology) is plugged in and 
turned on. 

3. Verify that a network problem is not occurring. See Appendix B, “Diagnosing 
Network Problems,” on page 237 for more information. 

4. Turn off the Video Analysis Device and shut down the OnBoard ISE computer 
running the sensor that is having the problem. Turn the Video Analysis Device 
back on. Finally, turn the computer running the ISE back on. 

5. If the problem is still not solved, contact customer support (see “Getting 
Support” on page 223) 
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Searching for Known View Sensor Status 

Article Number: 1372 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Searching 
for Known View. 

Solution: 

If the status is Searching for Known View, the system is currently searching the 
stored views to see if the camera’s current field of view is a known view. A stored 
view is a surveillance camera field of view that has been designated in the system for 
monitoring by a sensor. 

For example, this status may appear when a camera is moving or a camera has just 
stopped moving. This status is replaced by Known View or Unknown View once 
the camera’s field of view has become stationary and the current field of view has 
been compared to the stored known views. 
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Suspended Sensor Status 

Article Number: 1501 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Suspended. 

Solution: 

The video is being received, but the sensor processes that examine the video for 
events were stopped when a user clicked the Suspend Processing button. Sensors 
that support forensics data may no longer generate useful primitives and video. 

To reactivate the sensor, click the Resume Processing button next to the sensor’s 
Status field in the Properties tab. 
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Unknown View Sensor Status 

Article Number: 1459 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as Unknown 
View. 

Solution:  

The sensor does not recognize the camera’s field of view as a known view. A known 
view is a live camera feed that matches a stored view. A stored view is a surveillance 
camera field of view that has been designated in the system for monitoring by a 
sensor. 

Until the camera’s field of view becomes a view the sensor recognizes as a known 
view, the sensor does not generate any new alerts. Sensors that support forensics 
data may no longer generate useful primitives and video. 

An Unknown View status can have several causes: 

• A scene change event has occurred to make the live camera feed 
unrecognizable to the sensor. A scene change event is any event in a known 
view that significantly changes the camera’s field of view, such as the camera 
being panned, turned off, unplugged, jostled, or covered, or the lights being 
turned on or off within the field of view. 

• ObjectVideo VEW sensors that have not been assigned a video source appear 
briefly in Searching for Known View status, and then become Unknown 
View. Assign a video source to the sensors using the instructions in 
“Assigning a Video Source to a Sensor” on page 60. 

• You may not have created an initial view for a VEW Standard, VEW HiRes, or 
VEW Leader/Follower sensor. These sensors require that you create at least 
one view before they can detect any events. See “Creating a View” in the Rule 
Management Tool Help for more information. 

• If a PTZ camera is being used, the camera may have been moved away from 
a known view. You can move the camera back to a field of view the sensor 
recognizes as a known view. If your sensor supports multiple views, you can 
also designate the current field of view as a known view. If your sensor does 
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not support multiple views, you can also force the field of view to become a 
known view. To force a view, click the Force button between the two 
snapshots in the upper portion of the View tab. When the Force View dialog 
appears, select a view from the list of stored views and click the Force View 
button. The Forcing View dialog is displayed until the view is successfully 
added. 

• If a multiplexer is being used, the multiplexer may have switched to another 
camera that has no known view defined for it. You can switch to a camera 
that has a known view defined for it. If your sensor supports multiple views, 
you can also designate the current field of view as a known view. If your 
sensor does not support multiple views, you can also force the field of view to 
become a known view. 

• If the camera is an outdoor camera, it is possible that nightfall or the sun 
rising may have caused the system to stop recognizing the view. This can 
happen if the view for the sensor was defined during dusk or dawn. In such a 
case, the system may compare the original view with the view from a 
different time of day and determine that they are not the same because of 
the lighting difference. 

For sensors that support multiple views, you can create two views using the 
Rule Management Tool. Create one view during the daytime and the other 
view during the nighttime. Some trial-and-error may be required. In some 
cases, you may need to create more than two views (for example, an 
additional twilight view and an additional dawn view). 

For sensors that support a single view, force the view so that the current field 
of view becomes the sensor’s known view. You will need to force the view 
again if the lighting changes and the sensor enters an unknown view again. 

Note: This problem can occur if you are using a camera that does not support 
night vision. The ObjectVideo software’s ability to detect events during the 
night may be diminished if you are using a camera that does not support 
night vision and there is inadequate artificial light. If you encounter this 
problem frequently, it is highly recommended that you use cameras that 
support night vision. 

• If the system no longer recognizes the live camera feed as a known view (for 
example, an outdoor camera’s feed after a heavy snowfall), you can force the 
view. You can also force a view if you want an ObjectVideo OnBoard sensor 
that only supports a single view to monitor a different field of view than the 
one the camera was in when the video source was assigned to the sensor. 
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Unvalidated Sensor Status 

Article Number: 1502 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

Summary: 

In the Properties tab, the Status field of the sensor lists the status as 
Unvalidated. In addition, a question mark appears beside one or more sensor 
icon(s) in the Rule Management Tool and System Configuration Tool. When a sensor 
is in an Unvalidated status, the sensor is unable to detect events in real time. A 
sensor that supports forensics data may no longer generate useful primitives and 
video. A VEW Leader/Follower sensor cannot follow an object involved in an event. 

Note: If an Unvalidated sensor status appears immediately after system 
installation, the problem is license-related. 

Solution: 

The following list describes possible causes and solutions: 

• You may not have installed licenses to use the ObjectVideo system. This may 
be the case if all of the sensors in your system have an Unvalidated status. 
Follow the instructions in “Installing Licenses” page 41 to install the 
appropriate licenses, and then restart all the ISE software in your system (see 
“Starting and Stopping the ISE Services” on page 136). After you do so, wait 
a few minutes, and then refresh the System Configuration Tool or Rule 
Management Tool by clicking the Refresh Configuration button. 

• You may have added sensors to the ObjectVideo system for which you have 
not purchased or installed licenses. To purchase additional licenses, contact 
customer support (see “Getting Support” on page 223). Once you’ve received 
your new license file, install the licenses according to the instructions in 
“Installing Licenses” page 41. 

• The sensor running on the ISE computer may not have responded during the 
time set for the synchronization. Increase the Synch Wait (secs) time in the 
Rule Management Tool or System Configuration Tool Options dialog (see 
“Sensor Synchronization Times Out and Operation Timed Out Message 
Appears” on page 189 for more information). 

• The sensors on the ISE computer may be under a heavy load that makes 
them slow to respond to the Rule Management Tool and System Configuration 
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Tool. A system administrator should investigate by checking the sensor load, 
rebooting the computer running the ISE software, or contacting customer 
support (see “Getting Support” on page 223). 

• If the sensor running on the ISE computer went down unexpectedly, the 
ObjectVideo Server may not immediately report that the sensor is gone and 
may still report it in the list of the sensors. Clicking the Refresh 
Configuration button should display the updated configuration. 
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Loading Snapshot Graphic Appears Instead of a Camera Snapshot 

Article Number: 1368 

Found In: Rule Management Tool and System Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

In the View tab for a sensor or view (views only appear in the Rule Management 
Tool), no snapshots of the camera’s video feed are displayed. Loading Snapshot 
graphics appear in place of camera snapshots 

Before Using this Solution: 

Before you perform the steps in this article, click Configuration > Refresh in the 
System Configuration Tool and Rule Management Tool and verify that the sensor 
icons still appear. If the sensor icons do not appear, see “ISE Not Communicating 
with the ObjectVideo Server” on page 186. 

This troubleshooting article assumes that you are using Apache as the web server on 
the computer running the ObjectVideo Server software. If you are using a different 
web server, contact customer support (see “Getting Support” on page 223). 

Solution: 

Snapshots may not appear in the View tab for a sensor or view if there is a problem 
with the web server used to store the snapshots. Loading Snapshot graphics 
appear in the place of the snapshots. The web server hosts alert snapshots so that 
they are available to the Rule Management Tool and System Configuration Tool. 
Loading Snapshot graphics can be the result of any of the following: 

• The web server is unable to connect to the network. 

• The web server software is not running. 

• An invalid document home directory or port number for the web server was 
specified when the ObjectVideo Server software was installed. 

To diagnose and solve the web server problem: 
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1. Open a browser, such as Internet Explorer, on a computer running the Rule 
Management Tool. 

2. Browse to http://server/. 

The server is the host name of the ObjectVideo Server. An Apache web page 
should appear. 

3. Do one of the following: 

• If an Apache web page does not appear, you are unable to contact the web 
server. The client application computer may not be able to communicate with 
the web server because of a network problem (see Appendix B, “Diagnosing 
Network Problems,” on page 237 for more information). 

If you do not find a network problem, the Apache web server may not be 
running. On the computer running the ObjectVideo Server, select Start > 
Control Panel > Performance and Maintenance > Administrative Tools 
> Services, locate Apache2 in the list of applications, and click Start or 
Restart. When the Apache server status is Started, proceed to step 15. 

• If an Apache web page does appear but snapshots still do not appear, 
proceed to step 4. 

4. Open the Rule Management Tool. 

5. Select the first sensor icon in the configuration. 

6. Click the View tab. 

7. Click the Debug Log button to open the debug log. 

 

8. Double-click with your mouse anywhere on the debug log window to clear the 
log. 

9. On the View tab, click the Refresh button that is between the Live Camera 
Feed and Active View snapshots (this is not the same button as the Refresh 
Configuration button on the toolbar). 

Log data appears in the debug log. 

10. In the debug log, scroll to the first line that begins with the tag <ImageUrl>. 

11. Select the text between the tags <ImageUrl> and </ImageUrl>. 

This is the location of the camera snapshot on the web server. 

12. Copy the text by clicking Ctrl + C on your keyboard. 

13. Paste the text (Ctrl + V) into a browser. 

 201 
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14. Do the following: 

• If a camera snapshot does not appear in the browser, proceed to step 15. 

• If a camera snapshot appears in the browser, contact customer support (see 
“Getting Support” on page 223). 

15. When you entered the web server’s home directory and port during the 
installation of the ObjectVideo Server software, you entered the wrong directory 
and/or port or did not enter a \ at the end of the path. See “Changing the 
ObjectVideo Server Settings” on page 133. 

16. After performing one of the solutions listed above, click the Refresh 
Configuration button to confirm that a camera snapshot is now displayed. 
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Alert Console Troubleshooting 

Troubleshooting Article Page 

Server Status is Offline, Lost Connection, or No Connection 204

Cannot Test Alert Sound 205

Cannot Find Video Source Alert 206

Health Monitor Alert: Attention! Lost communication with <host name or 
IP address>. The system may have stopped detecting new events. 
Contact customer support or your system administrator immediately.

207

Health Monitor Alert: Attention! Lost communication with the following 
ISE: <host name or IP address>. If this is unexpected, contact customer 
support or your system administrator.

208

Health Monitor Alert: Lost communication with a sensor. 209

Health Monitor Alert: Attention! <sensor name> is not operating in a 
Known view when in follower mode.  

210
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Server Status is Offline, Lost Connection, or No Connection 

Article Number: 1320 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

One of the following Server Status messages appears in the lower left corner of the 
Alert Console: Offline, Lost Connection, or No Connection. 

Solution: 

If the ObjectVideo Server status is not Online, the ObjectVideo components are not 
communicating correctly, and the Alert Console is unable to receive new alerts. 

The following list contains possible causes and their solutions: 

• The ObjectVideo Server computer may not be running. Turn on the computer 
running the ObjectVideo Server software. 

• The ObjectVideo Server services may not be running. See “Starting and 
Stopping ObjectVideo Server Services” on page 134 to verify whether the 
ObjectVideo Server services are running, and start them if necessary. 

• There may be network trouble. Resolve any networking issues. See 
Appendix B, “Diagnosing Network Problems,” on page 237 for more 
information. 
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Cannot Test Alert Sound 

Article Number: 1030 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

Summary: 

I do not hear anything when I select Test Alert Sound from the Tools menu. 

Solution: 

Check the volume of the computer’s speaker(s). If the computer is using external 
speakers, check to make sure that the speakers are properly connected to the 
computer, the speakers are plugged in, and the power to the speakers is on. 

In rare cases, if another application is using the computer’s sound card when an 
audible alert is triggered, that application may prevent the Alert Console from 
playing the alert sound. If you suspect that this is the case, quit other applications 
that may be using the sound card. 
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Cannot Find Video Source Alert 

Article Number: 1315 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

Summary: 

A Cannot Find Source Video alert appears instead of a snapshot. 

Solution: 

If a Cannot Find Source Video message appears instead of a snapshot (digital 
picture), the system was unable to retrieve a frame from the surveillance camera’s 
video stream. The message does not mean that the system or the camera is not 
working. It only indicates that the sensor was unable to process the video stream 
and was unable to provide you with one of the snapshots of the event. 

If this occurs frequently, open the Rule Management Tool and verify that the sensor 
monitoring the video feed is receiving a video signal. A Bad Signal status indicates 
the video feed is not receiving a signal (see “Bad Signal Sensor Status” on page 
191). 

If you are receiving a video signal, stop the ISE services and restart them using the 
instructions in “Starting and Stopping the ISE Services” on page 136. If the problem 
continues and you are using ObjectVideo OnBoard, reset the Video Analysis Device. 
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Health Monitor Alert: Attention! Lost communication with <host name or IP 
address>. The system may have stopped detecting new events. Contact 
customer support or your system administrator immediately.  

Article Number: 1149 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

Summary: 

In the Alert Console, I received a health monitor alert with the following message: 
Attention! Lost communication with <host name or IP address>. The system 
may have stopped detecting new events. Contact customer support or your 
system administrator immediately. 

Solution: 

The ObjectVideo Server cannot communicate with a computer on the system. The 
failure could occur on any computer in the ObjectVideo system except the computers 
running FAST, the Camera Placement Tool, and the Alert Backup Estimator 
(assuming no other ObjectVideo software is installed on the same computers). The 
host name or IP address is of the computer that the ObjectVideo Server cannot 
communicate with. The network is experiencing an outage or excessive latency 
because of an operating system or hardware issue. When this alert appears, the 
system may not be operating properly. See Appendix B, “Diagnosing Network 
Problems,” on page 237 for more information. 



Troubleshooting 

 208 

Health Monitor Alert: Attention! Lost communication with the following ISE: 
<host name or IP address>. If this is unexpected, contact customer support 
or your system administrator. 

Article Number: 1504 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 3.0 or later (Standard, HiRes, FlowControl, Leader/Follower) 

• ObjectVideo OnBoard 3.0 or later (100, 200, 1000) 

• ObjectVideo Forensics 3.0 or later 

Summary: 

In the Alert Console, I received a health monitor alert with the following message: 
Attention! Lost communication with the following ISE: <host name or IP 
address>. If this is unexpected, contact customer support or your system 
administrator. 

Solution: 

If this health monitor alert is displayed, an ISE within the system has lost 
communication with the ObjectVideo Server. This means that new events are not 
being detected. Sensors that support forensics data may no longer generate useful 
primitives and video. 

This may occur for the following reasons: 

• The ISE computer is turned off. Turn on the computer. 

• The Daemon Service may not be running on the ISE computer. Start the 
Daemon Service using the instructions in “Starting and Stopping the ISE 
Services” on page 136. 

• The ISE computer has lost its connection with the network. Be sure that the 
ISE computer is properly connected to the network (see Appendix B, 
“Diagnosing Network Problems,” on page 237 for more information). 
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Health Monitor Alert: Lost communication with a sensor. 

Article Number: 1416 

Found In: Alert Console 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

In the Alert Console, I received a health monitor alert with the following message: 
Lost communication with a sensor. 

Solution: 

The system can no longer connect to a sensor. Within 5 to 10 seconds this health 
alert is usually followed by a System Functioning Properly health monitor alert 
that indicates that communication has been restored. If communication is not 
restored, use one of the following solutions to correct the problem: 

• A surveillance camera may be unplugged or turned off. Verify that the camera 
is connected to the ISE computer or Video Analysis Device and turned on. 

• The computer running the ISE software may be turned off. Turn on the 
computer. 

• The number of active sensors may have changed. This would occur if the 
ObjectVideo Management Tool was used to reduce the number of active 
sensors on the ISE. Open the ObjectVideo Management Tool on the computer 
running the ISE software and verify that the number of active sensors 
matches the number of sensors that should be running on the ISE. 

• The Daemon Service may not be running on the computer where the ISE 
software is installed. Start the Daemon Service using the instructions in 
“Starting and Stopping the ISE Services” on page 136. 

• Verify in the ObjectVideo Management Tool that the ISE is communicating 
with the correct ObjectVideo Server. See the ObjectVideo Management Tool 
Help for more information. 
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Health Monitor Alert: Attention! <sensor name> is not operating in a Known 
view when in follower mode. 

Article Number: 1472 

Found In: Alert Console 

Product(s) Affected: ObjectVideo VEW 3.0 or later (Leader/Follower) 

Summary: 

In the Alert Console, I received a health monitor alert with the following message: 
Attention! <sensor name> is not operating in a Known view when in 
follower mode. 

Solution: 

The health alert indicates that the PTZ camera the sensor is monitoring has begun 
following an object. In VEW Leader/Follower, PTZ cameras can begin following an 
object in response to a rule violation.  

The sensor goes into Following status, and remains in that status until it is done 
tracking the object. While the Following status does not indicate a problem, a 
sensor in this status cannot detect any new events. Sensors that support forensics 
data may no longer generate useful primitives and video. 

When the sensor stops following the object, its status is determined by how you set 
up the follow object response in the Rule Management Tool: 

• If the sensor is to Return to Initial View after tracking, then it will return to a 
Known View status. 

• If the sensor is to Remain in Current View after tracking, then it will switch to 
an Unknown View status. It will remain in that status until the sensor goes back 
into Following status in response to another rule violation. A health monitor 
alert does not appear when a sensor goes from an Unknown View status to a 
Following status. 
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Leader/Follower Calibration Tool Troubleshooting 

Error: Communication Error 

Article Number: 1509 

Found In: Leader/Follower Calibration Tool 

Product(s) Affected: ObjectVideo VEW 3.0 or later (Leader/Follower) 

Summary: 

While attempting to run the Leader/Follower Calibration Tool, you receive the 
Communication Error dialog with the following message: 

ObjectVideo Daemon Service must be started for the Leader/Follower 
Calibration Tool to run. 

Solution: 

This problem occurs if you attempt to run the Leader/Follower Calibration Tool on a 
computer where the Daemon Service is not in a Running state. 

To correct the problem, do the following: 

1. Open the ObjectVideo Management Tool: 

• In Windows 2000, select Start > Programs > ObjectVideo > ObjectVideo 
Management Tool. 

• In Windows XP, select Start > All Programs > ObjectVideo > 
ObjectVideo Management Tool 

2. Click the Start button to the right of ObjectVideo Daemon Service. 
 
The status field next to ObjectVideo Daemon Service changes to Running. 
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Parameter Configuration Tool Troubleshooting 

Error Message: Communication Failure 

Article Number: 1390 

Found In: Parameter Configuration Tool 

Product(s) Affected: 

• ObjectVideo VEW 2.5 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.5 or later 

Summary: 

The red dot status symbol and/or the Error: Communication Failure message 
appear at the bottom of the Parameter Configuration Tool window. 

Solution: 

One of the following may have occurred: 

• The Daemon Service is not running on the local computer. On the computer 
running the client applications, open the ObjectVideo Management Tool and 
click the Start button next to ObjectVideo Daemon Service. 

• The Parameter Configuration Tool is incompatible with the versions of one or 
more of the other ObjectVideo software components running within your 
system. The version 3.0 Parameter Configuration Tool (installed with the 
ObjectVideo Integrator Toolkit 3.0) should only be used with ObjectVideo 
VEW 3.0 or ObjectVideo OnBoard 3.0 software. For example, if you are 
running the version 3.0 Parameter Configuration Tool, but you have a version 
2.0 VEW/OnBoard client application installed on the local computer, the 
Parameter Configuration Tool will not be able to communicate properly with 
the Daemon Service. 

To correct this problem, check for the version number of each application 
(starting with the Parameter Configuration Tool computer) by selecting About 
from the Help menu. Uninstall any ObjectVideo software that is not 
compatible, and then install the compatible version of the software. 
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• See “Server Status is Offline, Lost Connection, or No Connection” section on 
page 204 for information on problems that can affect the system’s ability to 
communicate. 

• Your network may be experiencing extreme latency. Identify and fix any 
issues that are slowing down the network. See Appendix B, “Diagnosing 
Network Problems,” on page 237 for more information. 
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Object Sizing Tool Troubleshooting 

Error Message: Communication Failure 

Article Number: 1359 

Found In: Object Sizing Tool 

Product(s) Affected:  

• ObjectVideo VEW 2.5 or later (Standard, HiRes) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

Summary: 

The red dot status symbol and/or the Error: Communication Failure message 
appear at the bottom of the Object Sizing Tool window. 

Solution: 

One of the following may have occurred: 

• The Daemon Service is not running on the local computer. On the computer 
running the client applications, open the ObjectVideo Management Tool and 
click the Start button next to ObjectVideo Daemon Service. 

• See “Server Status is Offline, Lost Connection, or No Connection” section on 
page 204 for information on problems that can affect the system’s ability to 
communicate. 

• Your network may be experiencing extreme latency. Identify and fix any 
issues that are slowing down the network. See Appendix B, “Diagnosing 
Network Problems,” on page 237 for more information. 
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FAST Troubleshooting 

FAST Is Unable to Start Message 

Article Number: 1441 

Found In: FAST 

Product(s) Affected: ObjectVideo Forensics 2.5 or later 

Summary: 

When I attempt to start FAST, the following error message appears: FAST cannot 
start because it is unable to obtain the software license. Please contact a 
system administrator or customer support for assistance. 

Solution: 

FAST cannot connect to the license server. FAST must be able to connect to the 
license server in order to start. The license server runs on the ObjectVideo Server 
computer. One of the following may have occurred: 

• FAST may not be able to connect to the license server because your computer 
is not connected to the network or there is another network problem. See 
Appendix B, “Diagnosing Network Problems,” on page 237 for more 
information. 

• The computer running the ObjectVideo Server software may not be running. 
Turn it on. 

• You may not have installed licenses to use the ObjectVideo system. Follow the 
instructions in “Installing Licenses” on page 41 to install the appropriate 
licenses. After the licenses are installed, stop and start the ISE services on 
each computer, as described in “Starting and Stopping the ISE Services” on 
page 136. 

• The license server software on the ObjectVideo Server computer may not be 
running. See “Starting and Stopping the Sentinel LM License Management 
Service” on page 136 for instructions on starting the service. 

• All of the licenses for FAST may be in use. FAST licensing allows a limited 
number of instances of FAST to be running at one time. The licenses are 
available on a first-come, first-served basis. To upgrade the system to 
support more simultaneous uses of FAST. See “Upgrading FAST” on page 146 
for more information. 

• If your computer is not currently connected to the network on which the 
license server is running but you previously checked out an authorization to 
open FAST, the authorization may have expired. You will need to reconnect to 
the network and check out an authorization to use FAST again. See “Checking 
Out an Authorization for Opening FAST Offline” on page 130 for more 
information. 
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Forensics Store Service Troubleshooting 

Forensics Store Service Not Generating Forensics Data 

Article Number: 1476 

Found In: Forensics Store service 

Product(s) Affected: ObjectVideo Forensics 3.0 or later 

Summary: 

For an ObjectVideo VEW sensor or ObjectVideo OnBoard sensor with metadata, 
forensics data (primitives and video) are not being generated in the forensics data 
directory. 

Solution: 

One of the following may have occurred: 

• The Forensics Store service may not be running. See “To Start the Forensics 
Store Service” on page 128 for instructions on how to start the service. 

• In the ObjectVideo Management Tool, the option to turn on forensics data 
generation for a sensor may not be selected. See “To Enable Forensics Data 
Storage” on page 128 for instructions on how to enable forensics for a sensor. 

• The name of the forensics data directory may contain a space or the wrong 
forensics data directory may be specified on the computer running the ISE 
software. Rename the directory, and then run the ObjectVideo Management 
Tool. In the Forensics Store tab, change the Store Base Directory setting 
to match the renamed forensics data directory, and then click Apply. 
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Maintenance Troubleshooting 

Troubleshooting Article Page 

ObjectVideo Database Not Automatically Purged (Database Size Less than 
Maximum Allowable Size)

218

ObjectVideo Database Not Automatically Purged (Database Size Exceeds 
Maximum Allowable Size)

222
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ObjectVideo Database Not Automatically Purged (Database Size Less than 
Maximum Allowable Size) 

Article Number: 1141 

Found In: ObjectVideo database 

Product(s) Affected: 

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

Summary: 

When you verified the purging of the ObjectVideo database (as explained in 
“Checking the Size of the Database” on page 118), you found that the database was 
not purged at the size set in the Purge Database at This Size (MB) field of the 
ObjectVideo Server installer. The database has not yet reached its maximum size 
limit (2 GB [2,000 MB] for an MSDE database). 

Solution: 

Contact customer support to determine why the purge has not taken place 
automatically (see “Getting Support” on page 223). You may be instructed to 
manually purge the database before it exceeds the maximum allowable size (2 GB 
for an MSDE database). If you are not using the MSDE database, contact customer 
support for information on maintaining the database. 

Before purging the database, export important alerts to HTML files using the 
instructions in “Exporting Alerts to an HTML File” on page 116. If you do not create 
alert reports, you will not have any record of stored alerts. 

Unlike automatically purging the database, manually purging the database 
permanently deletes all alerts in the database. Purging the database does not affect 
any of the system information (views, sensor groups, etc.) stored in the database. In 
addition, the purging script copies the alert data to a file in a directory on the 
computer running the ObjectVideo Server software.  

The backupObjectStore.bat script enables you to purge the database. It is 
installed on the computer running the ObjectVideo Server software in C:\Program 
Files\ObjectVideo\Server by default. 

The commands described in this troubleshooting article need to be run from the 
command prompt on the computer running the ObjectVideo Server software. To 
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access the command prompt in Windows, click Start > Run, type cmd in the Open 
field, and then click OK. 

This troubleshooting article describes two approaches to purging the database: 

• Purging the database and copying the data to a default location on the 
computer running the ObjectVideo Server software (C:\Program 
Files\ObjectVideo\Server\Data) 

• Purging the database and copying the data to a location on the computer 
running the ObjectVideo Server software that you specify 

Follow the instructions in the sections that follow to manually purge the database. 

Important: 

• If you allow the database to reach 2 GB in size, you will not be able to purge the 
database using the approach described in this section. If this occurs, contact 
customer support for assistance (see “Getting Support” on page 223).  

• You should only purge the database while alert generation and other database 
activity are at a lull or not taking place. Purging is possible while the database is 
in use, but it is not recommended. 

Purging and Copying to the Default Location 

By default, the purging script copies the ObjectVideo database data to the following 
directory on the computer running the ObjectVideo Server software: 

C:\Program Files\ObjectVideo\Server\Data 

Follow the instructions in this section to purge the database and copy the alert data 
to this directory. 

To Purge and Copy to the Default Location 

1. From a command prompt on the computer running the ObjectVideo Server 
software, change directories to the ObjectVideo Server installation directory. 

To change directories, type the following in the command prompt window, and 
then press Enter: 

cd C:\Program Files\ObjectVideo\Server 

The command prompt displays the following: 

C:\Program Files\ObjectVideo\Server> 

2. Type the following text in the command prompt, and then press Enter: 

backupObjectStore.bat hostname installationkey 
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The hostname is the host name of the computer running the ObjectVideo Server 
software, and the installationkey is the installation key used when installing 
the ObjectVideo Server software on that computer. Omit any hyphens in the 
installation key. 

For example, if the ObjectVideo Server’s host name is server1 and the installation 
key is 12345, you would type the following in the command prompt: 

backupObjectStore.bat server1 12345 

Text that resembles the following appears on the command prompt: 

 

The alerts are copied to the default-objectstore.bak file in the Data directory. 

3. Wait a few minutes for the process to finish. 

4. In Windows Explorer, browse to the  
C:\Program Files\ObjectVideo\Server\Data directory, and then rename the 
default-objectstore.bak file. 

This ensures that, the next time you perform the purge, the file that is created 
does not write over the old file. 

Purging and Copying to an Alternate Location 

If you do not wish to copy the alert data to the default location (C:\Program 
Files\ObjectVideo\Server\Data) when you purge the ObjectVideo database, do 
the following: 

1. Using Windows Explorer or the command prompt, create the alternate directory 
in which you want to store the alert data (if it does not already exist). 

2. From a command prompt on the computer running the ObjectVideo Server 
software, change directories to the ObjectVideo Server installation directory. 

To change directories, type the following in the command prompt window, and 
then press Enter: 

cd C:\Program Files\ObjectVideo\Server 
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The command prompt displays the following: 

C:\Program Files\ObjectVideo\Server> 

3. Type the following text in the command prompt, and then press Enter: 

backupObjectStore.bat hostname installationkey path 

The hostname is the host name of the computer running the ObjectVideo Server 
software, and the installationkey is the installation key used when installing 
the ObjectVideo Server software on that computer. Omit any hyphens in the 
installation key. The path is the directory path and file name (no spaces) to 
which you want to copy the alert data. 

For example, if the ObjectVideo Server’s host name is server1, the installation 
key is 12345, and you want to copy to C:\ObjectVideoDatabaseBackup\Q1-
2004.bak, you would type the following in the command prompt: 

backupObjectStore.bat server1 12345 C:\ObjectVideoDatabaseBackup\Q1-
2004.bak 

Text that resembles the following appears on the command prompt: 

 

Notes: 

• Alternate directory paths and file names containing spaces are not supported. 

• You must carefully type the exact file name and location, or the operation will not 
succeed. 

• Running backupObjectStore.bat with no arguments displays help text for the 
script. 

• Once the ObjectVideo database has been purged, you should confirm the purge 
has been successful by checking the size of the database. For more information, 
see “Checking the Size of the Database” on page 118. Since groups, views, and 
other sensor information are not purged, the ObjectVideo database may still 
contain data after the purge. 
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ObjectVideo Database Not Automatically Purged (Database Size Exceeds 
Maximum Allowable Size) 

Article Number: 1142 

Found In: ObjectVideo database 

Product(s) Affected:  

• ObjectVideo VEW 2.0 or later (Standard, HiRes, FlowControl) 

• ObjectVideo VEW 3.0 or later (Leader/Follower) 

• ObjectVideo OnBoard 1.5 or later (100, 200) 

• ObjectVideo OnBoard 3.0 or later (1000) 

• ObjectVideo Forensics 2.0 or later 

Summary: 

The database was not purged at the size set in the Purge Database at This Size 
(MB) field of the ObjectVideo Server installer. The database has exceeded the 
maximum size limit (2 GB for the MSDE database). When you checked the size of the 
ObjectVideo database (as explained in “Verifying a Purge Has Occurred” on 
page 117), the database size was equal to or more than 2 GB. 

Solution: 

If the ObjectVideo database has exceeded the maximum size limit, you must contact 
customer support for instructions on how to purge the database (see “Getting 
Support” on page 223). 



 

Getting Support 
Sales 

If you are purchasing the software from ObjectVideo Sales, use the following 
methods to obtain software components or licenses: 

• Call 703-654-9300. 

• Send an e-mail message to sales@objectvideo.com. 

Customer Support 

Before contacting customer support, refer to the “Troubleshooting” (page 156) 
chapter of this document to see if the problem you are encountering is described 
there. 

If ObjectVideo Customer Care is providing your customer support services, use one 
of the following methods to contact them: 

• Go to http://www.objectvideo.com/customercare. 

• Send an e-mail message to support@objectvideo.com. 

 223 



 

Appendix A: Prerequisite Software 
Third-party software is required for most ObjectVideo software. In most cases, an 
installer for each of the third-party applications is included on the installation CD of 
the ObjectVideo component that requires the software. This appendix lists the 
required software and describes how to install it. It consists of the following sections: 

• “ObjectVideo Server and ISE Software Requirements” on page 225 lists the 
software required for the ObjectVideo Server and ISE software. 

• “Client Application Software Requirements” on page 226 lists the software 
required for the ObjectVideo client applications. 

• “Installing Prerequisite Software” on page 227 provides step-by-instructions 
for installing the prerequisite software. 

Note: ObjectVideo and its partners pre-install software before ObjectVideo-certified 
computers are delivered for deployment. See “ObjectVideo Server and ISE Hardware 
Requirements” on page 17 for more information. 
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ObjectVideo Server and ISE Software Requirements 

The table that follows lists the prerequisite software required to run the ObjectVideo 
Server and ISE software and the page on which the installation instructions are 
provided. The prerequisites vary based on whether you are running the ObjectVideo 
Server software only, the ISE software only, or both the ObjectVideo Server and ISE 
software on the computer. The third-party requirements apply to both ObjectVideo 
VEW and ObjectVideo OnBoard systems. 

Note: Contact customer support for instructions on installing the Conexant Video 
Capture Card Driver. 

Table 21: ObjectVideo Server and ISE Software Requirements 

Required 
Software 

ObjectVideo 
Server 

Computer 

ISE 
Computer 

Server/ISE 
Computer 

Page 

Apache HTTP 
Server 2.0    228

Conexant 
BtPCI WDM 
Video Capture 
Card Driver 
5.3.2.0 

   N/A  

Microsoft .NET 
Framework 1.1    233

Microsoft 
DirectX 9.0b    231

Microsoft 
Message 
Queuing 
(MSMQ) 

   232

Microsoft SQL 
Server Desktop 
Engine (MSDE) 

   234

MPEG-4 Video 
Compressor    236
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Client Application Software Requirements 

The following table shows the prerequisite software applications required by each of 
the ObjectVideo client applications and the page on which the installation instructions 
are provided. 

Table 22: Client Application Software Requirements 

Required 
Software 

VEW/OnBoard 
Client 

Applications 
FAST 

ObjectVideo 
Integrator 

Toolkit 
Page 

Java Runtime 
Environment 
1.4.2_03 

   229

Microsoft .NET 
Framework 1.1    233

Microsoft Data 
Access 
Components 
(MDAC) 2.7 

   230

Microsoft 
DirectX 9.0b 

   231

Windows 
Media Player 9 

   235

MPEG-4 Video 
Compressor 

   236
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Installing Prerequisite Software 

This section describes how to install the third-party software required for the 
ObjectVideo components. See the previous sections in this appendix for information 
about where to install the prerequisite software. 

The order in which you install the prerequisite software does not matter. Usually, 
each application’s installer will prompt you to reboot the computer after the 
installation is complete. However, if you are installing multiple applications, you may 
postpone rebooting the computer until all prerequisite software is installed for that 
computer. 

Note: You must be logged in as a Windows user with Administrator privileges to 
install new software. 
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Installing the Apache HTTP Server 

The ObjectVideo Server software requires Apache HTTP Server 2.0 to function 
properly. 

If you are already running an HTTP server other than Apache and wish to keep it 
after installing Apache, temporarily stop the non-Apache server while you are 
installing Apache and the ObjectVideo Server. Also ensure that there is no port 
conflict between the two HTTP servers. For example, if the non-Apache server is 
assigned to port 80, you will either have to reassign it to another HTTP port (like port 
8080) or assign Apache to an HTTP port other than 80. If assigning Apache to a port 
other than 80, ensure that you point to that port during the ObjectVideo Server 
installation process. 

To Install the Apache HTTP Server 

1. In the Windows Control Panel, open Add or Remove Programs. 

2. Scroll through the list of currently installed programs, and see if Apache2 
appears in the list. 

• If Apache2 is not listed, proceed to step 3.  

• If Apache2 is listed, you do not need to install it. 

3. On the ObjectVideo Server installation CD, double-click the apache_2.0.54-
win32-x86_no_ssl.exe file in the Apache folder. 

4. Follow the instructions on the screen to install the software. 

5. Select Start > Control Panel > Performance and Maintenance > 
Administrative Tools > Services. 

6. Locate Apache2 in the list of services. 

7. Confirm that the Status is Started. 

If the Status is not Started, right-click the Apache2 service and select Start. 
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To Install the Java Runtime Environment 

FAST requires Java Runtime Environment 1.4.2_03 to function properly. 

1. In the Windows Control Panel, open Add or Remove Programs. 

2. Scroll through the list of currently installed programs, and see if Java 2 Runtime 
Environment, SE v.1.4.2_03 appears in the list. 

• If Java 2 Runtime Environment, SE v.1.4.2_03 is not listed, proceed to 
step 3.  

• If Java 2 Runtime Environment, SE v.1.4.2_03 is listed, you do not need 
to install it. 

3. Use Windows Explorer to browse to the installation CD. 

4. In the JavaRuntime folder, double-click  
j2re-1_4_2_03-windows-i586-p.exe. 

The Java Runtime Environment installer may take some time to start. 

5. Follow the instructions on the screen to install the software. 
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To Install MDAC 

The VEW/OnBoard client applications require MDAC 2.7 to function properly. 

Note: In Windows XP, MDAC is usually installed during the installation of 
Microsoft .NET Framework 1.1. If you are using Windows 2000, MDAC requires a 
separate installation. 

To install MDAC, take the following steps: 

1. Use Windows Explorer to browse to the VEW/OnBoard client applications 
installation CD. 

2. In the MDAC folder, double-click mdac_typ.exe. 

3. Follow the instructions on the screen to install the software. 
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To Install Microsoft DirectX 

The ObjectVideo Server, ISE, and FAST software require Microsoft DirectX 9.0b to 
function properly. 

1. Select Run from the Start menu. 

2. In the Open field, type msinfo32 and click OK. 

The System Information window opens. 

3. Do one of the following: 

• In Windows XP, select DirectX Diagnostic Tool from the Tools menu. 

• In Windows 2000, select Tools > Windows > DirectX Diagnostic Tool. 

4. In the System Information area at the bottom of the window, verify that the 
Microsoft DirectX version number is 9.0b or higher. If the version number is not 
9.0b or higher, proceed to step 5. 

5. Use Windows Explorer to browse to the installation CD. 

6. Double-click the dxsetup.exe file found in DirectX folder. 

7. Follow the instructions on the screen to install the software. 
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To Install MSMQ 

The ISE software requires MSMQ to function properly. 

1. In the Windows Control Panel, open Add or Remove Programs. 

2. Click the Add/Remove Windows Components button. 

The Windows Components Wizard screen opens. 

3. Do one of the following: 

• If Message Queuing is not selected, select it and proceed to step 4. 

• If you attempt to select Message Queuing and are prompted to enter the 
Windows XP installation CD, insert the CD and follow the directions to enable 
message queuing. 

4. Click Next. 

5. The Configuring Components screen appears while message queuing is 
enabled, followed by the Completing the Windows Components Wizard 
screen. 

6. Click Finish. 
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To Install the Microsoft .NET Framework 

The ObjectVideo Server, ISE, FAST, and the ObjectVideo Integrator Toolkit software 
require Microsoft .NET Framework 1.1 to function properly. 

1. In the Windows Control Panel, open Add or Remove Programs. 

2. Scroll through the list of currently installed programs and see if Microsoft .NET 
Framework 1.1 appears in the list. 

• If Microsoft .NET Framework 1.1 is not listed, proceed to step 3. 

• If Microsoft .NET Framework 1.1 is listed, you do not need to install it. 

3. Use Windows Explorer to browse to the installation CD. 

4. In the DotNET folder, double-click dotnetfx.exe. 

The installer may take some time to start. 

5. Follow the instructions on the screen to install the software. 
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To Install MSDE 

The ObjectVideo Server software requires MSDE to function properly. 

1. In the Windows Control Panel, open Add or Remove Programs. 

2. Scroll the list of currently installed programs, and see if Microsoft SQL Server 
Desktop Engine appears in the list: 

• If Microsoft SQL Server Desktop Engine is not listed, proceed to step 3. 

• If Microsoft SQL Server Desktop Engine is listed, you do not need to 
install it. 

3. Use Windows Explorer to browse to the ObjectVideo Server installation CD. 

4. In the MSDE folder, double-click setup.exe. 

5. Follow the instructions on the screen to install the software. 
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To Install Windows Media Player 9 

FAST requires Windows Media Player 9 to function properly. 

1. In Windows XP, click Start > Run. 

2. Type wmplayer.exe in the Open field. 

3. Click OK. 

4. Do one of the following: 

• If Windows Media Player opens, select About Windows Media Player from 
the Help menu to see the version number. If you have never run Windows 
Media Player on the computer, you may have to complete the Windows Media 
Player installation before you have access to the Help menu. You will be 
prompted to complete the installation. If the version number is 9.0 or 
greater, you do not have to install Windows Media Player. If the version 
number is less than 9.0, proceed to step 5. 

• If Windows Media Player does not open, proceed to step 5. 

5. Use Windows Explorer to browse to the installation CD. 

6. Do one of the following: 

• In Windows 2000, double-click the MPSetup.exe file found in 
WindowsMediaPlayer\Win2000. 

• In Windows XP, double-click the MPSetupXP.exe file found in 
WindowsMediaPlayer\WinXP. 

7. Do one of the following: 

• If a dialog appears indicating that Windows Media Player 9 is already 
installed, no further action is necessary. 

• Follow the instructions on the screen to install the software. 
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To Install the MPEG-4 Video Compressor 

ObjectVideo ISE and FAST both require the MPEG-4 Video Compressor to function 
properly. 

1. Use Windows Explorer to navigate to the SYSTEM32 folder where Windows is 
installed (usually C:\WINDOWS\SYSTEM32). 

2. Determine if you have the MPG4C32.dll file in this folder. 

3. If you have this file, the proper video compressor has already been installed. If 
you do not have this file in this location, proceed to step 4. 

4. Use Windows Explorer to browse to the installation CD. 

5. In the VideoCompressors folder, double-click wmtools.exe. 

6. Follow the instructions on the screen to install the software. 



 

Appendix B: Diagnosing Network 
Problems 
As you deploy ObjectVideo components, ensure that your network is free of possible 
problems that can interrupt the operation of the ObjectVideo system. To do this, first 
check whether you can reach each node on your network by pinging each node. In 
Windows, you can do this by going to Start > Accessories > Command Prompt 
and typing the following: 

ping IP address or host name <Enter> 

For example, to ping a computer with the IP address 10.0.0.1, you would type the 
following: 

ping 10.0.0.1 <Enter> 

If you do not know a computer’s IP address, you can find it on the Command Prompt 
of that computer by typing ipconfig. 

A successful ping test should include four packets sent and four received, with none 
lost. 

Note: In ObjectVideo OnBoard, the Video Analysis Devices are also assigned IP 
addresses. You should ping them to be sure they can be reached. 

If you cannot ping a node, check the following: 

• Is the target device turned on? 

• Is there a break in the connectivity to that device? This includes the 
transmission medium (e.g., cabling, connectors, wireless network, etc.). 

• Is the target device correctly configured for IP internetworking? 

• Does the target device have a firewall? A firewall blocking the ping test (i.e., 
by blocking Internet Control Message Protocol [ICMP] traffic) may also be 
blocking essential ObjectVideo system communication (port 8076) traffic. 

• Can you ping the IP address but not the host name? If this is the case, your 
problem is DNS-related. 

• Are the network proxies set correctly? For HTTP communications, make sure 
that you bypass the proxy for local addresses. 

If you can ping a node but receive excessive response time (latency), check the 
connection path for the source of latency or lost packets. You can view the 
connection path by typing tracert IP address or host name <Enter> in the Windows 
Command prompt. The output of this command shows each node or “hop” from the 
source of your ping to the device you are targeting. Check each hop in the path to 
find the origin of latency or lost packets.
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forensics data, 13, 15, 46, 51, 86–94, 98, 

121–31 
Forensics Media Extractor, 122–24 
Forensics Store 

backing up forensics data, 122–24 
customizing storage settings, 86–94 
defined, 13 
disk space used over time, 88, 89–93 
health monitor alerts, 125–26 
installing, 46 
setting time span for storage of forensics 

data, 86 
sharing forensic directory for FAST 

access, 95–96 
starting, 128, 136 
stopping, 127, 136 
troubleshooting, 163, 164, 165, 166, 

216 
Frequently Asked Questions. See FAQs 

G 
generating reports, 116 
getting support, 223 
green sensor dot, 66, 67 

H 
hard drive requirements, 18, 19, 20, 22 
hardware requirements, 17–22 
health monitor alerts, 39, 115, 125–26, 

129, 207, 208, 209, 210 
Help requirements, 23 
host name, 17, 32, 34, 45, 49, 57, 66, 82, 

107, 133, 140 
hosts file, 17, 45, 49, 57, 107, 133, 140 
HTML file, 116 
Hypertext Markup Language file. See HTML 

file 

I 
installation CDs, 24 
installation key, 37, 45, 49, 57, 107, 111–

20 
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installing 
Alert Backup Estimator, 106–9 
Alert Console, 55–59 
Apache HTTP Server, 228 
Camera Placement Tool, 106–9 
Daemon Service, 37, 45, 49, 57, 107 
FAST, 99–101 
FAST install errors, 173 
Forensics Store, 46 
installer does not start, 158 
Integrator Toolkit install errors, 174 
ISE install errors, 169 
ISE software, 49 
Java Runtime Environment, 229 
Leader/Follower Calibration Tool, 106–9 
licenses, 41–43, 139, 215 
MDAC, 230 
Microsoft .NET Framework, 233 
Microsoft DirectX, 231 
MPEG-4 Video Compressor, 236 
MSDE, 234 
MSMQ, 232 
Object Sizing Tool, 106–9 
ObjectVideo Integrator Toolkit, 106–9 
ObjectVideo Management Tool, 40, 47, 

52, 59, 106–9, 109 
ObjectVideo Server install errors, 161 
ObjectVideo Server software, 37–40 
OnBoard ISE software, 44–47, 44–47 
Parameter Configuration Tool, 106–9 
prerequisite software, 227–36 
Rule Management Tool, 55–59 
Sentinel LM, 38, 41 
System Configuration Tool, 55–59 
troubleshooting, 157–74 
validating, 63–69 
VEW/OnBoard client application install 

errors, 171 
VEW/OnBoard client applications, 55–59 
Windows Media Player, 235 

Integrator Toolkit. See ObjectVideo 
Integrator Toolkit 

Intelligent Sensor Engine. See ISE 
Internet Explorer, 23 
ISE (Intelligent Sensor Engine) 

defined, 6, 10, 13 
editing properties, 75–76 
hardware requirements, 17–21 
icon, 66 
installer troubleshooting, 169 
installing OnBoard ISE software, 44–47 
installing VEW ISE software, 48 
missing icon, 186 
OnBoard ISE defined, 10 
reviewing properties, 75–76 
services, 136 
setting up the VEW ISE computer, 33–35 
software requirements, 169, 225 

stopping forensics data, 127, 128 
uninstalling, 149 
verifying forensic data generation, 98 
VEW ISE defined, 6, 13 

J 
Java Runtime Environment, 229 

K 
keyboard, 32, 33 
Keyboard, Video, Mouse switch. See KVM 

switch 
Known View status, 66, 67 
KVM (Keyboard, Video, and Mouse) switch, 

32, 33 

L 
Leader/Follower Calibration Tool 

defined, 106 
hardware requirements, 21 
installing, 106–9 
software requirements, 226 
uninstalling, 155 

licenses 
installing, 41–43, 139, 143–46 
upgrading, 139, 143–46 

Loading Snapshot graphic, 200 
locking code, 42 
Lost Communication status, 193 
Lost Connection status, 204 
low dynamic range, 191 

M 
maintaining the ObjectVideo system, 110–

42 
maintenance troubleshooting, 217–22 
MDAC (Microsoft Data Access 

Components), 230 
Microsoft .NET Framework, 99, 123, 233 
Microsoft Data Access Components. See 

MDAC 
Microsoft DirectX, 231 
Microsoft Event Viewer, 159 
Microsoft Internet Explorer, 116 
Microsoft Message Queuing. See MSMQ 
Microsoft SQL Server Desktop Engine. See 

MSDE 
Microsoft Word, 116 
Min Disk Space Available In Bytes, 89, 90, 

91, 125 
missing 

ISE icon, 186 
sensor icons, 186, 188 

mouse, 32, 33 
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Mozilla, 23 
MPEG-4 Video Compressor, 236 
MSDE (Microsoft SQL Server Desktop 

Engine) database, 39, 112, 234 
MSMQ (Microsoft Message Queuing), 232 
multiplexer, 8, 12, 33, 34, 70 

N 
Netscape Navigator, 23 
network interface, 18, 19, 20, 22 
network problems, 237 
network requirements, 17 
nightfall sensor status, 197 
No Connection status, 204 

O 
Object Sizing Tool 

defined, 106–9 
hardware requirements, 21 
installing, 106–9 
software requirements, 174, 226 
starting and stopping services on 

computer, 138 
troubleshooting, 214 
uninstalling, 155 

ObjectVideo Alert Logger, 134 
ObjectVideo Customer Care, 223 
ObjectVideo database 

archive files, 117 
automatic purging, 111 
checking the size, 118 
copying to a default location, 219 
copying to an alternate location, 220 
defined, 111 
deleting, 152 
determining when to export alerts, 113 
purging, 111–20, 218 
role with ObjectVideo Forensics, 129 
size alerts, 115 
troubleshooting, 218, 222 
verifying purge, 117 

ObjectVideo Forensics 
accessing the forensics directory, 95–96 
creating scenarios, 102–5 
creating views, 70–71 
customizing storage settings, 86–94 
defined, 4 
installing FAST, 99–101 
maintaining, 110–42 
ObjectVideo database role, 129 
overview of system, 11–16 
role of ObjectVideo database, 129 
starting and stopping forensics storage, 

127 
uninstalling FAST, 154 
upgrading FAST, 146 

VEW components used in, 16 
ObjectVideo Integrator Toolkit 

defined, 4, 106–9 
hardware requirements, 21 
installer troubleshooting, 174 
installing, 106–9 
software requirements, 174, 226 
uninstalling, 155 

ObjectVideo Management Tool 
changing server settings, 133 
defined, 59, 109 
hardware requirements, 21 
installing, 40, 47, 52, 59, 106–9 
role in forensics, 86–94, 127 
software requirements, 226 

ObjectVideo OnBoard 
adding sensors, 53 
adding views, 72 
assigning video sources, 62 
defined, 3 
forcing views, 72 
hardware requirements, 20–21 
maintaining, 110–42 
overview of system, 9–10 
software requirements, 224–36 
upgrading, 145 
validating installation, 63–69 

ObjectVideo Server 
changing settings, 133 
defined, 6, 10 
deleting image files, 120 
hardware requirements, 17–21 
icon, 68 
installer troubleshooting, 161 
installing software, 37–40 
Lost Connection status, 204 
manually specifying, 133 
No Connection status, 204 
Offline status, 67, 177, 185, 204 
Online status, 66, 68, 184 
reviewing properties, 75–76 
role in ObjectVideo Forensics, 16 
Server Status, 66, 67, 68, 177, 178, 

184, 185 
services, 134 
setting up computer, 32 
software requirements, 161, 225 
uninstalling software, 151 
Unknown status, 68, 178, 185 

ObjectVideo services, 134–38 
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ObjectVideo system 
customer support, 223 
installation CDs, 24 
maintaining, 110–42 
overview, 5–16 
software requirements, 224–36 
symptoms of problems, 67 
uninstalling software, 148–55 
upgrading, 143–46, 215 
validating installation, 63–69 

ObjectVideo VEW 
assigning video sources, 60 
components used by ObjectVideo 

Forensics, 16 
creating views, 70–71 
defined, 3 
hardware requirements, 17–19 
maintaining, 110–42 
overview of system, 6–8 
software requirements, 224–36 
upgrading, 143–46 
validating installation, 63–69 

Offline status, 67, 177, 185, 204 
OnBoard 100 

defined, 4 
forcing a view, 72 
icon, 67 
validating installation, 65 

OnBoard 1000 
adding a view, 72 
defined, 4 
forcing a view, 72 
icon, 67 
validating installation, 65 

OnBoard 200 
adding a view, 72 
defined, 4 
forcing a view, 72 
icon, 67 
validating installation, 64, 65 

OnBoard ISE. See ISE (Intelligent Sensor 
Engine) 

Online Help, 27 
Online status, 66, 68, 184 
opening FAST offline, 21, 41, 130–31 
Opera, 23 
operating system requirements, 18, 19, 

21, 22 
Operation timed out message, 68, 75, 189 
other documentation, 26–27 
overview 

ObjectVideo Forensics system, 11–16 
ObjectVideo OnBoard system, 9–10 
ObjectVideo system, 5–16 
ObjectVideo VEW system, 6–8 

P 
Parameter Configuration Tool 

defined, 106 
hardware requirements, 21 
installing, 106–9 
software requirements, 174, 226 
starting and stopping services on 

computer, 138 
troubleshooting, 212 
uninstalling, 155 

parameter files, 141 
Partner Package, 47, 52, 59, 101, 109 
permissions to share forensics data 

directory, 95 
pinging a computer, 237 
Power User privileges, 86, 127, 132 
prerequisite software, 227–36 
Primitive Stream Bit Rate, 87, 90 
processor requirements, 18, 19, 20, 22 
product documentation, 26 
properties 

camera, 76–77 
ISE, 75–76 
ObjectVideo Server, 75–76 
sensor, 76–77 

purging the ObjectVideo database, 39, 
111–20, 218 

Q 
quick reference cards, 27 

R 
RAM requirements, 18, 19, 20 
Readme files, 26 
read-only properties, 75 
reference cards, 27 
Remote Desktop Connection, 32, 34 
replacing parameter files, 141 
reports, 116 
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requirements 
client application hardware, 21 
client application software, 226 
FAST hardware, 21 
FAST software, 226 
hardware, 17–22 
Help, 23 
ISE software, 225 
network, 17 
ObjectVideo Integrator Toolkit hardware, 

21 
ObjectVideo Integrator Toolkit software, 

226 
ObjectVideo OnBoard hardware, 20–21 
ObjectVideo Server software, 225 
ObjectVideo system, 17–23, 224–36 
ObjectVideo VEW hardware, 17–19 
software, 23, 224–36 
VEW/OnBoard client application 

hardware, 21 
VEW/OnBoard client application 

software, 226 
resetting 

contacts, 83 
property fields, 75 

responses, 80, 82 
reviewing 

camera properties, 76–77 
ISE properties, 75–76 
ObjectVideo Server properties, 75–76 
sensor properties, 76–77 

rule creation, 80 
Rule Management Tool 

Contacts tab, 83 
defined, 7, 10, 56 
hardware requirements, 21 
installer troubleshooting, 171 
installing, 55–59 
role in ObjectVideo Forensics, 16 
software requirements, 171, 226 
starting and stopping services on 

computer, 138 
troubleshooting, 175–202 
uninstalling, 153 

running a scenario, 104 

S 
scenarios, 102–5 
scene change event, 196 
searching for database size alerts, 115 
Searching for Known View status, 66, 194 
security, 55 
Selector field, 61 
sensor 

adding, 53 
assigning a video source, 60–62 

associating with a Video Analysis Device, 
60–62 

Bad Signal status, 191 
creating, 53 
defined, 7 
editing properties, 76–77 
forcing views, 72 
green sensor dot, 66, 67 
icons, 66 
lost communication health monitor alert, 

209, 210 
Lost Communication status, 193 
missing icons, 186, 188 
question mark next to icon, 68 
reviewing properties, 76–77 
Searching for Known View status, 194 
selecting VEW HiRes resolution, 50 
setting up licenses, 41–43 
status, 183 
Suspended status, 195 
Unknown View status, 70, 72, 196 
Unvalidated status, 68, 198 
validating initial status, 66 
views, 70–71 
yellow sensor dot, 66 

Sentinel LM 
installing, 38, 41 
license server, 136, 215 
uninstalling, 151 

Server Address, 133 
server rack, 32, 33 
Server Status, 68, 177, 178, 183, 184, 

185, 204 
Server/ISE computer 

defined, 10 
hardware requirements, 17–21 

setting up 
licenses, 41–43 
ObjectVideo Server computer, 32 
schedule to search for database alerts, 

113 
time span for storage of forensics data, 

86–89 
VEW ISE computer, 33–35 

settings that affect forensics data disk 
space, 89–93 

sharing forensics directory for FAST access, 
95–96 

SMTP (Simple Mail Transfer Protocol) 
server, 17, 82 

snapshots, 111 
software requirements, 23 
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starting 
Daemon Service, 138 
forensics storage, 128 
ISE services, 136 
ObjectVideo Server services, 134 
Sentinel LM, 136 
services on client application computer, 

138 
stopping 

Daemon Service, 138 
forensics storage, 127 
ISE services, 136 
ObjectVideo Server services, 134 
Sentinel LM, 136 
services on client application computer, 

138 
storage of forensics data, 86–94 
Store Check Interval, 90, 92 
stored view, 70 
sunrise sensor status, 197 
support, 223 
Suspended status, 195 
switcher. See multiplexer 
symptoms of problems, 67 
Synch Wait time, 189 
synchronization timed out, 189 
System Configuration Tool 

component properties, 76–77 
defined, 7, 10, 55 
hardware requirements, 21 
installer troubleshooting, 171 
installing, 55–59 
Properties tab, 76–77 
role in ObjectVideo Forensics, 16 
software requirements, 171, 226 
starting and stopping services on 

computer, 138 
symptoms of problems, 67 
troubleshooting, 175–202 
uninstalling, 153 
validating install, 63–69 

system overview 
ObjectVideo Forensics system, 11–16 
ObjectVideo OnBoard system, 9–10 
ObjectVideo VEW system, 6–8 

T 
target time span, 86, 91, 125 
technical support, 223 
testing the alert sound, 84, 205 
time span for storage of forensics data, 

86–89 
timed out message, 189 
troubleshooting 

Alert Console, 203–9 
FAST, 215 
Forensics Store, 216 

install errors, 157–74 
maintenance tasks, 217–22 
network problems, 237 
Object Sizing Tool, 214 
Parameter Configuration Tool, 212 
Rule Management Tool, 175–202 
System Configuration Tool, 175–202 

U 
unable to start FAST, 215 
uninstalling 

Alert Backup Estimator, 155 
Alert Console, 153 
Camera Placement Tool, 155 
FAST, 154 
Integrator Toolkit, 155 
ISE software, 149 
Leader/Follower Calibration Tool, 155 
Object Sizing Tool, 155 
ObjectVideo Server software, 151 
ObjectVideo system, 148–55 
Parameter Configuration Tool, 155 
Rule Management Tool, 153 
Sentinel LM, 151 
System Configuration Tool, 153 
VEW/OnBoard client applications, 153 

Unknown status, 68, 178, 185 
Unknown View status, 66, 72, 196 
Unvalidated status, 68, 198 
upgrading an ObjectVideo system, 139, 

143–46, 215 

V 
validating the ObjectVideo system 

installation, 63–69 
verifying 

database purge, 117 
forensics data generation, 98 
installation of ObjectVideo system, 63–

69 
upgrade of ObjectVideo system, 144 

VEW FlowControl 
defined, 3 
icon, 66 
validating installation, 64 

VEW HiRes 
creating views, 70–71 
defined, 3 
icon, 66 
selecting sensor resolution, 50 
validating installation, 65 

VEW ISE. See ISE (Intelligent Sensor 
Engine) 
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VEW Leader/Follower 
calibrating sensors, 79 
creating views, 70–71 
defined, 3 
icon, 66 

VEW Standard 
creating views, 70–71 
defined, 3 
icon, 66 
validating installation, 64 

VEW/OnBoard client applications. See Rule 
Management Tool, System Configuration 
Tool, or Alert Console 

Video Analysis Device 
assigning an IP address, 30 
associating a sensor with, 60–62 
connecting to the network, 30 
defined, 9, 14 
Lost Communication status, 193 

video capture card, 225 
video display card, 18, 21 

video distribution amplifier, 34 
video feed, 7, 60–62, 144 
video input, 33, 34, 60, 77 
video isolation transformer, 34 
video source, 18, 60–62, 77 
Video Stream Bit Rate, 87, 90 
views, 70–71, 72 

W 
web server, 38, 163, 164, 165, 166, 167, 

168, 200 
Windows Media Player, 235 
Windows security, 55 
Windows Services, 134–38 

Y 
yellow sensor dot, 66 
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